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Getting started

Introduction
About program

Program mission
The SCIA Engineer software system has been designed and developed to provide structural engineers and designerswith
an efficient, comprehensive and robust tool.

Theoretical background
SCIAEngineer is a software system for a static and dynamicanalysis of structuresand their design to standards. It is groun-
ded on the displacement-based finite elementmethod.

SCIA Engineer does not work with finite elements directly but it exploits structural elements (referred to as members) on
which the finite elementmesh isautomaticallygenerated just before the calculation.

SCIA Engineer can be used to calculate and design structures consisting of 1D members (modelled by linear finite ele-
ments) and planar parts such aswalls, plates, and curved slabs (modelled by2D finite elements).

Types of calculation
SCIAEngineer comprisescalculationmodules for the following typesof calculation:

1. linear static calculation (including some non-linear features),
2. geometricallynon-linear calculation,
3. dynamicnatural vibration calculation,
4. seismiccalculation,
5. buckling analysis,
6. andmuchmore.

Code checks
In addition to the calculation itself, SCIA Engineer enables the user to carry out the final design of a structure in accordance
with appropriate technical standards.

The "Code Check library" of SCIA Engineer contains a multi-national set of technical standards for various material types,
mainly for steel and concrete.

Proper and exhaustive use of program features assumes that a user iswell accustomed to
the principles of the finite element method, is familiar with appropriate technical standards
and conventions, and is a skilled professional in the field of design and calculation of engin-
eering structures.
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About documentation

We recommend undergoing a specialised training for SCIA Engineer organised for you by
your localSCIAdealer before using the program for realwork.

The documentation contains explanation of the program principles, theoretical background and operation and will provide
the user with invaluable knowledge about the SCIAEngineer software.

Purpose and contents
This manual provides an in-depth coverage of SCIA Engineer main module functionality and covers the input, calculation
and result-evaluation phases for both frame and shell structures.

Protection of SCIA Engineer
Protection of SCIA Applications

Introduction
Thismanual provide basic information about settingsnecessary for running of SCIAapplications

Thismanual provides information about both floating (network) and standalone (dongles) protection.

Standalone protection
The biggest change with respect to the previous version is that starting from version 2010 the donglemust be accompanied
with LIC file and in some casesalso E2C file. Dongle itself isnot sufficient for starting theSCIAEngineer.

This change givesuspossibility to providemore flexible licensing solution including time limited licensing, editionsetc…

To simplify asmuch as possible updating of dongles, working with dongle on more computers and other similar use cases it
ispossible to download LIC andE2C filesonline from theSCIAserver. (see the chapter related to Protection setup)

Compatibility with older versions: The same dongle can be used to run EPW, older version
of SCIA Engineer (up to version 2009.0) and new version of SCIA Engineer (from version
2010.0).

Floating protection
SCIAFloating protection is based on FLEXnet technologyof Flexera Software Company. This type of licensing stores com-
mercial modules in “Trusted storage” on the Licence server. Those modules can be used (Checked out) by SCIA applic-
ation online or borrowed (offline using ofmodules from licence server).

FLEXnet based protection fully replacesFlexLMbased protection from version 2010.0.

Compatibilitywith older versions: Older versionsof SCIAEngineer (FlexLMprotection) can
be run with new FLEXnet licence server. In this case the modules are provided by the
licence server only if the FlexID dongle isattached.
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Trial, Student and Viewer modes
From the version 2011 it is possible to run SCIA Engineer without protection as SCIA Viewer. In this case SCIA Engineer
has limited functionality. It is intended to be used for viewing of calculated structures only. In versions starting from 2010 the
user can also use “TRIAL” or “STUDENT” moduleswhich are also free but still require somemodules.

Student version

- User can usemajorityof all SCIAEngineer functionality.

- User can edit and calculate a project

- Projects can be saved as *.esad only

- Available for free for registered users (students) only

Trial version

- User can use functionality listed in his licence file only

- User can edit and calculate a project

- Projectsare saved into *.esa

- Provided bySCIAdealers to prospect customers

SCIA Viewer version

- Available from version 2011

- User can view existingmodel and document only

- User can not edit nor calculate a project

- If the project is savedwith results then user can view precalculated checks

- Projects cannot be saved neither exported to any file format

- Available to anybodywithout anyprotection

Standalone protection
Standalone protection is facilitated bySentinelSafenet dongles.

New user – activity on user’s side
When a hardware lock (dongle) isused for the protection, the following procedure needs to be followed:

- Installation of the SentinelProtection Installer

- Attaching theSentinelDongle

- Import LIC file (andE2C file in case od editions) in “Protection setup” utility

Note: Allmentioned actionsare usuallydone automaticallyduring the installation. Following
stepsare described for special caseswhen user needs to perform themmanually.

Installation of the Sentinel Protection
TheSentinelProtection Installer provides for communication betweenSCIAEngineer and theSentinel dongle.
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In the Installation & Software menu of the installationDVD choose the option Install Sentinel Driver. Follow the install-
ation instructionson the screen.

The Sentinel Protection Installer can also be installed manually by executing the file X:\Tools\Sentinel\Sentinel Pro-
tection Installer 7.* .exewhereX represents theDVD drive and * the version number.

Note: When an older version of the Sentinel System Driver or the Sentinel Protection
Installer has already been installed on the computer, this older version must first be de-
installed through theControlPanel before installing the newSentinelProtection Installer.

Attaching the Sentinel Dongle
TheSentinel hardware locksare available for USBports. Attach the dongle to a free port of the computer.

Importing of new LIC file
Each dongle needs to be accompanied with the LockId.LIC file to provide licenses. To get this file on the user's computer is it
necessary to do the following:

1. attach the dongle to computer
2. run Protection setup dialogue
3. press [Import licence file]

Then the Protection setup tries to connect to SCIA Activation server and download necessary LIC file. If the file cannot be
downloaded from the internet it can be sent via email and then opened from the disk. The open file dialogue is opened auto-
maticallywhen the internet download fails.

The following message will appear after successful import of licence file and user can see the list of his commercialmodules
in the “Expand” mode of Protection setup dialog.
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Note 1:Automatic import of LIC file from the SCIA protection server can be done with
attached dongle only.

Note 2: Import of LIC file can be done only if the user is logged with the rights to write into
with Licence file (seeSetup / Options / Directories)

Note 3: It is possible to change the path to the folder where the licence file will be imported
in Advanced setting dialogue (right clickon the header of Protection setup dialogue).

Note 4: It is possible to disable automatic downloading of LIC file from the SCIA protection
server in Advanced setting dialogue (right clickon the header of Potection setup dialogue).

Checking the Sentinel Dongle
Tomake sure theSentinelDongle hasbeen installed correctly the SentinelSuperProMediccan be used.

Installation of Sentinel SuperPro Medic

1. UsingWindowsExplorer go to X:\Tools\Sentinel\ where X represents theDVD drive.

2. Execute the file SuperproMedic.exe and follow the instructionson the screen.

3. By default the SuperPro Medic is installed in the folder C:\Program Files\Rainbow Tech-
nologies\SuperPro\Medic

Checking the Sentinel Dongle

1. UsingWindowsExplorer go toC:\ProgramFiles\Rainbow Technologies\SuperPro\Medic

2. Execute the file SuperproMedic.exe TheSuperProMedicappearson the screen.

3. In the upper right corner of the SuperPro Medic the version of the installed Sentinel Driver is shown.
When no version is shown theSentinelProtection Installer needs to be installed asdescribed earlier.
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4. In the field Server Name/IPor Mode choose the option STANDALONE

5. Next press [Find SuperPro] to search for correctly installed Sentinel dongles. A dialog box appears
showing the number of keys found.

6.When no Sentinel donglesare found, press [MedicSays] to receive extra information in order to find the
cause of the problem.

When the SuperPro Medic indicates that the Sentinel dongle has been found, then this means the dongle is attached cor-
rectly to a parallel or USBport and theSentinelProtection Installer hasbeen installed correctly.

Upgrade of dongle – existing user
After buying a new version of SCIA Engineer or new modules users needs to update his Licence file using [Import licence
file] button in theProtection setup dialogue – see previouschapter.

Followingmessagewill appear after successful update of Licence file.
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When the user usessomepredefined sets, hewill need to updatemodules in those sets (add newmodules).

Time limited dongle
Time limited licence isavailable also for dongles.

It is possible to set different time limitation (different number of days) for each commercial module in the LIC file. The num-
ber of days is calculated from themoment of importing the LIC file by user in the protection setup utility. During the import of
LIC file, the current date iswritten into the dongle (number of days is stored in the LIC file).

The number of remaining days (excluding the current day) for time limited module is displayed in the list of modules. Once
the time limitation isexceeded, the licence isdisplayed as “Expired” andwill not be available during start of SCIAEngineer.

Note 1: The date in the dongle is changed only if the counter of LIC file is higher that the
counter in the dongle (to prevent prolonging of time limited version by repetitive Importing
LIC file by the user).

Note 2: It is not necessary to send new dongle to the user to prolong is time limited version.
Onlyperforming of [Import licence file] fromProtection setup isenough

Note 3: If there is “0 day(s) to expire” it means that this is the last day the module can be
used.

Note 4: In case of using more dongle, the number of available days is compared with the
datewritten in the dongle linkedwith the LIC file.
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Using of more dongles together
User can use asmanydonglesashe can attach to the computer. The LockID numbersof all attached donglesare displayed
at the header of protection setup utility.

In the list of available commercialmodules isdisplayed the sumofmodules fromLIC files related to all attached dongles. Fin-
ally the sumofmodules fromLIC files related to all attached donglescan be used in SCIAapplication.

Note 1:[Import LIC file] can be done also with more attached dongles but it is
strongly recommended to do it with just one dongle attached.

Note 2: It is possible to use more dongles with different time limitation. In case that some
commercialmodule is in all LIC files, the onewith longer time limitation is taken into account.

Floating (network) protection
This manual is focused on licensing features specific for SCIA License Server but it also contains basic information about
managing of licence server. More detailed information about general managing of licence server can be found in Licence
AdministrationGuide provided byFlexera Software.

Supported operating systems
Licence server can be installed on following operating systems

Description of floating protection
SCIA floating protection is type of networkprotection. It is based on the FLEXnet technologyof Flexera Software Company.
Modules are stored in Trusted storage on the Licence server in case of this licensing. Those modules can be used online
(checked out) or theycan be borrowed and used offline. On the licence server there are stored allmodulesand editions.

TheSCIALicenceServer can be installed on anycomputer in the client's network. Thismeans that it doesnot have to be the
domain or file server.

Each of modules on the SCIA License Server can have different amount of licenses, which can be started simultaneously.
The user can determinewhichmoduleshewants to use (via Protection setup dialogue) andwhichmoduleswill remain avail-
able on the server for other users.

FLEXnet protection fully replacesFlexLMprotection in new versions (from2010.0).
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Managing of licence server is newly (from version 2012) done by lmadmin.exe. Thismanager hasweb based user interface
whichwill be described later.

Components used in SCIA floating licensing
SCIA floating (network) licensing consistsof following components:

l Application (e.g. SCIA Engineer): Thisapplication isa client for the SCIALicenseServer. Setting of protection isdone
in Protection setup (lockman.exe).

l Trusted storage on End user’s machine (Application TS): It isTrusted storage on end user’smachine. Here are
storedmodulesborrowed from client’s licence server. No user'saction isneeded to install and use application TS.

l Vendor daemon: It is the SCIA.exe file which is located on client’s licence server machine. Vendor daemon ispart of
Licence server which communicateswith application and administrates requests for modules. It is installed together with
theSCIALicenseServer

l Trusted storage on server machine (Server-side TS): It is trusted storage on user’s licence server machine. Here
are storedmoduleswhich user hasactivated. Thosemodulesare then enabled to user’sapplication via SCIAdaemon.

l SCIA Activation Manager: application located on client's licence server. It is used to activate (deactivate) moduleson cli-
ent's server fromSCIAActivation server.

l SCIA activation server: Thisserver isoperated bySCIA. It is located on our machine and communicatesdirectlywith
our database containing information aboutmodulesbought byour clients. It proceedsactivation, return and other
requests from client'sActivationmanager and send responses to them. The domain nameof the activation server is: activ-
ation.scia-online.com

Trusted storage - overview
The trusted storage is space on the licence server where information about activated modules is stored. This storage is
secured against unauthorized use.

Trusted storage contains license rights for FLEXenabled applications.

Important: Some computer identities are used as bindings for securing Trusted storage. It is strongly recommended to
return licenses to SCIAactivation server before any (SWor HW) changeson licence server.

In some caseswhen security rules are violated the trusted storage become untrusted. It can happen by legal action but also
by illegal attempt to unauthorized usage of the licenses. In such case no modules are provided by the licence server and
untrusted licence ismarked in The Activation manager (see further). Licence administrator should contact SCIA support in
this case.

Compatibility with older versions
Older versionsof SCIAEngineer (FlexLMprotection based on *.DAT file) can read license fromnewSCIALicenceServer.

New versions of SCIAEngineer (2010 and later) requiresSCIA Licence Server with version of FLEXnet 11.8 or newer. It is
recommendable to use latest version of SCIALicenceServer provided bySCIA.

In case of using licence server with older version of FLEXnet than 11.10 together with SCIA engineer 2012 (or latest patch
of 2011.1) there can be problem with correct interpretation of "@localhost" address. In this case it is recommendable to
upgradeSCIALicence server to latest version or use exact IPadress (127.0.0.1) in the Protection setup.

Installation of SCIA License Server
Installation of SCIA Licence server is part of the installation DVD. It is necessary to go through all stepsonly. No special input
isneeded.

The default path where the SCIA Licence server is installed is c:\Program Files (x86)\Common Files\SCIA\LicenceServer\
(can be different for different OS).
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Activation of modules on SCIA License Server
To activatemodulesonSCIALicense server user needs to receive the LID file fromSCIAand go through following steps:

1. RunSCIAActivationManager

2. Make sure that FlexID dongle isattached andworking properly
3. Press [Read Licence ID]and select the LID file using the “Open file dialog”
4. Select the licence in the list of licensesbyclicking on the licence number
5. Press [Activate Licence]
6. The informationmessage isdisplayed after successful activation
7. SCIAActivationManager can be closed now

Activated licence is indicated by the green icon.

After the successful activation it is necessary to restart the SCIA License server.

Upgrade of user’s version
When user buys new modules, it must be indicated in SCIA database. Then the user (or his IT administrator) needs to
update licenseson hisSCIALicenseServer.

The update ofmoduleson theSCIALicense server consistsof two steps:

1. Return currentmodules fromuser’s trusted storage to SCIAactivation server (return request)
2. Activatemodules fromSCIAactivation server (it will be activated including newmodules)

Those two stepscan be donemanuallyor at once bypressing [Reload licence].
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Configuration and start of SCIA Licence server

Note 1: The licence server is configured automatically during the installation of SCIA
LicenceServer. In usual cases the following stepsare done automatically.

Note 2: More detailed information about general managing of licence server can be found
in LicenceAdministrationGuide provided byFlexera Software.

1. make sure that there is running process lmadmin.exe on the license server machine.
2. start Internet browser and navigate to http://serveraddress:8080 (e.g. http://localhost:8080)
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3. Clickon [Administration] and sign in (for the first login use "admin" for username and password)

4. Go to "Vendor daemon configuration" and click "Administer"

5. In the "General configuration" section it isnecessary to have correctpath to licence file (SCIA_Software.lic or *.DAT)
and correctpath for the vendor daemon (SCIA.exe).
Vendor daemon port is the port which isused for communication between scia.exe and lmadmin.exe. it is not used for
communication betweenSCIAEngineer and licence server.
Restart retries specifieswhether the licence server will be automatically started after restart of licence server machine
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(also restart after sleepmode).Put here the value 1 to enable automatic restart of license server .

6. In the "Vendor daemon log" section it ispossible tomodify the position of log filesor show the log file.

7. Changes in configurationmust be saved

Once the daemon isconfigured correctly, it can be started using the "Start" button.

Running daemon can be stopped using "Stop" button. Or it ispossible to reread the licence file.
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Checking the status of licence server
The statusof SCIALicence server can be checked on the "Dashboard" of theweb based interface. It ispossible to see alerts
and warnings here and to see which licenses are available at the server. There are provided information about availability,
expiration or current users (Hosts) for eachmodule.
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Setting of protection in SCIA applications

Standalone protection
The setting of Protection is done is Protection setup dialogue (lockman.exe). In the most cases user needs just to select
"Onlystandalone" type of protection. This selection ensures that allmodules fromattached dongle and LIC file are used.

User can check list of hismodules in "Expanded" mode of the protection setup.
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In case the list of modules is empty or outdated it can be updated using [Import licence file] button. (see chapter related to
Upgrade of existing users).

Floating protection
The setting of protection isdone in Protection setup dialogue (lockman.exe).

In the Protection setup dialog the user needs to set protection type to “Floating” and fill in the correct port and path to
Licence server. (e.g. 27000@localhost or 27000@my_server_name). The list with available commercial modules is dis-
played after pressing [Apply/Refresh].

User must select modules which he wants to use in SCIA application. Selections of modules can be also saved as "Sets".
Those setscan be then quicklyaccessed in combo box "Setsofmodules".
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Borrowing
Borrowing enables to the end-user to take somemodules from Licence server to his local computer and use them also off-
line. The borrowing is done for specified time (maximal one month). After this time borrowed modules are automatically
returned back to SCIALicence server.

Note 1: If the user wants to use borrowing, it must be explicitly enabled by SCIA. The bor-
rowing can be enabled for each separate commercialmodule (edition/ package).

Borrowing ofmodules is controlled fromProtection setup utility:
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Moduleswhich can be borrowed are indicated by the <B> (since the version 2011).

If the user wants to borrowmodules, he needs to select (check) modules he wants to borrow and press [Borrow selected
modules] button. Then he is asked for number of days (calendar). All modules that are currently selected (checked) are
borrowed (if it is allowed for them).

Successfully borrowed modules are indicated by the text with time remaining to automatic returning of modules (since the
version 2011).

In case the borrowing isnot anabled for selectedmodule thewarningmessage is received.

If the user wants to borrow some more modules (or other selection of modules) then he has to return currently borrowed
modulesat first. After returning he canmake new selection ofmodulesand performBorrow action again.

Note: The “early return” is possible only if the end-user is connected to his SCIA Licence
server.

It is highly recommended to replace the path to the licence server with one space character
(" ") in the protection setup utility. Otherwise the starting andworking in SCIAEngineer can
become slow due to system searching for the licence server which isnot accessible.

List of protection related tools

Protection setup
The protection setup is a separate utility. It can be launched using Lockman.exe. This is basic tool for end-users to configure
their licensing.
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User can select one of the following protection types:

1. Trial – it runsSCIAEngineer in Trialmode if there isa “TRIAL” module in the local trusted storage (localSCIALicence
server)

2. Only standalone – readsmodulesonly from the dongle and LIC file
3. Only floating – readsmodulesonly from theSCIALicence server
4. First standalone then floating –Selectedmodulesare taken primarily from the standalone dongle. If some selected

module isnot available at the dongle it is taken fromSCIALicence server
5. First floating, then standalone – try to readmodules fromSCIALicence server, if it is not accessible, thenmodules

are taken fromdongle
6. Student – it runsSCIAEngineer in Studentmode if there isa “STUDENT” module in the local trusted storage (local

SCIALicence server)

If the dongle isattached then itsLockID isdisplayed in the header of the dialog.

When the floating protection is selected, then user must specify the path to hisFLEXnet Licence server.
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At the bottom of the dialog there is the list with commercial moduleswhich are available in the LIC file or on the user's SCIA
License server. Here the user can select moduleswhich he wants to use in SCIA application. The selection of modules also
can be saved to Sets.

Sets are predefined settings of commercial modules. They are stored in files in User\protection\Sets directory. In the Pro-
tection setup dialog the user can choose between existing sets of modules in the combobox. SETs are intended to be used
for floating protection (tomake selection ofmoduleseasier), however, it can be used alsowith standalone protection.

[Save set of modules] saves the current selection of modules into defined set (the name of the set is according to file
name specified by the user).

SCIAEngineer can be startedwith specificpredefined set ofmodules (i.e. selection ofmod-
ules). This feature enables the user to switch between predefined set of modules without
starting Protection setup.
The syntax is: esa.exe /Ccustom_filter_file_name where "custom_filter_file_name" rep-
resents the name of the predefined set of modules without file extension. If spaces are
used in the nameof the set the syntax isesa.exe "/Ccustom filter file name".

[Import set of modules] modify the current setting of modules according to selected set, but does not change the name
of the current set.
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It can be also used for importing SETs from another computer (e.g. if prepared by IT administrator on the server). After the
import the SET iscopied toUSER\Protection\Setsdirectoryand can be used.

[Remove set of modules] deletescurrent set.

Note 1: Fileswith Setscan bemanipulated (copy, delete, edit) alsomanually.

Note 2: Numbers next to commercialmodule are valid only for floating licensing andmean:
total number ofmoduleson the server / available number ofmodulesat themoment.

Each commercial module in the list can be expanded (by double-click). Then the technical modules contained in the com-
mercialmodule are listed.

Changing of path to the licence folder from Protection setup
It is possible to change theway to the directorywith license file fromProtection setup dialog

Use right-mouse-button on the header of the dialog and start Advanced setting. Then you can enter different path to the dir-
ectorywith licence file.
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Displaying of usage of some module from Protection setup
This feature isavailable for the floating licensesonly.

To learnwho iscurrentlyusing somemodule, use right-mouse button above themodule and press “Show list of users. Then
you can seewho isusing themodule.

SCIA Activation manager

Thisutility needs to be installed on user’s licence server. Its installation ispart of SCIALicence server installation.

The utility is intended to be used by client’s licence administrator. It enables to administrate licenseson SCIA License server.
Following actionsare available:

l Add new license (one licence representsone LockID) in the list
l Delete license from the list

And also perform transactionswith SCIAActivation server

l Activate a license
l Return a licence to SCIAActivation server (can be latelyagain freelyactivated).
l Repairdamaged trusted storage - it must be explicitly allowed bySCIA.
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Note: It is recommended to return licenses to SCIAActivation server before anychangesof
client's licence server machine. it will prevent damaging of the licence.

Running the program
Starting program
Depending on your personal habits select one of the followingways:

Short-cut on desktop

1. If the short-cut hasbeen placed on the desktop automaticallyduring the installation, proceed to step 3.

2. Place the short-cut on the desktop.

1. Click the rightmouse button on the desktop.

2. Select New >Short-cut command.

3. Browse the hard disk to find the folder you have installed SCIAEngineer into.

4. Select ESA.EXEand finish theNewShort-cut command.

3. Double click the short-cut to start the program.

Start menu

1. ClickStart button on the left ofWindowsstatusbar.

2. Select (All)Programs>SCIAEngineer XXXX.X>SCIAEngineer XXXX.X.

Windows explorer or another file manager

1. Browse the hard disk to find the folder you have installed SCIAEngineer into.

2. Select ESA.EXE file and double click it to start the program.

Program files and folders
The programusesnumerous foldersand file types to store itsdata.

Folders
Program folders
main program folder It contains the program executable and auxiliary files.

set
It contains initialisation files for a new project. (The information stored here may be overridden by
the data from files saved in User folders, if available.)

db It stores system databases (e.g.materials, bolts, etc.)

prof It contains cross-section databases.

DocumentTemplates
This folder offers a set of default templates for document. Its contents is automatically copied into
the appropriate user folder on first program run.

GraphicTemplates
This folder offers a set of default templates for graphical outputs. Its contents is automatically
copied into the appropriate user folder on first program run.
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Note: All the program foldersareReadOnly.

User folders
set It contains initialisation files for a new project.

db It stores files with user-defined databases.

prof It contains cross-section databases.

DocumentTemplates This folder holds the templates for document.

GraphicTemplates This folder holds the templates for graphical outputs.

Note: The destination of this folder may be adjusted in the appropriate program setup dia-
logue.

Temporary folder
This folder storesall the information that the programneeds to store during its run.

Note: The destination of this folder may be adjusted in the appropriate program setup dia-
logue.

Project folder
This folder stores the user-crated projects.

Note: The destination of this folder may be adjusted in the appropriate program setup dia-
logue.

Files
ESA Project file

ESAD
Project file that has been created in a demo or student version of the program. It cannot be read into a standard
licensed version of the program.

EPW Project file created in Esa Prima Win

DB4 Database file

SET Initialisation file for the adjustment of project and user interface.

OTS File with table templates for document.

EPD Template for drawing in Paper space.

Update of the program
You can usemenu itemHelp >Check for Updates to update your installation of the program.

Note: If, for any reason, it is not desirable that the user of SCIAEngineer use this possibility
to update the program (e.g. in large companies with IT department controlling the install-
ations of the software), it is possible to disable this item by a simple change of the value of
one registry entry. If the value HKEY_ CURRENT_
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USER\Software\SCIA\Esa\10.0\Admin\Settings\EnableUpdateMenu = 0, then the Check
for Updatemenu item isdisabled.

Project manager dialogue
Projectmanager dialogue isa toolwhich helpsuser to open, create or browse projects. It allows to adapt protection settings,
use linksand other options tomanage theSCIAEngineer or findmore information about it.

All these functionalitiesare stored in one dialogue.

Project information preview
The biggest advantage of the dialogue isa project information preview. Each project is complemented bya picture of a struc-
ture and basic information such asname, author, number ofmembers, calculated results ...

l The top "play" button opens the selected project;
l Preview displays the slide-show of images from the project, it can be listed byarrows;
l The table contains the standard information about the project data, structure and calculation;

When the Project manager dialogue appears?
The dialogue isdisplayedwhen user clickson icon "Start projectmanager" on the basicapplication toolbar.

Using Project manager dialogue
New project
In theNew project categoryuser can select the type of a new project.

It is possible to switch to anyother possibility on the left side.
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It isalso possible to create a new project using predefined project template.

Recent projects
User can select and open one from recent projects heworked on in the past. List of those projects is the same as is available
in SCIAEngineer mainmenu.Opening of the project can be done using double click.
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List of recent project isupdated after restart of SCIAEngineer.

Open projects
Thisbutton launch the systemOpen file dialogue and enables to select anywantedSCIAEngineer project file.

All standard functionsare supported (Copy, Paste, New folder etc.).
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Protection settings in Start project dialogue
TheProtection setup dialogue can be started using the button Protection setting. Changesdone in the protection setting are
respected after a small delay. In case the SCIA Engineer is running, any changes done in the protection setting will be
applied after restart of the application.

In case ofmissing license theProtection setting button becomes flashing and red.

Links to web pages
The bottompart of the left panel contains links to important web-pages.

Search and sort the list of projects
The list of projectswhich isavailable for abovementioned tabshascommon behavior.

Search
It is possible to filter it using the "Search" field.
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Sort
It is possible to sort the list according to one of columns. The sorting is switched by clicking on the column header. It have
sequentially following three possible values (none, ascending, descending).

TheProjectmanager dialogue isskipped in case the "Open last project" is selected in the
setting of Action on start-up in SCIAEngineer.
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User can switch to old projectmanager in setup.
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Terminology and conventions

Terminology
Global terms
additional data
entity

An entity that defines properties other than the shape of a structural member, e.g. load, support,
hinge, etc.

catalogue block;

type structure

A predefined template structure; some of repeatedly used types of structure have been pre-cre-
ated and can be quickly defined by a simple selection of the appropriate type in the integrated cata-
logue.

cut-out A rectangular area created by a mouse when dragged over the screen; the area extends from the
point where the drag move started to the point where the left button was released; the sides of the
cut-out are always horizontal and vertical.

entity Either a 1D member, load, support, hinge or any other part of a structure model the properties of
which are defined and can be edited.

generator A part of the program that automatically generates some kind of data, e.g. the finite element mesh,
load from a given wind conditions, etc.

geometric entity An entity that defines the geometry (or shape) of the structure. See member.

intersection line A polygonal line drawn by a mouse on the screen; the line can intersect as many entities as
desired.

member Any structural member.

mesh finite elementmesh

solver A part of the program that calculates the structure subject to the defined load using the selected
type of calculation. The solver first assemblies the set of equations, then carries out the numerical
solution of the problem.

Geometric entities
1Dmember A straight or curved member defined by means of its midline and cross-section. The cross-section

may be constant or varying along the length of the 1Dmember.

cross-link A connection of two intersecting 1Dmembers.

force load Load in the form of force. It can be either point or continuous.

foundation block A type of support that represents a pad foundation.

hinge Connection of two members. It can be either rigid or of defined elasticity.

load Any kind of load that the structure is subject to.

moment load Load in the form of bending moment. It can be either point or continuous.

node Generally a vertex of a member or a point where two or more members intersect.

predefined load A load defined by means of the composition of e.g. floor. The user defines individual layers of the
floor, their height and specific weight.

rigid arm A 1Dmember of an infinitely large stiffness.

support Point or line support of a structure. Several types of supports are available: standard, foundation
pad, wall, etc.
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Cross-sections
catalogue cross-sec-
tion

A cross-section that can be defined by selecting from the library of cross-sections. The library is an
integral part of SCIA Engineer.

general cross-sec-
tion

A cross-section the shape of which is completely defined by the user.

reference point The reference point is defined according to a cross-section type:

for catalogue cross-sections it is located in the first point of the cross-section,

for general cross-sections and cross-sections defined by a polygon it is identical with point [0,0].

Co-ordinate systems
Introduction to co-ordinate systems
Asa user of SCIAEngineer youwill come acrossa set of variousco-ordinate systems. Some co-ordinate systemsare essen-
tial for the work with the program itself, some others may significantly reduce the effort and time necessary to get the
required result.

The co-ordinate systemsmaybe divided into several groupsaccording towhat they relate to:

global co-ordinate sys-
tem

the essential co-ordinate system, provides for positioning and orienting of a model and its
unambiguous definition

user-defined co-ordinate
systems

UCS

facilitates the model definition, the user may define it’s origin and direction

point definition co-ordin-
ate systems;

geometry definition co-
ordinate systems

provides for the definition of geometry in the most straightforward way

entity co-ordinate sys-
tems

local co-ordinate system

defines the orientation of individual entities in a model and provide for the unambiguous inter-
pretation of physical quantities related to the entity

Global co-ordinate system
The global co-ordinate systemused in the program isa three-dimensional right-handedCartesian co-ordinate system.

The axesof the systemaremarkedX, Y, and Z.

Note: It is highly recommended to locate the createdmodel of a structure close to the origin
of the global co-ordinate system (i.e. near the point whose global co-ordinates are 0, 0, 0)
in order to prevent possible numerical inaccuracy due to numerical operations carried out
with excessivelygreat numbers.

It is further recommended to focus on this point especially after the model geometry has
been imported froma third-partyCAD program.
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User-defined co-ordinate system
In order to simplify and speed up work with a model, the user can define its own co-ordinate system or systems and locate
their origin, including possible inclination, anywhere in the global co-ordinate system.

The user-defined co-ordinate system isa three-dimensional right-handedCartesian co-ordinate system.

The axesof the systemaremarkedX, Y, and Z.

The user co-ordinate systemmay be set arbitrarily and the setting can be changed during work asmany times as required.
In addition, any number of user co-ordinate systemsmay be defined simultaneously but just one of them can be active at a
time. The user can swap between the previously and also newly defined user co-ordinate systemswhenever it seems to be
convenient.

For information about setting and using of user co-ordinate systems see chapter Basic Working Tools > User co-ordinate
system.

Entity co-ordinate systems

Introduction to entity co-ordinate systems
Each structural entity, that means each member, has got its own local co-ordinate system. This co-ordinate system is a
three-dimensional right-handedCartesian co-ordinate system.

The systemprovides for:

l unambiguouspositioning of themember in space,
l unambiguousdefinition of load and boundaryconditions,
l unambiguous interpretation of results.

This chapter also deals with a group of co-ordinate systems that do not refer to a structural entity in the full meaning of the
word, but that is veryclosely related to it. Thisgroup consistsof co-ordinate systemsusedwith cross-sections.

Cross-section co-ordinate system
There are several co-ordinate systemsused with cross-sections. All the sectional co-ordinate systemsare two-dimensional
right-handedCartesian co-ordinate systems.

Principal (or main) axes
The principal axescorrespond to the principalmomentsof inertia of a cross-section. Theyaremarked u and v.

The u axis is called (according to the officialEurocode terminology) amajor axisand the vaxis is called aminor axis.

The principal axes are used to evaluate important sectional characteristics necessary for design and assessment to tech-
nical standards (code check), e.g.momentsof inertia, radiusesof gyration, etc.

Centroidal axes
The two centroidal axespass the centroid of a cross-section and the first moments (the staticmoments) of the cross-section
around these axesare equal to zero.

The centroidal axesaremarked yand z.

The centroidal axes are used to evaluate important sectional characteristics necessary for design and assessment to tech-
nical standards (code check), e.g.momentsof inertia, radiusesof gyration, sectionmodulus, etc.

For symmetrical cross-sections, the centroidal axesare identical to the principal axes.
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For example, for steel cross-sections the centroidal y axis is parallel to the flanges and the centroidal z axis is perpendicular
to the flanges.

Geometric co-ordinate system
The geometricaxesare used to define co-ordinatesof cross-section vertices. The axesof the systemaremarked yand z.

Orientation of the cross-section co-ordinate systemwith reference to the beam local co-ordinate system

A cross-section is oriented so that the centroidal axis y is identical with beam local axis Y and the centroidal axis z is identical
with beam local axisZ. If the 1Dmember isbeing rotated around its localXaxis, also the sectional centroidal axes rotate.

Beam co-ordinate system

The beam co-ordinate system is a three-dimensional right-handed Cartesian co-ordinate
systemwith axesmarked x, y, and z.

Each 1D member is defined bymeans of two end points – by a "starting point" and by an "end point". Each 1D member has
got a unique local co-ordinate system, the origin of which is located in the starting point of a 1Dmember. The x-axis isalways
identicalwith the longitudinal beamaxisand its direction is from the staring point towards the end point. Bydefault, the y-axis
isgenerallyhorizontal (unless the beamorientation prevents this) and the z-axis isgenerally vertical (again, unless the beam
orientation in space prevents this configuration).

For example, a horizontal beamhasboth xand yaxishorizontal and the zaxis is vertical pointing upward. Similarly, a vertical
column has the xaxis vertical and both yand zaxesare horizontal.

The local co-ordinate system can be rotated around its x-axis if required.
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In addition to this local co-ordinate system, also a principal (or main) co-ordinate system can be referred to on a 1D mem-
ber. The principal co-ordinate system of a 1Dmember is related to the principal co-ordinate system of the cross-section of a
1Dmember.

Right-handed coordinate system
It may help you to determine the direction of individual beam axis, if you remember what you (probably) learnt at school.
Take your right hand, position your thumb, index finger andmiddle finger so that theyare perpendicular to each other. Then
the following applies (see also the image below):

l the thumb points in the direction of the x-axis,
l the index finger points in the direction of the y-axis,
l themiddle finger points in the direction of the z-axis.

Geometric block co-ordinate system
Some of geometric blocks use a specific co-ordinate system. The system is used only throughout the phase of block defin-
ition. The concrete co-ordinate system, if applied, isalwaysdisplayed in the dialogue for blockdefinition.

Point definition co-ordinate systems

Introduction to point definition
Any geometric entity is defined by positions of its vertices. The vertices are defined as points inserted into required location.
Any inserted point, regardless the entity type it relates to, can be defined in one of the following co-ordinate systems:

l Cartesian co-ordinate system

l Cylindrical co-ordinate system

l Spherical co-ordinate system

The choice of a particular systemdependson several factors:

l how is the point position defined in themodel drawings,

l what is themost efficient andmost easiest way for the specific situation,

l which particular system ispreferred by the user.

Cartesian co-ordinate system
A point in the Cartesian co-ordinate system is uniquely defined by three length co-ordinates x, y, and z. The individual co-
ordinates represent the distance of the point from the origin of the co-ordinate systemmeasured along individual axes x, y,
and z respectively.
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Cylindrical co-ordinate system
In the cylindrical co-ordinate system the co-ordinate of any point is given by three components r, theta, and z. The co-ordin-
ates r and theta represent polar co-ordinates of a point in xy plane. And the z co-ordinate is a distance of the defined point
from xyplane.

Thus the ordinate along x, y, and zaxisare respectively:

x= r ×cos (theta),

y= r ×sin (theta),

z=z.

Spherical co-ordinate system
In the spherical co-ordinate system the co-ordinate of any point is given by three components r, Psi, theta. Thus the ordin-
atesalong x, yand zaxisare:

x= r ×sin (theta) cos (Psi),
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y= r ×sin (theta) sin (Psi),

z= r ×cos (theta).

Polar UCS explained
This topicwill explain using polar UCS in 2D resultsdialog (see "Parameters for displayof results")

UCS polar option is beneficial for circular, semi-circular or curved slabs. When using this option, all internal forces will be
recalculated in tangential and radial direction with centre according to user defined UCS. This values should be used when
user will decide to design reinforcement in tangential and radial directions (outside of Scia Engineer). See imagesbelow and
notice the different internal forces for Local andPolar UCS.

semi-circular slab
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UCS local, internal forces mxD-

UCS polar, internal forces, mtD-

User should avoid to use sectionswith averaging values, in near proximity to centre of polar
UCS where big peak values can appear (due the singularity in the centre of polar UCS)
and return distorted values.
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Conventions for applied physical quantities
Input quantities conventions
The following notation and conventionsare user in the programand in the programdocumentation.

Axes
global X Y Z

local x y z

External forces
Fx Fy Fz Mx My Mz

Prescribed displacement and rotation
global Ux Uy Uz Fix Fiy Fiz

local ux uy uz fix fiy fiz

Both external forces and translations are considered as positive when acting in the direction of an appropriate axis. E.g.
Force defined in global co-ordinate system and acting in the direction of the positive global X-axis is taken as positive. Force
defined in global co-ordinate system and acting in the direction opposite to the direction of the positive global X-axis is taken
asnegative.

Output quantities conventions
The following notation isuser in the programand in the programdocumentation.

Axes
global X Y Z

local x y z

Displacement and rotation
global Ux Uy Uz Fix Fiy Fiz

local ux uy uz fix fiy fiz

Reactions
Rx Ry Rz Mx My Mz

Internal forces
N Vy Vz Mx My Mz
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Stress
sig x sig y sig z

tau xy tau yz tau xz

Note:Moments Mx and Mz in a beam are considered positive around the positive local x
and z axis respectively. Moment My , however, is considered positive around the
NEGATIVE local yaxis.

Units
Introduction to units
SCIAEngineer supports variousunit types.

SI units International system of units (metric practice)

FPS units foot-pound-second unit

Imperial, English units, US unit FPS unit

Length units

Imperial length units
The imperial units for length are:

l inch (in),

l foot (ft).

The official values for conversion are:

quantity multiply by to obtain

inch 25.400 millimetre (mm)

foot 0.3048 metre (m)

Display style of length units
Displaystyle of length units isdefined by format, precision and unit symbol.

Format
The format can be:

l scientific (1.55E+01)

l engineering (15.50E+00) (the exponent is ..., -09, -06, -03, +00, +03, +06, +09, ... )

l decimal (15.50)

l fractional (15 1/2)

Precision
The precision for scientific and decimal format isdefined as follows. Sample value is3.1415926
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Decimal length inUnits Setup Precision Result

0 0 3

1 0.1 3.1

2 0.01 3.14

3 0.001 3.142

4 0.0001 3.1416

etc. etc. etc.

The precision for fractional format isdefined as follows.

Fractional precision inUnits Setup Precision

0 1

1 ˝

2 Ľ

3 1/8

4 1/16

etc. etc.

Unit symbol
unit symbol

millimetre mm

centimetre cm

decimetre dm

metre m

inch (1st option) in

inch (2nd option) "

foot (1st option) ft

foot (2nd option) ‘

foot-inch (1st option) ft in

foot-inch (2nd option) ‘ "

Example
The value is78.24 cm.

Format Precision Unit symbol Result

scientific 0.001 centimetre (cm) 7.824E+01 cm

scientific 0.01 millimetre (mm) 7.82E+02 mm

engineering 0.001 centimetre (cm) 78.240E+00 cm

engineering 0.01 millimetre (mm) 782.40E+00 mm

decimal 0.01 centimetre (cm) 78.24 cm

decimal 0.001 inches (in) 30.803 in

decimal 0.001 inches (") 30.803 "
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decimal 0.001 feet (ft) 2.567 ft

decimal 0.001 feet (') 2.567 '

decimal 0.001 feet-inches (ft in) 2 ft 6.803 in

decimal 0.001 feet-inches (' ") 2' 6.803"

fractional 1/16 feet(') 2-9/16'

fractional 1/16 inches (") 30-13/16"

fractional 1/16 inches (in) 30-13/16 in

fractional 1/16 feet-inches (' ") 2' 6-13/16"

Input of length units
For metric units (mm, cm, dm, m), the scientific and decimal formats are supported. Once the value is input, the value is
transformed into the defined format, precision and unit.

For the imperial units (in and ft), the scientific, decimal and fractional formats are supported. The use of symbols " and ' is
supported. The fractional input (-1/2, -3/4, …) is supported. When entering fractions, the fractionsmust be separated from
the rest bya hyphen. Once the value is input, the value is transformed into the defined format (scientific, decimal, fractional),
precision and unit symbol.

It is always possible to enter a number in greater precision than defined by settings. The precise value is stored internally
and the displayed value reflects theUnits setup.

Examples for imperial units
Input string Display setting Result

3.5 decimal, inches (") 3.5"

3-1/2 decimal, inches (") 3.5"

5' decimal, inches (") 60"

5.3' 6" decimal, inches (") 69.6"

5.3' 6.6" decimal, inches (") 70.20"

5.3' 6.6 decimal, inches (") 70.20"

3.5 decimal, feet (') 3.5'

3-1/2 decimal, feet (') 3.5'

5' decimal, feet (') 5.0'

5.3' 6" decimal, feet (') 5.80'

5.3' 6.6" decimal, feet (') 5.85'

5.3' 6.6 decimal, feet (') 5.85'

3.5 fractional, feet (')-inches (") 3' 6"

3-1/2 fractional, feet (')-inches (") 3' 6"

5' fractional, feet (')-inches (") 5' 0"

5.3' 6" fractional, feet (')-inches (") 5' 9-5/8"

5.3' 6.6" fractional, feet (')-inches (") 5' 10-1/4"

5.3' 6.6 fractional, feet (')-inches (") 5' 10-1/4"
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Angle units
The displayof the angle unit isdefined by the format and the precision.

Format
l decimal degrees (45.000)

l degrees/minutes/seconds (45d0'0")

l grads (50.000g)

l radians (0.7854r)

Precision
The precision of angle units isanalogous to decimal format of Length units.

Similarly to Length units, the settings for displaystyle of angle units can bemade inUnits setup.

Units Setup
In SCIA Engineer the user uses and comes into contact with a good number of various physical quantities. In order to allow
the user to adjust preferable unitsand displaystyle of these quantities, the programoffersameans for user’sadjustment.

The adjustment can be done inUnitsSetup dialogue.

Unit "parameters"
Unit It sets the unit in which the value of appropriate quantity is displayed.

Decimal length It defines number of decimal digits to be displayed when the corresponding quantity is displayed.

Output format It specifies the format of displayed value for individual the quantity. See below.

Output format

decimal standard representation of a number
78.24 cm

782.4 mm

scientific representation of a number bymeans of a base and an exponent

7.824E+01
cm

7.82E+02
mm

engineering
representation of a number bymeans of a base and an exponent, where the exponent is
always a multiple of three

78.240E+00
cm

782.40E+00
mm

fractional

fractional representation of a number bymeans of a fraction 3/16 in

deg/min/sec representation of a number used for angles

ft in representation of a number used for imperial units 2 ft 6.803 in
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The procedure for adjustment of units

1. Open dialogueUnitsSetup:

1. either usingmenu function Setup >Units,

2. or using buttonUnits ( ) on toolbar Project.

2. Make the required settings.

3. Confirmwith [OK].

Note: For more information about units see chapter Terminologyand conventions>Units.
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Layout and operation

Title bar
The title bar is the heading of the applicationwindow. It consistsof three parts:

l the program icon (on the left side of the bar)
l text information about the application name
l text information about the nameof the opened and active project and the number of the active project window
l three control buttons for (i) minimising the applicationwindow, (ii) making the applicationwindow full-screen, and (iii) clos-

ing the application on the right side of the bar.

Note: The first and the last feature of the title bar is the common feature of any Microsoft
Windowsapplication.

Example of a title bar

Status bar
The status bar is a bar placed at the bottom of the application window. It is used to display information about the program
and/or about the functions under process and it contains a few control elements. By default the status bar shows the fol-
lowing information:

co-ordinates of the
mouse cursor position in
UCS

When a function requiring the definition of a point (e.g. insertion of a 1D member) is running,
the status bar shows the cursor position in the current user co-ordinate system.

co-ordinates of the
mouse cursor position in
GCS

If selected in the application settings the status bar shows the co-ordinates also in the global co-
ordinate system.

project length units
The bar displays the current length unit (e.g. meter, inch, etc.). The unit can be easily changed
by simple clicking on the unit box on the status bar.

orientation of working
plane

The working plane box of the status bar shows the current orientation of the working plane. The
orientation can be changed by clicking on the working plane box or by pressing F11.

[SNAP mode] This button opens SNAP mode dialog. (F6)

[Filter for selections] Switches selection filter based on main tree or service.

[Current UCS]
This button displays the current UCS for the active window. If pressed, it opens the UCS man-
ager.

[Active code] A small icon shows the flag of the country whose code is currently set as active.
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The status bar also displays a brief help text for program elements like a toolbar button or a menu function if the mouse
cursor is just being placed on such an element.

Example of a statusbar

Note: The statusbar in the picture doesnot show the global co-ordinatesof themouse pos-
ition. Thisoption can be switched on or off in the Application settings.

Menu bar
The menu bar is, by default, located just under the Title bar of the application window. It can be, however, moved into
another position within the application window. It can be either docked to the left or upper edge of the application window, or
it can be let floating anywherewithin theworkarea.

Majority of SCIA Engineer functions is accessible via this menu. There are some functions that can be accessed only from
the treemenu of from toolbars.

Example ofmenus

- 59 -



Chapter 3

menu
View
>
View

menu
Modify
>
Curve-
s edit
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Helpmenu - Local help,WebHelp, eLearning or FAQsare available.

There are shortcutsdisplayed inmenus:

Tree menu window
The treewindow issimilar in function to themenu bar but it ismore readable and user-friendly.

The individual itemsof the treemaybe:

service It opens another tree menu in the same window. E.g. service Structure, Loads, etc.

function It opens a specific function, e.g. Point load in node, Cross-link, etc.

branch
It opens a branch of the tree and shows individual functions in it. E.g. branch Point load offers functions Point
load in node and Point load on 1Dmember.

How to operate the tree menu
The procedure to operate the tree menu is very straightforward and closely resembles the operating rules for standard
MicrosoftWindows tree control.

Opening branches of the tree
The tree consists of amain branch and possible sub-branches. If an item hasa sub-branch, it is indicatedwith a plus sign (+)
in front of the item name. The sub-branch can be opened (listed on the screen) by means of either (i) a left mouse button
single click on the plus sign or (ii) a left mouse button double-click on the item name. If the same action ismade with already
opened a branch, the branch isclosed.
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Activating tree branch items
In order to activate an item of a branch (either amain branch item that opensa service or sub-branch item that opensa par-
ticular function), simply double-click on the item name with the left mouse button. Depending on the item type either a cor-
responding function isactivated or a particular service treemenu isdisplayed.

If the branch item represents a particular function, it can also be activated using a button at the bottom part of the treemenu
window.

Closing a service
In order to close thewhole service you can do the following:

l press the [Close] button.

Closing a function
In order to close the function, you can use one of the followingways:

l press the [Esc] keyonce.

l click the [Arrow] ( ) button on the toolbar at the top of the command line.

l invoke thewindow pop-upmenu and select function End.

Terminating a function
In order to abandon the activated function without accepting the already made changes, press [Ctrl] + Break keys sim-
ultaneously.

It is also possible to invoke thewindow pop-upmenu and select functionCancel.

Example of a treemenu

One click in main tree
To enhance speed of work in main tree, there is a possibility to turn ON one click opening in main tree. Setting can be found
inOptions - Setup - Other.
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Command line
The command line provides for the following:

l some functionscan be activated via typing the appropriate command,

l List of commands (after typing "?" in command line).
l if any function hasbeen already called (regardlesswhether via the command line, menu, treemenu, or toolbar button), it

displaysguiding instructionson the command line,

l if any function requires a numerical input (e.g. co-ordinates of an inserted point), the corresponding value or valuesmay
be typed on the command line.

Especially the second feature is very useful particularly for beginning users as they are clearly guided through the function
theywant to use and can simply follow the presented step-by-step instructions.

You can accesscommand line via right clickmenu in toolbar area.
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Command line can be docked or auto-hidden asother frames inmainwindow.

Syntax of commands
The syntaxof a command to the command line is:

command parameter1 [parameter2] [parameter3] [etc.]

Example
SELBEAM1
Thiscommand adds the 1Dmember namedBEAM1 into the current selection.

Syntax for input of co-ordinates
The important thing to be aware of is that if a co-ordinate is typed bymeans of one or two numbers only, it is considered to
be defined in the activeworking plane of the current user co-ordinate system.

If the point is defined bymeans of three values, it is considered to be defined in the current user co-ordinate system. In this
case, the orientation of theworking plane isnot taken into account at all.

General syntax for the definition of a point
[prefix] [number] [separator] [number] [separator] [number]

Prefix

none absolute co-ordinate in UCS

@ relative co-ordinate related to the last input point, defined in UCS

* co-ordinate in GCS

@* relative co-ordinate related to the last input point, defined in GCS

Number

[space] [sign] [nnn] [.] [nnn] [exp] [sign] [nnn]

[space] if any, ignored

[sign] sign plus or minus (‘+’ or ‘-‘)

[nnn] row of digits 0,1, ..., 9

[,] decimal comma or point

[exp] exponent – sign ‘e’ or ‘E’

Separator
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; length value follows

< angle value follows

Syntax for the definition of a point in Cartesian co-ordinates
[*,@][X],[Y],[Z]

Examples

12.4;45.8;12.4 absolute point co-ordinate in UCS 12.4, 45.8, 12.4

123.4;345.8 absolute point co-ordinate in the current working plane of the UCS 123.4, 345.8

@123;23;5 relative co-ordinate related to the last inserted point in UCS 123, 23, 5

@123;23 relative co-ordinate related to the last inserted point in the current working plane of the UCS 123, 23

@123 relative co-ordinate related to the last inserted point in the current working plane of the UCS 123, 0

*123;23;5 global co-ordinate in GCS 123, 23, 5

* the origin of GCS 0, 0, 0

Syntax for the definition of a point in polar co-ordinates
[*,@][length]<[angle]

Examples

123<90 absolute co-ordinate of point in UCS 0, 123, 0

123<180 absolute co-ordinate of point in UCS 0, -123, 0

Syntax for the definition of a point in spherical co-ordinates
[*,@][length]<[   angle]<[angle] 

Example

123<90<90 absolute co-ordinate of point in UCS 0, 0, 123

Syntax for the definition of a point in cylindrical co-ordinates
[*,@][length]<[angle],[length]

Example

123<90;200 absolute co-ordinate of point in UCS 0, 123, 20

Syntax for imperial units
If the imperial (fractional) units are used, the number must be terminated by a semicolon (;). Without thismark it is not pos-
sible to determinatewhere the number ends.

Examplesof valid input in "feet":

8; =0yd 8ft

12ft 8; =0yd 12ft 8in

12ft 8in; =0yd 12ft 8in

3yd 5; =3yd 5ft 0in
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3yd 6ft 8; =3yd 6ft 8in

3yd 6ft 8in; =3yd 6ft 8in

format without spacesalsomaybe used :

8; =0yd 8ft

12ft8; =0yd 12ft 8in

12ft8in; =0yd 12ft 8in

3yd5; =3yd 5ft 0in

3yd6ft8; =3yd 6ft 8in

3yd6ft8in; =3yd 6ft 8in

Commands
Abbreviations
Command: By the “command” is meant the string used to run some actions from the command line. Commands usually
contain dots, e.g. “Structure.1d.Beam”

Shortcut : By the “shortcut” is meant string used wgicg is shorter substitution to full lenght command. Some commands
doesnot have corresponding shortcuts. Type "?" to command line to see full list of commands.

Using of commands

Installation
Commands and shortcuts are available immediately after the installation of the SCIA Engineer. It is not necessary to install
anything special neither to do anychanges in the settings.

Each commandmay be started again without its selection. Use key "Enter" when the com-
mand is finished, and the command isstarted again automatically.

For quick non dialog access you can use "Shift+ Enter " in command line. Useful for com-
mand member, when you can immediately input 1d member, without dialog specifying
properties.

Protection
Commands and shortcuts belong to general functionality. They are not protected by any module and are available for all
users. However user is still able to run actionssupported byhis licence only. E.g. user which doesnot have nonlinearity in his
licence cannot start inserting of “Beam local nonlinearity”

Customization
Commands
Commandsare defined bySCIAand cannot be changed by the user.

Shortcuts
Shortcutsare also defined bySCIA, but theycan be changed (customized) byusers.
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Stepsneeded for customization of shortcuts:

1. Go to Setup / Options / Environment

2. Press [Customize shortcuts] button

3. File with customized shortcuts is opened. It is possible to add there new rows with customized short-
cuts.Show default commands]

Format of rows in the file isFull.Dot.Command=shortcut

(e.g. Structure.1d.Member =member )
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4.Restart SCIA Engineer

Original shortcuts are available together with the new onesafter the customization. In case
of duplicity the customer’s shortcutshashigher priority than the original one.

It is possible to open file with default commands to search and copy full namesof commands using [Show default
commands]

Localization
There can be available different commandsand shortcuts for different languages. It dependson level of localization for each
country.

In case there are different commands for some country they are used together with English commands. Localized com-
mandshave higher priority than theEnglish ones..

The number “9” in the namesof files (mentioned in chapter related to customization) indicates the language. In case you are
using different language, the number in filesnameswill be different.

It is possible to use different *.usercmd file for each language. In such case the *.usercmd related to current language has
higher priority than theEnglish (9) one .

The complete order of searching of the command is following:

l Customized shortcuts for the current language
l Customized shortcuts for English language
l SCIAdefined shortcuts for current language
l SCIAdefined shortcuts for English language
l Full command names for current language
l Full command names for English version
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Basically, if youwant to use one user defined shortcutsacrossversionsand languages, use
one defined for English (number 9, you canmanually overwrite name of the .usercmd file in
user folder)

Functionality coverage by commands

General
Commands are available only in open project. If there is not any project opened then it is not possible to use command line
for starting actions.

Actions available via commands
Commands and shortcuts cover major part of available actions within SCIA Engineer. Following types of actions are
covered bycommands:

l actionsstarted from the tree
o inserting of entities (structuralmembers, supports, loads, libraries ...)
o running of calculation
o displaying of resultsand checks

l actionsstarted from toolbars
o modification of entities (copy,move, rotate, ...)
o changing of view (view point, zoom, view parameters, ...)
o actionsduplicatewith action started from the tree (calculation, libraries, ...)

l starting of variousmanagersand tools (galleries, document,…)

Actions not available via commands
It is not possible to modify running action using command line. E.g. when the inserting of beam is running it is not possible to
change e.g. snapping or geometryof the beamusing command line.

Commandsare not available in Document, GCSeditor, ODA.

Also selectionscannot be changed using commandsor shortcuts.

List of commands
The following table list the available commands including system-defined abbreviations (where available).

You can access this list by typing "?" into the command line.

Command Abbreviation Short explanation

Redo Redo

Undo Undo

Tools.Activity.Activityonoff =act Activity On/Off

Tools.Activity.Drawinactivemembers =drawinact Draw inactive members

Tools.Activity.Activitybyselection =actsel Activity by selection (Selected membersOn)

Tools.Activity.Invertcurrentactivity =invact Invert current activity

Tools.Activity.Activitybyworkingplane =actwp Activity by working plane

Tools.Activity.Activitybyclippingbox =actcb Activity by clipping box
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Command Abbreviation Short explanation

Tools.Activity.Activitybyselectionoff =actseloff Activity by selection (Selected membersOff)

Command.endcontinue =ec End+Continue

View.Viewx =x View X

View.Viewy =y View Y

View.Viewz =z View Z

View.Axo =axo AXO

View.Zoomin =zoomin Zoom +

View.Zoomout =zoomout Zoom -

View.Zoomall =zoomall Zoom all

Tools.Ucs.Ucsby3points =ucs3p UCS by 3 points

Tools.Ucs.Xyworkplane =wpxy XY workplane

Tools.Ucs.Yzworkplane =wpyz YZworkplane

Tools.Ucs.Xzworkplane =wpxz XZworkplane

View.Viewparam.Showall =vpa Set view parameters

Tools.Ucs.Accordingtoentitylcs According to entity LCS

Tools.Ucs.Gcs =gcs GCS

Tools.Ucs.Gcsparallel =gcspar GCS parallel

Tools.Ucs.Verticalorthogonaltox =wpvx Vertical orthogonal to X

Tools.Ucs.Verticalorthogonaltoy =wpvy Vertical orthogonal to Y

Tools.Ucs.Verticaldefinedbyline =wpvl Vertical defined by line

Tools.Ucs.Move =wpm Move

Tools.Ucs.Rotate =wpr Rotate

Tools.Ucs.Perpendiculartoucssx Perpendicular to UCS's X

Tools.Ucs.Perpendiculartoucssy Perpendicular to UCS's Y

Tools.Ucs.Accordingtoview =wpbyview According to view

Tools.Ucs.Previous =wppre Previous

Command.End =END End

View.Cbox.new Clipping box - new

View.Cbox.Dotgridtracksettings Dot grid and tracking setting

View.Cbox.Onoff Clipping box (on/off)

Modify.Move =move Move

Modify.Rotate =rotate Rotate

Modify.Scale =scale Scale

Modify.Mirror =mirror Mirror

Modify.Copy =copy Copy

Modify.Trim =trim Trim

Modify.Extend =extend Extend

Modify.Breakinpoints =bk Break in defined points

Modify.Connectmembers =connect Connectmembers/nodes

Modify.Polylines.Insertnode Edit polyline - insert node

Modify.Polylines.Insertnodeatintersections Edit polyline - insert node at intersections

- 70 -



Layout and operation

Command Abbreviation Short explanation

Modify.Polylines.Deletenode Edit polyline - delete node

Modify.Polylines.Breakintosinglecurves Edit polyline - break into single curves

Modify.Polylines.Fillet Edit polyline - fillet

Modify.Multicopy =multicopy Multicopy

Modify.Curves.Arcbyradius Edit curve - arc by radius

Modify.Curves.Arcbybulge Edit curve - arc by bulge

Modify.Curves.Arcbyangle Edit curve - arc by angle

Modify.Curves.Bezierweightfactor Edit curve - bezier weight factor

Modify.Curves.Curvetoline Convert curve to line

View.Zoomallselection =zoomsel Zoom all - selection

Modify.Delete =del Delete

View.Cbox.Alphanumericaledit Alphanumerical edit

View.Cbox.Aroundselectedentity Around selected entity

View.Cbox.Move Move

View.Cbox.Attachtoworkplane Attach to workplane

Modify.Breakinintersections =bix Break in intersections

View.Cbox.Fromucs FromUCS

Modify.Disconnectlinkednodes =disconnect Disconnect linked nodes

Modify.Polylines.Joincurvesintopolyline Join curves into polyline

Modify.Join =join Join

View.Cbox.Aroundallentities Around all entities

Modify.Stretch =stretch Stretch

Modify.Copyadddata =copyadd Copy add data

Modify.Moveadddata =moveadd Move add data

View.Perspectiveview =per Perspective view

Modify.Curves.Linetocirclearc Convert line to circle arc

Modify.Reversecurve =reverse Reverse orientation

Modify.Curves.Loinetoparabolicarc Convert line to parabolic arc

Modify.Curves.Linetobezier Convert line to bezier

Modify.Curves.Linetospline Convert line to spline

View.Generatestructuralmodel =gensm Generate structural model

View.Redraw =re Redraw

View.Regenerateview =reg Regenerate view

Command.Cancel =CANCEL Cancel

View.Viewparam.Showselected =vps Set view parameters for selected

Modify.Copyadddata =copyadd Copy add data

Modify.Moveadddata =moveadd Move add data

BIM.Align Align

Tools.Paperspacegallery =papg Paperspace gallery

Tools.Printpicture =prip Print Picture

Tools.Printdata =prid Print Data
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Command Abbreviation Short explanation

Tools.Report =er Engineering report

View.Viewparam.Showhideloads =shlo Show / hide loads

View.Viewparam.Showhidesufraces =shsur Show / hide surfaces

View.Viewparam.Rendergeometry =rengeo Render geometry

View.Viewparam.Rendermodeldata =rendata Render model data (loads, the hinges,...)

View.Viewparam.Showhidesupports =shsup Show / hide supports

View.Viewparam.Showhidemasses =shmas Show / hide masses

View.Viewparam.Showhidemodels =shmod Show / hide models

View.Viewparam.Showhideadditionalmodeldata =shamod Show / hide additional model data

View.Viewparam.Showhidefemesh =shfem Show / hide FE mesh

View.Viewparam.Showhidedotgrid =shdg Show / hide dot grid

View.Viewparam.Showhideresult =shres Show / hide result

View.Viewparam.Showhidelabelofnodes =shlno Show / hide label of nodes

View.Viewparam.Showhidelabelofmembers =shlme Show / hide label ofmembers

View.Viewparam.Showhidelabelofloads =shllo Show / hide label of loads

View.Viewparam.Analysismodelvolumes =amvol Analysismodel - volumes

View.Viewparam.Analysismodelaxes =ama Analysismodel - axes

View.Viewparam.Structuralmodel =sm Structural model

Tools.Activity.Activitybylayers =actlay Activity by layers

View.Viewparam.Showhidereinforcement =shrei Show / hide reinforcement

View.Viewparam.Showhidelabelreinforcement =shlrei Show / hide label reinforcement

View.Viewparam.Showhideothermodeldata =shmodd Show / hide other model data

View.Viewparam.Wired =w Wired

View.Viewparam.Transparent =t Transparent

View.Viewparam.Rendered =r Rendered

View.Ortho =ortho On/off Ortho

View.Tracking =trace On/off Tracking

Tools.Activity.Activitybystorey =actsto Activity by storey

Tools.Activity.Activitybystoreyup =actstou Move activity by storey up

Tools.Activity.Activitybystoreydown =actstod Move activity by storey down

Drawings.Drawingmanager =drwman Drawing manager

Results Results

Results.1d.Internalforcesonbeam =rifb Internal forces on beam

Results.Reaction.Reactions =react Reactions

Steel.Check =stec Check

Results.1d.Deformationsonbeam =rdb Deformations on beam

Results.1d.N =rn N

Results.1d.Mx =rmx Mx

Results.1d.Vy =rvy Vy

Results.1d.Vz =rvz Vz

Results.1d.My =rmy My
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Command Abbreviation Short explanation

Results.1d.Mz =rmz Mz

Results.1d.Ux =rux ux

Results.1d.Uy =ruy uy

Results.1d.Uz =ruz uz

Results.Reaction.Rx =reax Rx

Results.Reaction.Ry =reay Ry

Results.Reaction.Rz =reaz Rz

Results.Reaction.Mx =remx Mx

Results.Reaction.My =remy My

Results.Reaction.Mz =remz Mz

Results.Deformedstructure =rd Deformed structure

Results.Displacementofnodes =rdn Displacement of nodes

Results.Reaction.Resultantofreactions =resreact Resultant of reactions

Results.1d.Relativedeformation =rrd Relative deformation

Results.Reaction.Intensity =ri Intensity

Structure.Billofmaterial =bom Bill of material

Results.Reaction.Reactionline =rrl Reaction line

Steel.Checkfireresistance =sfirecheck Check - fire resistance

Results.Reaction.Foundationtable =ftable Foundation table

Results.1d.Connectionforces =rcf Connection Forces

Results.1d.Connectioninput =rci Connection input

Results.1d.Memberstress =rms Member Stress

Steel.Steelslenderness =sslend Steel slenderness

Results.Calculationprotocol =Calcprot Calculation protocol

Results.Eigenfrequencies =rei Eigen frequencies

Results.Criticalloadcoefficients =rcc Critical load coefficients

Concrete.1D.Concreteslenderness =cslend Concrete slenderness

Results.2d.Displacementofnodes =rpldn Displacement of nodes

Results.2d.Member2dinternalforces =rplif Member 2D - Internal Forces

Results.2d.Member2dstresses =rpls Member 2D- Stresses

Results.2d.Member2dcontactstresses =rplcs Member 2D- Contact stresses

Concrete.2D.Design.Memberdesignuls =cdesuls2D Member design ULS

Concrete.2D.Design.Memberdesignulssls =cdessls2D Member design ULS+SLS

Results.1d.Relativedeformationnocheck =rrdnocheck Relative deformation

Concrete.2D.Design.Deformations =cdef2D Deformations

Results.Subsoilcparameters =rscp Subsoil - C parameters

Results.Subsoilotherdata =rsod Subsoil - Other data

Results.Reaction.Nodalspacesupportresultant =nssr Nodal space support resultant

Results.1d.Shearstress =rss Shear stress

Results.2d1dupgrade =r2d1dup 2D/1D upgrade

Results.2d.Sigeplus =rsigepl SigE+
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Command Abbreviation Short explanation

Results.2d.Sigeminus =rsigemin SigE-

Results.2d.Mx =rplmx mx

Results.2d.My =rplmy my

Results.Deformed1d2dstructure =rd1d2d Deformed Structure

Concrete.2D.Design.Member2ddeformations Member 2D deformations

Concrete.2D.Design.Voidedslabshearresistance =cvoidsres Voided slab shear resistance

Concrete.Billofprestressreinforcement =cpbom Bill of prestress reinforcement

Results.Accelerationofnodes =rdn Acceleration of nodes

Results.Displacement =disp 3D displacement

Results.Stress =sss 3D stress

Steel Steel

Steel.Checkdata.Bucklingdata =sbuckl Member buckling data

Steel.Checkdata.Ltbrestraints =ltbres LTB Restraints

Steel.Checkdata.Webstiffener Web stiffener

Steel.Checkdata.Diaphragms Diaphragms

Steel.Checkdata.Fireresistance =sfire Fire resistance

Steel.Checkdata.Memberdata Steel member data

Steel.Setup Setup

Steel.SetupBS Setup

Steel.Connections.Check Check

Steel.Characteristicbeamfactor Characteristic beam factor

Structure.Modeldata.Sectiononbeam =bsection Section on beam

Steel.Checkdata.Webcripplingdata Web crippling data

Steel.Checkdata.Overlapdata Overlap data

Steel.SteelsetupEC =Steelsetup Steel Setup

Steel.Connections.Setup Connections Setup

Steel.Checkdata.Additionallateralrestraints Additional Lateral Restraints

Steel.Checkdata.Localtransverseforcesdata Local Transverse Forces data

Steel.Slschecks =sslsc SLS Checks

OpenConnection Open connection

Steel.Checkdata.Links =slink Links

Steel.Checkdata.Stiffeners =sstiffen Stiffeners

Steel.Connections.Framestrongaxis Frame bolted/welded-strong axis

Steel.Connections.Frameweakaxis Frame bolted/welded-weak axis

Steel.Connections.Gridpinned Grid pinned

Steel.Connections.Bolteddiagonal Bolted diagonal

Drawings.Sectiontolinegrid Plan view

Drawings.Section =secv Section

Drawings.Planviewtodwg Export section/Plan view to DWG

Drawings.Generalsection General section

Drawings.Sectiontolinegrid Storey-to-Plan view
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Command Abbreviation Short explanation

Drawings.Sectiontolinegrid Section-to-Line grid

Drawings.dimensions.linear.Aligned =dal Aligned

Drawings.dimensions.linear.Horizontal =dhor Horizontal

Drawings.dimensions.linear.Vertical =dvert Vertical

Drawings.dimensions.Stationing.Horizontal =dshor Horizontal

Drawings.dimensions.Stationing.Vertical =dsvert Vertical

Drawings.dimensions.Stationing.Aligned =dsal Aligned

Drawings.dimensions.baseline.Horizontal =dbshor Horizontal

Drawings.dimensions.baseline.Vertical =dbsvert Vertical

Drawings.dimensions.baseline.Aligned =dbsal Aligned

Drawings.dimensions.baseline.Angular =dbsan Angular

Drawings.dimensions.Radius =dra Radius

Drawings.dimensions.Diameter =ddi Diameter

Drawings.dimensions.Arclength =darcl Arc length

Drawings.dimensions.Angular =dan Angular

Drawings.dimensions.Arcangular =darcan Arc angular

Drawings.dimensions.Label =dlab Label

Drawings.dimensions.Labelwithleader =dlable Label with leader

Library.Materials =mat Materials

Library.Crosssections =css Cross-sections

Library.Catalogueblocks =licb Catalogue blocks

Library.Namedcsitem Named item

Library.Analysis.Crosssectionlist =licsli Cross-section list

Library.Analysis.Sectionmatrix Section matrix

Library.Analysis.Productrange Fabricated Css, Product range, Joists

Library.Analysis.Nonlinearfunctions =nlf Nonlinear functions

Library.Analysis.Hingetype =hit Hinge type

Library.Analysis.Initialdeformations =inidef Initial deformations

Library.Analysis.Buckling =buckl Buckling

Library.Analysis.Emodulusfunction =efun E modulus function

Library.Prestessing.Fittinghollowcoreslabs =hcfit Fitting hollow core slabs

Library.Dampers =damper Dampers

Library.Analysis.Orthotropy =liort Orthotropy

Library.Steel.Diaphragms =diaph Diaphragms

Library.Steel.Bolts =bolts Bolts

Library.Steel.Boltdiameterrelation Bolt diameter relation

Library.Steel.Connectiondatatocss Connection data to CSS

Library.Steel.Hallconnection Hall connection

Library.Concrete.Stirrups =stirrups Stirrups

Library.Concrete.Longitudinalreinforcement =longrnf Longitudinal reinforcement

Library.Concrete.2dreinforcementmesh =2drnf 2DReinforcementmesh
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Command Abbreviation Short explanation

Library.Prestessing.Boreholepatterns =bhp Bore hole patterns

Library.Prestessing.Sectionalstrandpatterns Sectional strand patterns

Library.Prestessing.Stressingbeds Stressing beds

Library.Prestessing.Tendonsourcegeometry Tendon source geometry

Library.Prestressing.Typeofstressing Type of stressing

Library.Composite.Hollowcoreslab Hollow core slab

Library.Composite.Compositeslabdata Composite slab data

Library.Composite.Shearconnectors Shear Connectors

Library.Geotechnics.Subsoils =subs Subsoils

Library.Geotechnics.Geologicprofiles =geop Geologic profiles

Library.Geotechnics.Geologicareas =geoa Geologic areas

Library.Geotechnics.Padfoundations =pads Pad foundations

Library.Loads.Predefinedloads =pdl Predefined loads

Library.Loads.Windpressures =winpres Wind pressures

Library.Loads.Seismicspectrums =seisp Seismic spectrums

Library.Loads.Dynamicloadfunctions =dlfun Dynamic load functions

Library.Loads.Unitmobileload Unit mobile load

Library.Loads.Mobileloadsystems Mobile load systems

Library.Loads.Loadpattern Load pattern

Library.Fireheat.Thermaldistributioncurves Thermal distribution curves

Library.Fireheat.Insulations =insul Insulations

Library.Fireheat.Temperaturetimecurve Temperature-time curve

Library.Analysis.Functionoftimedependency Function of time dependency

Library.Analysis.Functionoftemperaturedependency Function of temperature dependency

Library.Concrete.Cellularbeamtype =cellb Cellular beam type

Library.Loads.Trains Trains

Library.Drawing.Drawingstyle =dwst Drawing style

Library.Layers =lyr Layers

Library.Ucsmanager =liucs UCS

Library.Loads.Linesettlement =linesetl Line settlement

Library.Parameters =prms Parameters

Library.Loads.Combinations =lcomb Combinations

Analysis.Calculation =calc Calculation

Analysis.Hiddencalculation =hicalc Hidden calculation

Tools.Picturegallery =pig Picture gallery

Tools.Units =Units Units

Library.Loads.Resultclasses =rclass Result classes

Library.Templatesetting =templs Parameters template settings

Project =proj Project

Analysis.Checkstructuredata =checkdata Check structure data

Library.Loads.Massgroups =massg Mass groups
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Command Abbreviation Short explanation

Analysis.Meshgeneration =meshgen Mesh generation

Library.Loads.Nonlinearcombinations =nlcomb Nonlinear combinations

Library.Loads.Stabilitycombinations =stbcomb Stability combinations

Library.Loads.Combinationofmassgroups =masscomb Combination ofmass groups

Library.Loads.Concretecombinations =concomb Concrete combinations

Absences.Absencegroups Absence groups

Analysis.Solversetup =so

List of keyboard shortcuts
Default shortcuts in SCIA Engineer
Scia Engeneer providesset of basic shortcutsasdefault. See the list below:

Keyboard shortcut Definition

F1 Opens help page

F2 Opens structure service

F3 Opens load service

F4 Opens results service

SHIFT+F4 Opens results service (v17)

F5 Refresh of results

CTRL+F5 Recalculation (available for solverlink calculation only)

CTRL+SHIFT+F5 Calculation

F6 Cursor snap setting dialog

CTR+F6 Next view port

CTRL+SHIFT+F6 Previous view port

F7 On/Off tracking

F8 Ortho

F9 Move LCS

F10 LCS according to entitiy

F11 Switchesworkplane (XY,XZ, YZ)

CTRL+F11 SetsGCS

F12 Sets view perpendicular to workplane

CTRL+F12 Sets view to AXO

CTRL+SHIFT+F12 On/Off perspective

CTRL+Q Activity On/Off

CTRL+W Activity by layers

CTRL+E Activity by selection (Selected membersOn)

CTRL+R Rotate

CTRL+T Create plate

CTRL+Z Undo

CTRL+O Opens new project

CTRL+P Print picture
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Keyboard shortcut Definition

CTRL+A Selects all

CTRL+S Save

CTRL+SHIFT+S Save as

CTRL+D Activity by selection (Selected membersOff)

CTRL+SHIFT+D Coordinates info dialog

CTRL+SHIFT+F Match properties

CTRL+G Opens line grid and storeys service

CTRL+SHIFT+G Line grid manager

CTRL+SHIFT+H Create wall

CTRL+J Cross-sections

CTRL+K Combinations

CTRL+L Load cases

CTRL+Y Redo

CTRL+X Move entity

CTRL+C Copy entity

CTRL+N New project

CTRL+B Create 1d member

CTRL+SHIFT+B Create column

CTRL+M Materials

CTRL+TAB Next opened SCIA Engineer project

CTRL+SHIFT+TAB Previous opened SCIA Engineer project

Default shortcuts in Engineering Report
Scia Engeneer providesset of basic shortcutsasdefault for Engineering report aswell. See the list below:

Keyboard shortcut Definition

CTRL+P Opens print dialog

F5 Regenerate outdated

F6 Regenerate selected

Property table
A property table is a SCIA Engineer unique control used in the program dialogues and in the Property window. The control
looks like a table (basically a two columnmulti-row table) whose first column contains names of individual items displayed in
the table and the second column shows their values.

Generally, the values in the "value cells" of the property table may be modified. There are variousmeans for the change of
the value (see bellow). In addition, the individual items of the table may be interlinked either (i) to another part of the pro-
gram (e.g. another dialogue) or (ii) to a graphical window. Both variants represent a powerful feature increasing sig-
nificantly the simplicityand speed of editing process.

In order to unify the appearance of the programdialogues, the property table isalso used even for passive displayof inform-
ation. In such a case, the "value cells" are disabled to prevent an accidental alteration of the values.
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Type of property table cells
name cell It contains the name of the itemwhose value is displayed in the coupled value cell.

group cell
This is a special case of the name cell. Sometimes, the name cell is standalone and is not coupled
with any value cell. This is used to display e.g. the name of a group of items.

value cell
This cell holds the corresponding data. The data may or may not be edited depending on the par-
ticular situation.

The value cell may be of several types. Where possible, the cell terminology is taken from the standard MS Windows ter-
minology for dialogue boxcomponents. In parenthesis, a descriptive name isadded (if applicable).

edit box

(simple value cell)

The basic type of cell provides for manual input of value. Depending on the particular item the
value may be either numerical or alphanumerical.

combo box

(selection list cell)

This control is used for items where the proper value is defined by selection from a list of available
variants.

tick box

(yes/no cell)
This type of cell provides for two limit value only – for YES and NO.

button The button can be used to start a required type of action, e.g. open a dialogue, etc.

colour list This type is similar to the combo box. The difference is that it offers colours only.

Combination of cell types in one table cell
The individual cell typesmay be combined within a single cell. That means that, for example, one table cell may consist of a
combo boxand a button, or of three edit boxes.

This feature isused e.g. in tableswhere a cross-section should be specified. The table sell then contains:

l a combo boxwith all cross-section alreadydefined in the current project,

l a button that opens the Cross-section manager and thus provides for the definition of a new cross-section type if none of
the existing onesmeets requirementson the particular item.

Interconnection between table cells and graphical window
In some dialogues, individual table itemsmay be related to a specific part of the drawing shown in the graphical window. In
such a case, it would be useful:

l to highlight the appropriate part of the drawing if the corresponding table cell is selected, or

l to highlight the appropriate table cell if the corresponding part of the drawing hasbeen clicked on.

The SCIA Engineer property table makes this possible. Therefore, where applicable and useful, the appropriate table cells
are interlinkedwith corresponding drawing parts.

As an example we may give the dialogue for editing of a cross-section. Here, the dimensions of a cross-section represent
exactly what this feature is ideal for. On clicking any of dimension lines in the drawing, the corresponding table row is high-
lighted, and vice versa.

Example of a property table
The picture below shows the cross-section editing dialogue. The mouse cursor is positioned in the graphical window of the
Cross-section manager over the height dimension line. After the left mouse button was clicked, the corresponding item in
the table above the picture got the focus (the blue item).
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Progress bar
Especially for large models, some actions performed in SCIA Engineer may be rather time consuming. In order to tell the
user what the progress is, a progressbar is shown on the screen.

It simply:

l indicates that the program isworking,
l measureswhat portion of the totalworkhasbeen already finished.

The progressbar mayappear either in amodal dialogue or on a statusbar.

It may look like e.g.:

Note: If the application window is not maximized, it may happen that the progress bar can-
not fit into the statusbar whose length is limited by the adjusted width of the application win-
dow. In that case, the progressbar that would normallyappear on the statusbar is invisible.

User Interface Skins
SCIA Engineer can be run with a standard Graphical User Interface (GUI) or with a simplified user interface. The latter is
analogous to skins used in some other programs. In SCIA Engineer, these "skins" do not just alter the look of the program,
but theymay also reduce the available functionality (they are not capable of extending the functionality). Thismay be useful
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for clients who focus on a particular group of problems. For example, if you use SCIA Engineer as a modeller and do not
intend to perform anykind of calculation, it is redundant to have in themenu functions for input of loads, supports, hinges, for
start of calculation, review of results, etc.What’smore, it is also possible to change the arrangement of toolbarsand treewin-
dow and change iconson toolbars.

Agood example of a practical application of this technology is3D Free FormModeller.

3D Free FormModeller is an application based on the full SCIAEngineer, but leaving aside calculation and code check cap-
abilities. In addition, as it is intended for Allplan users, it replaces some standard SCIA Engineer-style icons on toolbarswith
icons fromAllplan, with the onlyaim: tomake it easier for Allplan users toworkefficientlywith 3D Free FormModeller.

Toolbars
Toolbars
Toolbars are small floating windows-like objects containing sets of buttons. The buttons can be used for opening various
functions. The toolbarsmaybe let floating on the screen or maybe docked to anyside of the screen.

Examples
View

Geometricalmanipulations

You may control which toolbars are displayed in menu View > Toolbars. Thismenu function enables you to switch on or off
the required toolbars. Moreover, you may use this function to display or hide other parts of the Graphical User Interface
(GUI).

You can also control displayof toolbars through right-clickdrop downmenu.
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Another partsof GUI that can be displayed or hidden:

l treewindow,

l propertywindow,

l report previewwindow,

l command line,

l statusbar,

l table input,

l table result,

List of available toolbars:

l Basic (New,Open, Projectmanager),

l Project (e.g. units, crosssection,materialsetc. ),
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l Tools (e.g. UCS, clipping box, etc. ),

l View,

l Activity,

l Geometrymanipulation (e.g.Move, Copy, etc.),

l Dimension Tools,

l Modelling tools (e.g. Boolean operations with general solids, Generation and modification of vertices on general solids,
etc.),

l Scales,

l Selection of objects.

Predefined toolbar arrangements
Even though youmay freelymove the toolbarson your screen and let them "flow" or dock them to anyside of applicationwin-
dow, you can also select from two predefined configurationsof toolbars in right-clickdrop downmenu or in setup.
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l Light –Default arrangement ,

l Full – addsDimension andModelling tools toolbarsand someother buttons to another toolbars

l Customized byuser – user defined state of toolbars (position, number or content throughCustomize dialogue)

Note: Switch of configurationswill take effect after restart of SCIAEngineer

Customizing the toolbars
Toolbars can be customised by the user. It is possible to reshape the toolbars, add or remove buttons from individual tool-
barsand to define new tailor-made toolbars.

- 84 -



Layout and operation

Each toolbar has a little-arrow button (the button is located at the right end of the toolbar if the toolbar is docked and at the
toolbar header if the toolbar is floating - see the two imagesbelow) .When the little-arrow button is clicked a submenu opens
with optionAdd or remove buttons. This item then offersseveral sub-items:

l the namesof toolbars that are docked in the same "toolbar-row" (in case of a floating toolbar, it containsonly the nameof
the particular toolbar),

l itemCustomise that opens theCustomize dialogue (described further in the text).

Picture: little-arrow button (markedwith red circle) on a floating and docked toolbar

Reshaping the toolbar
Each floating toolbar can be reshaped. Simply put the mouse cursor over an edge of the toolbar, click the mouse left button
and drag.

Example:

Hiding buttons from a toolbar

1. Click the little-arrow button on the required toolbar and open the sub-menu.
2. Select the nameof the toolbar youwant tomodify.
3. Another "sub-menu" with a complete list of available standard buttons for the toolbar isopened.
4. Unmark the buttonsyouwant to hide and select the buttonsyouwant to see.

If the toolbar if floating, this procedure canmodify only the toolbar whose little-arrow button
hasbeen clicked. If the toolbar is docked, this procedure can accessall the toolbars located
in the same "toolbar-row".

Dialogue "Customize"
You can customize toolbarsviaCustomize dialogue (content, order or new buttons).

Customizing keyboard shortcuts via customize dialogue
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Scia Engineer providespossibility to define user shortcuts in customizemenu.

See the default keyboard shortcuts.

Those shortcutscan be replaced and re defined in customizemenu aswell

Keyboard tab

This tab offersa list of all available commandsand possibility to assign keyboard shortcut to them.

You can search for commands through search text line or click into the list and start typing first letters of command you look-
ing for.

Description field can help you to findwhat you are looking for.

You can see if the command has already assigned an shortcut and you will be notified in case you will try to assign keyboard
shortcut which isalready in use byother command.

"Reset all" buttonwill discard all user-defined shortcutsand return the setting to factorydefault.

Carry the customised shortcuts between different computers
The settings adjusted on one computer can be easily transferred to another computer. It can be useful, for example, if one
engineer workson several different computersor if a teamwants to share the same settings.

The settingsmade by the user are stored in folder for "User settings files" that isdefined in theSetup > Options dialogue.
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Look for .useracc file in user folder. Just simplycopy this file and input it under the user folder on another computer

TIP: you can use customize dialogue to assign shortcuts for commands to open services in
main tree andmake your workflowmuch faster

Customizing toolbars via customize dialogue

Adjusting of the toolbars when customize dialogue is active
You can change order of buttonswithin toolbarsbyeasydrag and drop in toolbar itself.

Discard the button from toolbar bydrag it andmove it outside of toolbar.
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Commands tab

This tab offersa list of all available toolbarsand their buttons.

When on this tab, you can drag-and-drop anycommand from the dialogue to anydisplayed toolbar.

1. Select the required toolbar in the left list.
2. Select the required button in the right list.
3. Click it and drag to the required toolbar.
4. Release themouse button - the selected function isadded to the target toolbar.

You can change order of buttonswithin toolbarsbyeasydrag and drop in toolbar itself.

To remove a button fromanyof the existing toolbars, just "drag" the required function away from the toolbar (theCustomize
dialoguemust be opened).
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1. Select the function to be removed froma toolbar.
2. Click it and drag it anywhere away from the toolbar (outside the toolbar area of all toolbars).
3. Release themouse button and the function is removed from the toolbar.

Discard the button from toolbar bydrag it andmove it outside of toolbar.

Toolbars tab
On this tab you can:

- displayor hide anyof the existing toolbars,

- reset the toolbar to the default configuration,

- create a new toolbar(s),

- delete you user-made toolbar(s),

- rename you user-made toolbar(s),

When you create a new toolbar, swap to theCommands tab and drag-and-drop the required functionson it.
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TIP: you can use customize dialogue to create new toolbar and add there buttons related
to opening services in main tree (structure, results, etc.) and make your work flow much
faster.
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Reset do not work for user defined toolbars.

When a new toolbar is created, it may not appear in the list of existing toolbars in the Cus-
tomize dialogue. In that case, close theCustomize dialogue and reopen it. The new tool-
bar will be listed there then.

Customize dialogue

Customize dialogue isa servicewhich allow user to adjust toolbarsan d customize keyboard shortcuts.

Access to customize dialogue:
Right-clickdrop downmenu

Toolbar drop downmenu
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Application windows
Introduction to application windows
All the information that the program can give to the user is displayed in an application window. An application window can of
the following types:

l graphicalwindow,
l document window,
l previewwindow.

The user can use all the window types at the same time and swap between them freely, or he may use just one type at a
time. It dependscompletelyon hisor her will and habits.

At the same time, as many graphical and document windows can be opened as the user considers convenient to him. On
the other hand, there can be opened just one previewwindow.

Graphical window
Thiswindow can be perceived asa drawing board, however with rather advanced functionality. Amodel defined by the user
is displayed in thiswindow. The individual parts of a model can be literally drawn in thiswindow. All selections of any function
are made in this window type and any response of the program to the user’s action affecting the model is shown in this win-
dow. Also the calculated results are shown in this window. The window both displays the project data and receives inform-
ation from the user provided bymeansofmousemovesand clicking.

An arbitrary number of graphical windows, regardless of their type, can be opened at the same type for one or several dif-
ferent projects.
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Example of a graphical window

Viewports
The term "viewport" is taken fromAllplan andmeansa graphicalwindow.

TheWindowmenu offersseveral predefined arrangementsof viewports (windows).

1 viewport
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2 viewports

3 viewports

4 viewports (1)
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4 viewports (2)

Besides, it is of course possible to arrange thewindows in anyother way that suits your needsor habits.

Graphical window pop-up menu
Every graphical window that SCIA Engineer creates has a pop-up menu associated with it. This menu provides for a fast
access to some frequentlyused functions.

To access thismenu,move themouse pointer so that it iswithin thewindow - not inside the title bar, nor on thewindow'sbor-
ders. Then press the rightmost mouse button to make the menu appear on the screen. Then move the mouse to highlight
the required option. Click the leftmost button to start the selected action.

Thewindow pop-upmenu isdescribed in detail in a separate chapter Basicworking tools>Window pop-upmenu.

Example of a pop-up menu
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Antialiasing

What antialiasing is
The prefix “anti” can be defined as counteracting or neutralizing. Aliasing is a jagged, stair-step effect on curved or diagonal
lines. Therefore anti-aliasingmeans to counteract and neutralize jagged lines.

Image demonstrating Aliasing effect. On first picture aliasing effect can be noticed on slab edges. Second picture displays
same structurewith antialiasing (AA) algorithm switched on.

How antialiasing works in SCIA Engineer
There is variety of antialiasing algorithms available. Most of them are directly supported bymodern 3D graphic cards hard-
ware as theyare part of OpenGL instructionsset. Starting SCIAEngineer 2012we use one from varietyof algorithmscalled
Accumulation Buffer Antialiasing. We plan to support more different algorithms in the future to provide user with best pos-
sible output, similar asknown fromother 3Dmodeling programsor even 3D gaming industry.

Basically all antialiasing algorithms requires to generate 3D Scenemore times or on higher resolutions than it is actually dis-
played on user display. Therefore all antialiasing algorithms slows down response of 3D control. This slowing down effect
mainly depends on actual hardware - 3D graphic card. The faster the hardware is, effect of slowing down the 3D Scene is
lessevident.

SCIA Engineer native antialiasing algorithm comes with 3 predefined settings. Quality of output was carefully balanced to
speed reduction.

None
Antialiasing algorithm iscompletely switched off. Aliasing effect can be seen on curved or diagonal lines.
Medium quality
Antialiasing algorithm runs with very gently and balanced attributes. When using standalone 3D graphic card,
user should not notice anysignificant speed reduction on small tomedium sized projects.
High quality
Attributes of antialiasing algorithm are more than double as high as for Medium quality, therefore speed reduc-
tion might become evident. This option is comfortable for users using modern 3D graphic card on small to
medium sized projects. It is not recommended to use thisoption on extreme sized projects such ashigh-rise build-
ing or huge apartment blocks. Project size ismeant to be number of entities that 3D Control has to display at the
same time. Therefore for example even that bridge design project is challenging from engineering perspective,
does not mean big challenge for 3D control speed. As opposite to this, a huge steel structure consisting of thou-
sandsof beamsmight become verychallenging to handle.
Super quality
This setting is meant to be used by users, who prefer to use latest available hardware. Generally this option
makes sense to be used to export high quality output images, such as bitmap or clipboard images. Main dif-
ference in algorithm attributes to High quality is level of blur that is used to lower aliasing effect. This setting might
become highly subjective, as jagged linesmight looks slightly different than original - some linesmight appear to
be more thick than before while some edges might appear to be smudged comparing the original picture.
However at the same time, final output might appear more natural in documentation or print, giving more
"photorealistic" feeling. Slow down is noticeable even on fastest hardware, but is fairly usable on small - medium
sized projects. Important precondition is to use powerful 3D graphiccard.
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Typical use
Standard user with typical or older hardware

This typically includes standard notebooks, laptops or desktop computers 3 or more years old. For this kind of users, pre-
ferred default option is to switch Antialiasing OFF for 3D Scene manipulations. However users can still benefit from higher
antialiasing levels, but onlywhen exporting the final picture - to Document, Gallery, Clipboard or file.

User with latest hardware
This user is using latest desktop hardware with high-resolution display. User use modern 3D graphic card, such as Nvidia
Quadro or similar product line. User is keen to experiment with various settings for different projects. It is highly usable for
him to useMedium toSuper quality levels for hiseverydaywork.

Examples
SCIA Engineer antialiasing algorithm is valid for completely all 3D scene content. As SCIA Engineer is primarily FEM ana-
lysis tool, it is worth to explore the option on various types of analysis results, such as deformed mesh or internal forces dia-
gram courses. This will add extra readability level to SCIA Engineer output and it will produce pleasant and professional
looking pictures. This output not only represents structural engineer, but extra readability level adsextra benefit to all picture
outputs.

Couple of exported imageswithNone / Super quality switched on.

Any 3D Scene picture with antialiasing switched on can appear different when viewed by
individuals with varying levels of color sensitivity. People with various levels of astigmatism
might find antialiased output to be uncomfortable to work with. Therefore after any sign of
anysubjective discomfort it is recommended to keep this setting switched off.

Before:

After:
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Before:

After:

Before:
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After:

Document window
Thiswindow type is used to display a document or report about an analysedmodel, its input data, results of calculation, and
assessment to technical standards (i.e. code check). Thiswindow can contain both graphical and text information.

An arbitrary number of document windows, regardless of their type, can be opened at the same type for one or several dif-
ferent projects.

Example of a document window
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Preview window

Introduction
ThePreviewwindow isa document-likewindow that can be used for tabular preview of selected entitiesor results.

Manyprinciples are shared with Engineering Report, thereforemany instructions related to using of Preview window will be
identical to instruction related to Engineering report.

Opening the Preview
The procedure for the opening of the Previewwindow for non-results tables:
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1. In the graphicalwindow of SCIAEngineer select the entities that should be included into the preview.
2. Call function Print / Preview table:
1. either usingmenu function File >Print data >Print / Preview table,
2. or clicking button [Print] on toolbar Project.

3. The previewwindow isopened and tablesare displayed
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The procedure for openingPreviewwindow for result tables

l Press the action buttonPreview in the resultsproperties

Previewwindow can be also opened from themenuView / Toolbars
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Note: If the Preview window has been already opened, its content is replaced with the
appropriate new tables.

Switching between new on old preview window
Conservative usersmay still use old preview window. The switching can be done in Setup / Options / Other dialogue on the
panelClassicGUI.
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Printing the preview
Content of Preview window can be printed using two buttons. Left one opensprint preview backstage view with possibility to
modify printing parameters (those parameters are same as in Engineering Report). The right one start printing with the last
used setting.
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Exporting preview
Content of the Preview window can be exported using the Export button. There are the same possibilities as in exporting of
EngineeringReport.

Adjusting Preview window

Adjusting displaying
Zooming
It is possible to select one ofmajor zoommodes (fit to window, fit pagewidth, 100%) using toolbar buttons.
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Graphical presentation of numerical values
Graphical presentation of numerical valuescan be switchedON/OFF using the toolbar button.

- 106 -



Layout and operation

Preview template
Content of the preview window consists of the selected table (see the chapter Opening the Preview) and preview template.
Preview template can contain all entitieswhich can be inserted into Engineering Report. The content of Preview template is
placed before the selected table.

The typical content of the Preview template isdefinition of Page layout, Page format andVisual style.

Selection of Preview template
The current preview template can be selected in theOption dialogue:

There are two predefined report templates in the installation of SCIA Engineer. The one with Letter page format for United
statesand the second onewith A4 page format for the rest of theworld.

Creating of new Preview template
Creating of Preview template is veryeasy:

1. Define its content in the EngineeringReport.
2. Store it using theSave as preview template command.
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Editing of Preview templates
For editing of existing Preview templates follow those steps:
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1. Insert content of existing Preview template in EngineeringReport. Preview templatesare listed in the list of new items

2. Modify the content of the report
3. Store it using theSave as preview template command
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Property window
Property window
Propertywindow can be easilyopened or closed via right-clickmenu in TBarea, or fromViewmenu.
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The property window has its name derived from a property table that is displayed in it. The property window summarises
parameters, characteristics and selected options of particular entities such as nodes, 1D members, loads, result diagrams,
etc.

Example of a propertywindow

The property window always shows information related to the selected entities or selected function. However, the property
window has been designed to not only passively display the properties, but also to provide for fast and easymodification of
them.

If the current selection consists of only one entity, generally all the parameters can be modified. If more than one entity has
been selected, the propertywindow automatically applies a filter and displays the parameters that the selected entities have
in common.

Example of a propertywith common properties in one selection
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Example of switch between element type in property tree

If a function hasbeen started, the propertywindowmaycontain some switches thatmayaffect the behaviour of the function.
Most of the functions from service Results are good examples as the property window enables the user to select required
quantity to-be-displayed, adjust the style of result diagrams, etc.

Propertywindow containssome additional functions, accessed fromheader
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Select elements by more
properties

You can select elements based on multiple elements. You will be asked for "master" ele-
ment first, then dialog with properties will appear. You can select one or more (CTRL+click)
propeties. All elements based on selected properties will be added to your selection.

Select elements by property
Will select all elements of same type (beam, slab, line load, etc.) which shares selected prop-
erty value in property grid. Only one property can be selected.

Update property dialog Update property dialog

Member Switch to entity properties tab

Design group Switch to entity design group

Format painter tool Start format painter tool

Attributes editor Opens attribute editors

Delete selected attribute Delete attribute

Action buttons
As the name suggests, the Property Table comprises properties of a particular part of a structure model. Sometimes how-
ever, the property table containsalso a control that startsa particular action related to the element whose propertiesare dis-
played in the table.

If such controls (buttons in particular) are put somewhere inside the table, they may be overlooked. Therefore, these but-
tonswere "extracted" from the table and are located in a special section called Actionswith Action buttonsin it.

Thus, all the actions that are accessible for the current properties or for the "property-owner" are visibly and clearly sep-
arated from the often long list of information and can be easilyaccessed.

Sometimes action buttons are highlighted in red. Thismeans that some changes which leads to different presentation was
done (ex.: changing parameters for Results)

Action buttonsare used in variouspartsof SCIAEngineer.

Action buttons in the Property Window
The table below presentssome (not all) applicationsof Action buttons.
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service Steel >

function Check

Refresh

It redraws the screen in order to reflect the changes made in the Property Window (see also
Refresh of results).

Default keyboard shortcut - F5.

Single check It opens a dialogue that provides for checking of a single selected 1Dmember.

AutoDesign It opens a dialogue for the AutoDesign of selected 1Dmembers.

Split CSS Splits the cross section

Unify CSS Unify the cross section

Table results It opens the Table results and create new tab with results.

Preview It opens the Previewwindow and displays the relevant information in it.
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service Results >

function Internal
forces

Refresh

It redraws the screen in order to reflect the changesmade in the PropertyWindow (see also Refresh
of results).

Default keyboard shortcut - F5.

Detailed It will draw detailed result of selected member in 3d window.

Table results It opens the Table results and create new tab with results.

Preview It opens the Previewwindow and displays the relevant information in it.

Action buttons in Database managers
Action buttonsare used for example in theCombinationsdialog.

Seemore in chapter Exploded combinations.

Modal property window

Propertiescan be displayed (andmodified) in twomodes.
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The first mode isstandard Propertywindow.

Second possibility is to useModal propertywindow.

The standard property windows displays properties of selected entities but the modal property window display property of
just one entity.

Themodal propertywindow can be opened via pop-upmenuwhen cursor isover some entity.
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Second possibility (since version 14) how to open the modal property dialogue is using mouse double-click on some entity.
One of those two actionsopensmodal propertydialoguewith propertiesof the entity.

Opening of modal property window via double click works only in case of Single selection
mode. In case of Multi selectionmode is necessary to press combination of keysCtrl+Shift
together with double click.

Database managers
Introduction to database manager
A database manager is a tool that provides for all possible operations related to manipulation with entities stored in some of
program databases. The term "program database" stands e.g. for a database of materials, cross-sections, catalogue
blocks, etc. defined in a current project.

It is obvious that:
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l individual entitiesof these databasesmust be somehow defined,

l theremust be away to edit them, copy them, delete them,

l the user must have an opportunity to review parametersof the individual entities,

l theremust exist a procedure to select one entityasa "default" for functions requiring an entityof that type asan input para-
meter,

l the approach to all these pointsmust be unique regardless the type of database.

Examplesof database dialogs:

Material

Crosssections
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Layout and operation of a database manager
Amanager consistsbasicallyof the following controls:

List of defined entities of a par-
ticular database

The list shows all the entities related to the database of the manager that have been defined in the
current project so far.

Property table
This table shows a brief summary of parameters for the database entity that is just selected in the list
of already defined entities (see above).

Graphical window
This window displays a drawing of the database entity whose parameters are just listed in the prop-
erty table.

Control buttons
The buttons provide the access to the functions that are accessible from within the particular man-
ager.

Filter The filter allows for a readable representation of data in the Manager.
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List of defined database entities
The list summarises all the database entities that has been defined in the project. Most often, the list contains names of the
entities. However, if useful and practical, some additional informationmaybe added next to the name.

Property table
The property table displays parameters for the entity that is selected in the list of defined entities. It provides for a quick
review of the parameter values. Someof the parameterscan also be edited here. But normally, themodification of the para-
meters isperformed in the editing dialogue for a particular entity type.

Graphical window
This window contains a schematic drawing of the database entity the parameters of which are presented in the property
table. Thiswindow is fitted with a pop-upmenu. Themenu offers the user some important functions related to the displayed
entity.

Control buttons
There are several control buttons in theManager that allow to user to use various actions that maybe performed with data-
base entities.

button meaning

[New]

This button opens the New entity dialogue where a new entity can be defined and inserted into the
current project.

The newly defined entity is inserted at the end of the list of defined entities.

[Insert]

This button also opens the New entity dialogue where a new entity can be defined and inserted
into the current project.

But, the newly defined entity is inserted before the currently selected entity in the list of defined entit-
ies.

This feature can be used to have the entities in user-defined order and not in the order of inser-
tion.

[Edit]
This button opens the Editing dialogue for the entity currently selected in the List of defined entit-
ies. The Editing dialogue provides for thorough and detailed review or editing of the entity para-
meters.

[Delete]
This button allows the user to get rid of those entities of the particular database that are no longer
necessary in the project.

[Copy] The Copy button makes a copy of the entity that is selected in the List of defined entities.

[System
database]

It enables the user to read items from a standard system database.

[Read] It enables the user to read database items from an external file – user’s database.

[Save] It saves selected entities of the database to an external file – user’s database.

[Text Out-
put]

This button opens the preview window and displays all the parameters in it for the entity that is
selected in the List of defined entities.

[Close]
This button has got two functions. First, it sets the currently highlighted item in the List of defined
entities as the active (or current) entity. Second, it closes the database manager.
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[Unify]

This button enables the user to select items from the list of defined items that will be united with the
currently selected item.

Thus it is possible to get rid of excessive number of doubled items, or to establish a single item for
entities that originally used several items (e.g. to assign one cross-section to 1D members that ori-
ginally had different cross-sections). See Example below.

Example - function Unify
Let ussuppose that we have defined three beams, each of themof a different cross-section.

Later youmaywant to unify the section of the two left beamsand have both of themof rectangular cross-section. Of course,
you may edit the properties of the beam and change its cross-section. On the other hand, sometimes it may be useful to
"unify" the sections (and if required, get rid of the abandoned cross-section type, that can be automatically deleted from the
database).

You call theUnify function tomerge two cross-sections into one. In our example do the following:

1. select the rectangular cross-section,

2. call functionUnify,

3. select the I section,

4. confirmwithOK,

5. the I-section is removed from the project database, two beamsare assigned the same rectangular cross-section.

Filter
The filter provides for more readable representation of data in theManager if the current project containsan excessive num-
ber of defined entities of the particular type. The filter allows the user to set a limited set of entities that are displayed in the
List of defined entities. The entities that do notmeet the chosen criterion are "removed" from the list, but still remain normally
defined in the project.
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Note: Some specific database managersmay contain additional functionality. It is added in
the formof additional control buttons.

Name

Note: The name of any item in anymanager should be up to 8 characters in length. Longer
namesshould not be used andmaybe truncated by the program.

Example of a database manager

Opening the database manager
A Manager is opened whenever the appropriate function is activated. E.g. function Library > Cross-sections opens the
Cross-sectionmanager, etc.

In general, the particular manager is also opened when a general procedure for the definition of a new database entity is
invoked. In such a case, the opening of themanager isusuallyone of the first stepsof the procedure.

From the user’spoint of view a databasemanager isa standardWindowsmodal dialogue. Thatmeans that:

l it is opened via a function associatedwith it,

l it must be closed before the user can continue with the started multi-step action of before another function can be activ-
ated.

l it containscontrol elements that provide for actionsand tasks that are accessible fromwithin themanager.

The operation is simple and straightforward and isclear from the description of layout of a databasemanager.
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Note: The Particular manager can also be opened from various property dialogues that
contain an item associated with the particular database manager Such an item contains a
button to open the appropriatemanager.

Example:
Across-sectionmanager opened fromwithin the propertydialogue of a new 1Dmember.

Pop-up menu of database manager
The graphicalwindow of a databasemanager isequippedwith a pop-upmenu that summarisessome important functions.

Zoom rectangle The user may define the cut-out that should fit into the graphical window.

Zoom all This option zooms the drawing in or out so that the whole drawing fits the available window area.

Gallery It copies the drawing into the Picture gallery.

Document It copies the drawing into the Document.

Print This function prints the drawing on the connected graphical device.
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Copy to clipboard It copies the drawing into the Windows clipboard.

Copy to BMP file It saves the drawing into a WindowsBitmap file.

Copy to WMF file It saves the drawing into a WindowsMeta File.

Table input
Introduction
The Table input is a tool for the simple editing and creating the model in SCIA Engineer 2011 or higher. The main func-
tionality of the Table input is based on a grid system (e.g. Excel, Open office…). User seesall elements in rowsand its prop-
erties in columns, so the table ismore transparent then the propertywindow.

Table input shows all properties even for the multi-selection. Each item is displayed on a
separate row so it wont hide different properties in one cell like the propertywindow.

The table represents the 3D model in numbers, checkboxes, comboboxes, libraries and strings. It allows editing, creating
and deleting itemswithout graphical searching.

It allowscreating new items in structure, libraries, loadsand it allows tomakemodifications.

The filtering row, sort, multiple editboxand activitymake the usage veryeasyand fast.

There are even someuse-caseswhich are difficult of even impossible without Table input - quick renamingmore items,mul-
tiplyall forcesby the samenumber, etc.

Tabs
The table contains tabs for a different typesof the structure. All tabsare sorted to 3 groups - Structure, Load and Libraries.

One tab for 1Dmembersanother tab for point support on point and so on.

Each tab shows the icon of the itemand the crossbutton for simple hiding the tab.

Each tab isdivided to rows, columnsand cells:
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l The row representsonemember – node, beam, plate, support, layer …
l The column representsone propertyof amember – height, FEMmode, colour, name…
l The cell representsone property value – 3m, layer 1, wall (80) …

Cell types
l Number– a simple valuewhich can be changed bydirect editing or pasting another value
l String – a simple value – name–which can be changed bydirect editing or pasting another string
l Combobox – containsa list of values, change can be done byselecting another value from list or bypasting another

value from this list
l Link button – this cell is linked to the library, change can be done byselecting another value in the libraryor pasting

another value from the library (There isa Linkbutton in the cell alwaysdisplayedwith comboboxand it has the
same function)

l Checkbox – two values– yes/no, it can be pasted as1 or 0

Tabs - default settings, order
The Table input is a dockable window in SCIA Engineer. It is displayed by the context menu on the toolbar (similar to com-
mand line, etc.).

Default settings of the Table input
Each tab has a default settings predefined . The order of the visible columns and the width are loaded when the application
starts. The last used layout is loadedwhenSCIAEngineer is reopened.

The last defined layout is saved to the folder User asTableInputSettings.xml.
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When it is deleted, the default order is loaded to SCIA Engineer. Another possibility is to use the Reset GUI button. Go to
Setup / Options / Environment /Reset GUI. The restart of the application is required.

Each tab shows the appropriate icon for the element.

If there isnot enough space for all tabs then arrows for moving are displayed.

Tabs order and visibility
Each tab can be closed by the crosson it.

If onlyone tab isdisplayed, it cannot be closed.

Tabscan be reordered bydrag and drop.

Tab manager
The Table input displays three different groups of items. There are structure, libraries and loads. The context menu on the
tab displays all items in one group. Each itemmaybe added as a visible tab or it can be hidden - this is displayed as selected
or non-selected icon in the contextmenu.

Line support - edge isa visible tab;
Surface support isa hidden tab;

The icons in the Tabmanager matchwith iconsused in the Treemenu.
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Loading content to the tab
The content of the tab is loaded after switching to it. It can take some time for a larger projects. This loading can be paused
by the button on the progressbar.

When the loading is stopped then only a part of the content is displayed. This content can be sorted or filtered. Also pre-
defined sort of filter can be used.

Delimiter
The required delimiter for numbers ismanaged by the operation system. It can be changed to anysymbol.

The examplewith delimiter symbol _:
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In this caseSCIAEngineer accepts3_555 asa number and convert it to the tablewith
delimiter symbol coma.

Tools in Table input - work with columns

Context menu
Table input providesmore types of the context menu. The first is activated from the column header and the second is activ-
ated from the cell.

The special contextmenu isused on the toolbar edit-box.

From the column header:

From the cell:

From the edit-box:
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Column selector and work with columns
Column selector isa tool for displaying anycolumnwith property in the table.

It can be displayed by the button on the toolbar (the first picture) or by the context menu – item Column selector (see the
second picture).
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The selected columnswith properties can be drag&droped to the Table input and stay here as visible. The property can be
dropped between columnswhen two red arrowsare displayed.

And the result:

The column can be hidden by drag&drop back to the Column selector or by drag&drop to the grid (then it is automatically
moved back to theColumn selector).

Another way is to use contextmenu –Hide column.
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The contextmenu containspossibility to add all columnsat once.

Extend and narrow all visible columns
It is possible to extend and narrow all visible columns at once using context menu on the column header – Extend all
columns, Narrow all columns

The valuesare extended or narrowed byapproximately20% of itsoriginal size.

The reason is that the size of a text is managed by the operation system, not SCIA Engin-
eer so this isa fast tool to correct possible problemswith partly-visible headers.

Sorting
Each column can be sorted forward or backward. This functionality is activated by the click on the column header. The sor-
ted column isdisplayedwith the little black triangle.
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The sort can be cleared by the 3rd clickon the column header or by the contextmenu –Clear sort.

Tools in Table input - filtering row

Property filter

Valuescan be filtered byanyproperty in the table. The filter is launched by the toolbar button for filter .

The filter row isdisplayasa first row of the grid. Each cell ismarked byamagnifying glass icon .

The filter cellworkswith part of the value/string or with thewhole value/string.

User maysearch for all cellswhich contains letter "b" or whole "beam".
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Use value from table in the property filter
There isa item in the contextmenu on the cell:

Invalid property for filter
When the property filter isgrey it means that thisproperty cannot be filtered.

The filter cannot be used for coloursand check-boxes.

When the filter stayed
The tabwill remember its filtersduring:

l moving;
l switching to another tab;
l hiding the tab;
l displaying the tab;

The filter will be cancelledwhen the property is removed from the grid.
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More filters together
One of more filter cells may be used together. The filter is saved during sorting, removing column or switching to another
tab.

Cancel the filter

1. The filter for one column iscancelled by the xbutton in that column.

2. All filtersmaybe cancelled by the xbutton in the row header.

3. The filters in the columnsare cancelled by "ESC" keyone byone it the reverse order.

Mathematical operators "< bigger than" and "> lower than" and filtering by interval
There are 3modesof filtering:

simple comparison

Table displaysonly rowswhich have in the selected column value which contain value entered in Filtering row. See following
example:
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"<" and ">" for numerical values

Table displays only rows which have in the selected column value 'bigger than...' or 'lower than...' specified value. See fol-
lowing example:

"<" and ">" for text values

Table displays only rowswhich have in the selected column value 'bigger than...' or 'lower than...' specified string value. The
advanced logic can also handle the naming system often used in civil engineering (e.g. naming of columns - first symbol (let-
ter) according to x line-grid axis, the second symbol (number) according to y line-grid axis). See following examples:
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Filter by open interval "(XXX;YYY)"

The table displaysonly rows that have in the selected column value 'bigger thanXXX' and 'lower thanYYY', where 'XXX' and
'YYY' can be a numerical or string value.
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Filter by closed interval "<XXX;YYY>"

The table displays only rows that have in the selected column value 'bigger or equal to XXX' and 'lower or equal to YYY',
where 'XXX' and 'YYY' can be a numerical or string value. The sorting by closed interval is best to be used for discrete and
round values, such asnamesof entitiesvariousmember propertiesor coordinates.

Tools in Table input - filtering by activity, selection and active load case

Activity filter in Table input
The activity in the 3D window is controlled byActivity tools. The same activity can be used in the Table input. It ismanaged by
the button next to the filterson the toolbar.
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Thisbutton allows filtering the content according to current activity in the 3Dwindow. The default status isON.

When theActivity in Table input isOFF:

When theActivity in Table input isON:
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The activity in the Table inputmaybe combinedwith theProperty filter tool.

Selection filter in Table input
Anyuser-selectionmade in the 3D window is also displayed in the Table Input by yellow highlighted rows. The selection can
be used asa filter in the Table input. It ismanaged by the [SelectedRowsOnly] button next to the filterson the toolbar.

Thisbutton allows for filtering of the content according to current selection in the 3Dwindow. The default status isOFF.

When the [SelectedRowsOnly] isOFF:
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When the [SelectedRowsOnly] isON:

Filter by active load case in Table input
The activity in the 3D window is controlled byActivity tools. The same activity can be used in the Table input. It ismanaged by
the [Active LoadCaseOnly] button next to the filterson the toolbar. Note that button [Active LoadCaseOnly] is enabled only
when entities fromgroup: Load are displayed.

This button allows for filtering of the content according to currently active load case in service Loads. The default status is
OFF.

When the [Active LoadCaseOnly] isOFF:
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When the [Active LoadCaseOnly] isON:

Tools in Table input - selection

Selections
Whole Tab
There are two possibilities to select whole content of the Tab:

1. ClickCTRL+A
2. Click to the top left corner:

One row (=one member)
Thewhole row can be selected bydrag and drop from the first cell to the last one.
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One cell
The cell can be selected byclicking on it.

More cells
More cells can be selected bydragging selection rectangle fromone corner to the other.

Tools in Table input - copy and paste

Introduction
One of the most important functionalities is copy and paste content from/to the clipboard. This can be used for different
typesof applications–most probablyMSExcel.

It allows you to create complex geometry (e.g. defined by some function) with many thousands of nodes and insert it into
Table input in one step.

Copy
Selected content is copied to the clipboard by the context menu (item Copy) or by a standard short-cut CTRL+C. After-
wards, the content of clipboard can be inserted e.g. to MS Excel. To allow clear overview of the copied entities, the table
header is stored in the clipboard together with the copied data.
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Paste
Pasting the selected content back to the table isalso possible using the context menu (itemPaste) or bya standard short-cut
CTRL+V. Data to be pasted can be prepared e.g. in MSExcel. The inserted datamaystart with the table header as the first
line.

Technical details
In this chapter there is brief description how does the pasting of data from clipboard works internally. This knowledge is not
important for using the Table input, but it is good for understanding some issueswhichmayarise.

Table input is intended to allow to paste huge amount of data in a batch. We are able to input e.g. 20 000 nodes in less than
oneminute. There are 2 contradictory requests: to do it quickly and to guarantee that inputted data are consistent. The first
requests implies that ideally there is no data check that makes the code execution time demanding. The second requests
implies that there should bemany checks of input data to guarantee that project won't be damaged by inputting wrong data
set. It is good to realize that finding good balance of these two requests isnot easy.

We can distinguish two basic operations that can also be combined. The first one is related just to editing the actual data, no
new entity is created. The second one regards creating new entities on tabs with the "New row (= new member)" on
page 162. The third is combination of them.

1) Pasting data to modify actual entities
In this case the algorithm goes through particular cells one by one (from left to right, from top to down) and if old and new
value differ it just try to set new value. Sometimes it happens that new value cannot be set (e.g. due to geometrical check or
input value is out of range) at the time. If some value was not successfully changed, at the end of every row the algorithm
tries to set those values once again. If the change wasnot successful even during the second try, algorithm returnswarning
message (if the entity returnssomemessage) and jump to the next row.

Preceding description implies that if the operation is interrupted by the button beside the progressbar the all already finished
changesare accepted.

If editing of some property of some entity causes some warning message, this message is remembered and all messages
from thewhole editing processare displayed in one summarizingwarningmessage in the end.
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2) Pasting data to create new entities using the "New row"
Firstly all new entitiesare internally createdwith some default valuesof propertiesand than theyarewritten into data-server
in one step. If thisoperation is interrupted thewhole operation is cancelled and no entity is created.

The second step is to modify newly created entities and set values defined in clipboard in the way described in "1) Pasting
data tomodifyactual entities".

3) Pasting data both to modify actual entities and creating new entities
In the first step actual entitiesare edited [1) Pasting data tomodifyactual entities].

In the second step new entitiesare created and edited [2) Pasting data to create new entitiesusing the "New row"].

Tools in Table input - send table to Engineering Report
Table can be easily sent to EngineeringReport using the related button on the toolbar:

After clicking thisbutton the standard dialogue "Insert objects to EngineeringReport" isopened:

Afterwards the table is sent to EngineeringReport with respect to "Filtering row" and "Activity in table":

- 145 -



Chapter 3

Sorting of the table grid is not respected during sending to Engineering Report. Items are
afterwards in Engineering Report sorted in default order. Sorting of tables in Engineering
Report can be adjusted in "Table layout editor".

Tools in Table input - send table to MS Excel with one click
Table can be easily sent toMSExcel using the related button on the toolbar:

There are two parts of the export button. By simple mouse left click on the main button with icon of Excel, the default or last
used settings of tabs are exported and immediately opened in MS Excel. The second part of the button is an arrow with
quicksettingsof what selection of tabs isgoing to be exported.
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There are four possibilitiesof simple settings:

Export current
tab

Exports only currently displayed tab of Table input. When you use the Export to Excel button for the first
time, its default setting is set to Export current tab.

Export all cat-
egories

All tables from all categories (Structure, Load, Libraries) will be exported.

Export cat-
egory

All tabs from currently open category will be exported.

Export custom
selection

Additional dialogue will be presented before the export is performed. In this dialogue custom selection
from all possible tabsmay be made.

Export custom selection dialogue for table Input is apparent on image below. In the dialogue single entitiesmay be selected
and there isalso option to select or deselect all or select or deselect whole categories.
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For the first use of export button, its default setting is set to Export current tab to prevent possible long and unintentional
export procedure. For next use of export button, the last used settings is used. During the export process it is checked
whether the tab is empty or not and empty tabs are skipped during the export. When exported, MS Excel is launched and
exported file ispresented. This file is stored in temp folder and for future use it isadvised to save it to a different location.

For better readability of the exported Excel sheet is every tab from table input represented by separate named sheet and
together with exported data the table header is visible in the Excel file.
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Current sorting or filtering of the table grid is not respected during sending to MS Excel.
Items are afterwards in Excel sheet sorted in default order. For copying sorted or filtered
partsof Table input please use theCopyandPaste (Ctrl+C) andPaste (Ctrl+V).

Selection of members
Table input allowsmaking the selection of members in the model using the click on the row header. Selected members are
highlighted in Table input byyellow color.

Example:
There are threemembershighlighted in the Table input and it isalso selected in themodel.

The highlight worksotherwise also - the selection created in the 3Dwindow isdisplayed ashighlighted row/s in the tab/s.

Example: Member B1 and B2 are highlighted in the tab 1D members, they are also selec-
ted in the 3Dwindow and the intersection of their properties isdisplayed in thePropertywin-
dow.

The selection of membersmay be created in the 3D model graphically or in Table input by
the row/shighlight. Bothways leads to the same result - rowsare highlighted, propertywin-
dow displaysproperty intersection and the selection is visible in the 3Dwindow.

The selection could be disabled by View parameters settings, it this case highlight doesn’t
workeither.

Highlight from the Table input
Single highlight:
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l Clickon the row header to select onemember.

Multi-highlight:

l Hold SHIFT or CTRL key (standard short-cuts) to create amulti-selection of rows (in one blockor several rows
together).
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The highlighted =selectedmember displays itsproperties in the propertywindow.

Highlight from the 3D window
Selected items in the 3Dwindow are highlighted in the Table input.

- 151 -



Chapter 3

Add member to the highlighted / selected items
When user highlights one more row (using CTRL key) or graphically selects additional member it is automatically added to
the original selection.

Cancel highlight
The highlight is cancelled byESC key. It can be used in 3Dwindow (a standardway) or in the Table input directly.

TheESC keycancel the highlight in the current tab only, other tabswill keep their highlight.

Select by property in cell
In Table input it is possible to select allmemberswith the same property value byone click:

1. Select one cell in the grid of Table input
2. Click the button "Select byproperty in cell" on the toolbar of Table input
3. Allmemberswith the same property value are selected in themodel and related rowsare highlighted in Table input

- 152 -



Layout and operation

This functionality is similar to filtering the 3Dmodel by the selected property in the propertydialogue (the iconwith funnel).

Multiple editbox
Themultiple editbox is a special tool for the Table input. It can be used for editing values in the cells by formulas, to substitute
values in the cells, for copy row or copyadd data (supports, loads, etc.).

There are two important buttonswhich confirm the content of themultiple editbox.

"Apply edit" button

The button for substitution, searching and using themathematical formulas.
It ispossible to confirm thisbutton byEnter key.

"Copy row" button

The button for copying the row (newmember or new add data).
Mouse click is required for thisoption, Enter keydoesn’t work.
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Editbox right-click menu
Right-clickmenu contains items for mathematical formulas, substitution, search, clear the editboxand copycommand (mem-
ber or add data).

Right click menu for Copy member:

Example for the Copy add data:

Using simple mathematical formulas in the Table input
The editboxsupportsbasicmathematical formulas– add, subtract, multiplyand divide.

The specific symbol for the formulamust be used as the first symbol in the editbox:
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l +3means that numbersadd 3

l -3means that numberssubtract 3

l *3means that numbersmultiplyby3

l /3means that numbersdivide by3
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l ~0,1means rounding by the 1st decimal

Substitution of the value in the cell
The arrow symbol isused for the substitution (or without anysymbol in some cases).

Number substitution
The positive value can be substituted in twoways:

l >+5

l >5

Bothwill substitute the number in the cell, the new valuewill be 5,000.

Negative value:

l >-6

String substitution
String can be substituted in the twoways:
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l With symbol: >B15

l Without symbol: B15

l When the substitution isused onmore cells together namesare automatically renumbered:

B3 is renamed to B16 andB4 is renamed and renumbered automatically to B17

Each entity in the SCIA Engineer has an unique name. B16 can be used when there is no
1D member named this way already. For example new name B2 won’t be accepted, its
alreadyused.

Offset for copy member
The editbox may be used for copying member. Editbox requires the offset definition. The offset value must be written in a
special form -@13 5 or@1;3;5. The last settingsdefine the number of copies.

l Symbol@stands for "copy", 3 numbersdefine the offset in x, yand zdirection.

Example:
@1;1,5;0,8 ->means to copymember with offset 1m in xdirection, 1,5m in ydirection, and
0,8m in zdirection (see the picture).
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These two notations leads to the same result:@1 2 3 and@1;2;3

Owner for copy add data
If the user want to copy some add data, the definition of the new owner is required. The type of the owner depends on the
copied add data (e.g. node name for support in point, member name for line load on beam, etc.).

Example:
Copysupport in point – owner must be the nameof another node;
Copysupport on the beam–owner must be the nameof another beam;
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Search tool
A search tool allows user to find defined value in the table grid. The tool compares the value in the editboxwith values in the
grid step bystep.When the valuematches the cell is selected.

A symbol used for the search tool isa questionmark– see the picture:

Start searching using short-cuts
l CTRL+F – takes the value from the selected cell and copy it to themultiple editbox. Use keyF3 to search the value step by

step through the grid.
l CTRL+F3 – takes the value from the selected cell and copy it to themultiple editboxand immediately searches the first

exactmatch. F3 search value to the bottom.
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Start searching using manual input
l Put the symbol ? (or use the contextmenu itemSearch) to the editboxandwrite down the required value.
l PressEnter (or F3 key) - the fist cellwith exactmatch is selected in the grid.

Using the contextmenu to start searching:

The required valuemust be exact – e.g. not 0 but 0,000.

Example - how to search value 0,000

1. The first selection isCoord X for N4 - value is0,000. Use the contextmenu and select the itemSearch.
2. The value 0,000 iscopied to the editbox..
3. The selection ismoved down byF3 key (or Enter key) and it alwayssearches the next cellwith 0,000 (it goes through par-

ticular columnsone byone).

Copy row
The selected row (=member) can be copied by the button on the Table toolbar. The selected row is copied to the bottom of
the tabwith all propertiesaccording to the original row. The offset of the copiedmember or add data (supports, loadsetc.) is
definedmanually in the editbox.

- 160 -



Layout and operation

Copy structural entity
The entities like beams, slabsor load panels can be copied with predefined offset. Selected row is copied to the bottom. Off-
setmust be defined in themultiple editboxwith symbol@ (see the next chapter aboutmultiple editbox).

Red colour - offset and "Copy row" button;

Magenta colour - selected row for a copyprocess;

How to copy a member:

1. Editbox: write down the symbol@and the offset for a newmember.
2. Select the rowwhich should be copied.
3. Clickon the button "Copy row".

Copy add data
Add data is defined by their properties and by the owner. This owner must be predefined for Copy row. New owner for the
add data ispredefined by the editboxwith symbol@.

Red colour - owner for a selected add data and "Copy row" button;

Magenta colour - selected row for a copyprocess;

The owner is specified by itsname:

l B12 – for a beam
l N35 – for a node
l S11 – for a slab

How to copy add data:

1. Editbox: write down the symbol@and the nameof a new owner for add data.
2. Select rowwith add datawhich should be copied.
3. Clickon the button "Copy row".

See chapter Multiple editbox to findmore info about the editboxand how to use it.

Delete row
The selected rowscan be deleted by the button "Delete row" on the toolbar.
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How to delete row/s (= member/s):

1. Select the row and click the button "Delete row".

Examplewith B2 for deleting:

2. Or selectmore rowsand click the button "Delete row".

Examplewith B2 andB3 for deleting:

New row (= new member)
Anew geometryand entities can be created by the Table input. This functionality is provided byaNew row in tabs. It is a row
with symbol * in the header.

The new row containsorange cellsandwhite cells.

l Orange cells=Required cells;
These cellsdefine the geometry– coordinatesor an owner for add data.

l White cells=Optional cells;
These cellsenable predefining optional properties (layer, system line, offset, thickness ...).

Example - required cells for the tabNode. The node isdefined byX, Yand Z coordinatesso
it must be defined to be able to create a new one.
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The new row isnot available in each tab. E.g. it is not in the tab Layer.

Required cells examples
Coordinates for the structural node:

Begin andEnd node for 1Dmember:

The owner for the Force in node:

In the case of creating 2D members and load panels, the onlymandatory input is the geometry. The geometry is defined by
a sequence of nodes separated by a semicolon ";" or coma ",". When a 2D entity is being created using the Table input, the
validityof inputted data is verified and invalid entitiessuch asentitieswith crossing edgesor entitiesdefined bynodes that are
not in a plane are not created.

Subregions and openings are 2D entities similar to 2D members, however there is additional mandatory input field "2D
member" which represents the name of the 2D member in which the opening or subregion is being defined. For the defin-
ition of geometry of openings and subregions the same validity rules apply as in the case of 2D members and load panels.
Additionally, subregionsand openingshave to be defined in the sameplane as the 2Dmember in which theyare created.
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How to predefine an optional property
The user can predefine optional properties in white cells. Optional property must be filled in before the required cells are
defined. Otherwise itsnot taken into account.

The examplewith 1Dmember:

l The user predefinesType, Cross-section, Layer, LCS rotation and theMember system line position;

l The required cellsare filledwith N2 andN4 afterwards;
l The result isbeamB5:

l All predefined properties (optional and required) are valid so it isaccepted. The rest of the propertiesare filled by the
default settings (the same aswe have in a standard inserting dialogue).

Somepropertiesare dependent on others. In this case themaster property is required.

The examplewith Force in node:

l TheWind pressure curve isdependent on the Type =Wind.

l What happenswhenType isnot predefined (the default settingswith Type Forcewill be used instead):
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l Result: TheWind pressure curve isnot accepted. The Type Force is created. Onlypredefined optional propertyZ dir-
ection isaccepted asa valid value.

l What happenswhen theTypeWind ispredefined:

l Result: TheWind pressure curve andDirection X isaccepted asvalid values. The TypeWind iscreated asa new force.

The tow required cellsare displayed in 2D type of project (e.g.WallXY), The third coordin-
ate isdisplayedwithwhite colour and it isnot required.

Parameters in Table input
It is also possible to workwith the parametrized project in the Table input. Parametric values are displayed in the same way
as in the propertydialogue – comboboxeswith all appropriate parametersand possibility to put value in it.

Comboboxcontainsonlyparameters.

The number can be changed byediting the cell or paste the value from the clipboard.

Example how to paste the number to the cellwith the parameter:

1. Copy the value fromanother cell or fromXLS file.
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2. Paste the value to the cellwith parameter “length”.

3. The cell is changed to the number.

Tips and Tricks

All changesmade in the Table inputmust be accepted by themodel geometry.

Member moving
The position of a member depends on its nodes. It is possible to edit the position of nodes and tune the position of themem-
ber. It is possible tomovemoremembers together.

l Oneway is to change the value coord x, y, z;
l Or change value coord ux, uy, uz;

The change can be done by the substitution or using simple formulas.

Example on the picture:

l Using the substitution >5 to the cells for coord uy -> two columnsaremoved in ydirection;
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l Add +1,5 to the cells coord Z -> two columnsaremoved upward;
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Multi – renaming and renumbering (names)
The editbox isa tool for editing values in the Table input. Renaming and renumbering is important example.

How to renameand renumber more beams together:

1. The aim is to rename beams to bbb_12, bbb_13, bbb_14, etc. Put the first required string to the editbox (bbb_12).
2. Select cellswith beamnameswhich should be changed – clickand drag from the first cell to the last one.
3. Clickon theApplybutton next to theMultiple editbox.
4. Cellsare renamed frombbb_12 to the last one bbb_19.
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Rounding values
Many importedmodelsare inaccurate. The valuesneed rounding. This can be easily fixed using Table input andMSExcel.

1. Copy the content of the node tab to the clipboard and paste it toMSExcel (select cellsand useCTRL+C in Table input):

2. Use functionality for rounding:
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The result:
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3. Copy the content back to the Table input. All valuesare rounded.

Editing more items using multiple editbox
There isa possibility to applyone change onmore selected cells together. Usemultiple editbox for thispurpose.

How to do it:

1. Put the required value to the editboxalone or with the symbol>.
2. Multiselect cells– clickand drag from the first cell to the last one.
3. Clickon theApplybutton next to theMultiple editbox.
4. All selected cellsare changed (e.g. changed to 3, see the picture).

Advantage of the multiple-editbox right-click menu
There are towwayshow to change the symbol for the required operation in themultiple editbox.

l manually - rewrite the symbol (e.g. + to -);
l using right-clickmenu - select the required operation and the symbol is changed automatically;

Appropriate symbolsare displayed in the contextmenu. It can be used asa help.

See example:
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Using filter and activity in Table input
It is possible to use the filter row and switch the activity from the 3D window ON. User has more options to filter elements
which he needs.
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When user highlights a member in the table it is selected automatically in the model
(dashedmagenta line). Themember maybe displayedmore visible using Activity by selec-
tion. This is veryadvantageous for smaller elements.

Zoom to selection + selection link in Table input
It is veryuseful tu use the "Zoom to selection" command together with selection in Table input.

If you want to locate some entity in large project, just use the searching or filtering row in Table input, select the entity and
push the button "Zoom to selection" (on the "Selection of object" toolbar). The selected entity (which is unique based on
someproperties filters) isnicely located in themodel.
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Searching for a cross-section on a big structure
The larger structures generally contain a lot of cross-sections. Sometimes it can be difficult to find one specific cross section.
The Table inputmayhelp in this kind of searching.

1. Open 1Dmember tab.
2. Start the filter row, it isdisplayedwithmagnificent glasses.
3. Write the nameof the crosssection to the cellwithmagnificent glass in the columnCrosssection.
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4. Highlight the rowwith the required element - clickon the row header.
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5. The element is selected in the 3Dwindow and itspropertiesare displayed in the propertydialogue. It can be displayed
separatelyusing the activitybyselection in the 3Dwindow.

Using tab with layer for activity
If user want to use the activity by layers it is very helpful to display the tab with layers in the Table input (group Libraries).
User can change the activity right here. The layer settings are visible here all the time and user is not forced to open the
Layer librarywhen he needs to change the activityby layers.
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Highlight (=select) members according to the selected property in the cell
It is possible to select allmemberswith the same property value using Table input byone click. This functionality is similar to fil-
tering the 3Dmodel by the selected property in the propertydialogue (the iconwith funnel).

How to selectmemberswith the same cross-section:
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1. Open the tabwith 1Dmembers.
2. Clickon the cellwith required cross-section.
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3. Clickon the button "Select byproperty in cell" on the toolbar.
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4. Allmemberswith the same cross-section are selected in themodel and highlighted in the Table input.

Properties of cross-section in the Table input and property dialogue
The tabwith cross-sections is in the group Libraries.

Select the required cross section in the tab and check all properties in the row. The properties are displayed in the property
dialogue at the same time so there is no need to open the dialogue. Using Cross-section tab in the Table input is much
faster.
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This is the onlywayhow to display the cross-section properties in the propertydialogue.
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List of available tabs

Group Structure

1. Node - Structure nodes in 3Dmodel, can be inserted bydefining X, Yand Z coordinate;
2. 1D member - Beams, Columns, Ribs ..., can be inserted bydefining begin and end node, it is created asa straightmem-

ber;
3. 2D member - Plates,Walls ..., cannot be inserted byTable input;
4. Opening - Opening on 2Dmember, cannot be inserted byTable input;
5. Subregion - Subregion on 2Dmember, cannot be inserted byTable input;
6. Load panels - To panel nodes, To panel edges, ..., cannot be inserted byTable input;
7. Support - node - Point support in node, can be inserted bydefining node (=owner);
8. Support - beam - Point support on beam, can be inserted bydefining beam (=owner);
9. Line support - beam - Line support on beam, can be inserted bydefining beam (=owner);
10. Line support - edge - Line support on 2Dmember edge, can be inserted bydefining 2Dmember and edge number

(=owner);
11. Surface support - Surface support on surface, can be inserted bydefining 2Dmember (=owner);
12. Hinge on beam - can be inserted bydefining 1Dmember (=owner);
13. Cross link - Fixed, Hinged, Coupler, cannot be inserted byTable input;
14. Rigid arm - Rigid arms in nodes, cannot be inserted byTable input;
15. Line rigid arm - Rigid armsnode-line, cannot be inserted byTable input;
16. Post-tensioned tendon - Post-tensioned internal tendon, cannot be inserted byTable input;
17. Post-tensioned free tendon - Post-tensioned free tendon, cannot be inserted byTable input;
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Group Load

1. Force - node - Point force in node, can be inserted bydefining node (=owner);
2. Force - beam - Point force on beam, can be inserted bydefining beam (=owner);
3. Free force - Free force in point; can be inserted bydefining coordinatesx,y,z;
4. Line force - beam - Line force on beam, can be inserted bydefining beam (=owner);
5. Line force - edge - Line force on 2Dmember edge, can be inserted bydefining 2Dmember and edge number

(=owner), it is not possible to create a line force on internal edge in this tab;
6. Free line force - Free force on line, cannot be inserted byTable input;
7. Surface force - Surface force on 2Dmember, can be inserted bydefining 2Dmember (=owner);
8. Free surface force - Free force on surface, cannot be inserted byTable input;
9. Moment - node - Pointmoment in node, can be inserted bydefining node (=owner);
10. Moment - beam - Pointmoment on beam, can be inserted bydefining beam (=owner);
11. Free moment - Freemoment in node, can be inserted bydefining coordinatesx,y,z;
12. Line moment - beam - Linemoment on beam, can be inserted bydefining beam (=owner);
13. Line moment - edge - Linemoment on 2Dmember edge, can be inserted bydefining 2Dmember and edge number

(=owner), it is not possible to create a linemoment on internal edge in this tab;
14. Combination - Overview of linear combinationsand its coefficients, cannot be inserted byTable input;
15. Non-linear combination - Overview of nonlinear combinationsand its coefficients, cannot be inserted byTable input;
16. Load case - Load case database, cannot be inserted byTable input;
17. Generated free load - forcesgenerated from the original free load, cannot be inserted byTable input;
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Group Libraries

1. Cross-section - Crosssection library, tab containsonly the basicproperties, but the selected row displaysall crosssec-
tion properties in thePropertywindow, cannot be inserted byTable input;

2. Material - the librarywith usedmaterials, cannot be inserted byTable input;
3. Layer - Layers library (user can easily switch the activityby layer by this tab), cannot be inserted byTable input;
4. Geologic profile - the librarywith predefined geological profiles, cannot be inserted byTable input;
5. Geologic area - the librarywith predefined geological areas, cannot be inserted byTable input;
6. Design group - Design group library, cannot be inserted byTable input;
7. Sheetings - Profiled sheeting library, cannot be inserted byTable input;

tutorial: How to use a New row
The Table input is a tool for numerical inputting and editing the structure.

Each tab contains one type of entity. All rows represent members of the same type. The special row
on the bottom is displayed if the creating of a new member is supported by the tab. This row has a
star symbol as a header. It is called a "New row". It doesn’t contain any data just empty cells with
two different colours.

A new geometry or add data can be inserted to the project by this row. When the item is created it is
also displayed in the 3D model.

New row contains two type of cells:

1. Orange – required cell – the new entity is inserted only if this cell is filled;

2. White – optional cell – the new entity may have a different properties from the default;

E.g. a new node is defined by its 3 coordinates - see the picture:
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How to insert a new structure by the New row
Create free nodes by copy&paste

1. Open the project “New_row.esa”.
It is an empty project with no libraries or geometry.

2. Open the attached XLS file “paste.xls”.
The file contains three lists namedNODES, BEAMS and SUPP.

3. Select all cells with values in the list NODES and copy them to the clipboard. It is just coordinates
of nodes with no names.
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4. Paste coordinates to the New row in the Table input. It must be pasted with the focus on the first
orange cell which is “Coord X”. The secondmust be “Coord Y” and the third must be “Coord Z”.
The order is the same as it is in the default settings.

5. The table contains 27 free nodes. When it is pasted, the free nodes are created also in themodel
window.
If it is not visible check the activity in themodel window.

Create columns and beams by copy&paste

1. Copy all cells with content from the second list in the XLS file – BEAMS – to the clipboard.
It contains the type, the begin node and the end node of beams.

2. Switch on the tab 1D member in the Table input. Check the order of columns.

Check that the order of columns is Type, Begin node and End node so the
pasted content matches!

3. Paste the content from the clipboard to the New row in this tab. The content must be pasted to the
appropriate cells. Begin and end node are required values.
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4. The system starts the dialogue for the cross-section definition automatically.Create anynew crosssection.
5. 1D members are created after the paste.

Create supports by copy&paste

1. Copy all cells from the third list in the XLS file – SUPP – to the clipboard.

2. Open the tab Support - node in the Table input.

3. Paste the content from the clipboard to the New row. The content must be pasted to appropriate
cells. Structure node = owner is required cell.

Check the order of columns.
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The final project is in attachment "New_row-final.esa".

Performance tips
The chapter containsseveral tipswhich can help to balance performance and qualityof output according to current needsof
the user. It containsalso some general remarks related to performance of SCIAEngineer.

Rendering
The rendering of model is based on OpenGL technology. There are several settings which influence quality and speed of
displaying of themodel.

Themost significant changes in displaying speed and quality can be done in the setting Setup / Options / Environment - Win-
dowssetting.
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In the settingRendering user can select between following possibilities:

l Enable (OpenGL - hardware) - all calculationsare done in graphic card. It is fastest way of drawing
l Disabled (Wired) - also very fast wayof drawing of themodel, however in this themodel isdisplayed onlyaswired . This

selection isuseful in case of problemswith graphic card.
l Disabled (vector hidden linesalgorithm) - veryslowwayof displaying of themodel. In this case visibility of lines is cal-

culated by the processor
l Software emulation (OpenGL) - also veryslowwayof displaying. It provides the sameoutput as "Enabled (OpenGL -

hardware)", but all calculationsare done by the processor, This can be useful in case of problemswith graphic card.

Antialiasing quality canmake linessmooth but time needed for drawing of the picture ismultiple times longer.

Antialiasing dos not need to be switched permanently ON. it can be switched ON just for selected pictures (in gallery, in
EngineeringReport, in document). It is also possible to set level of antialiasing for pictureswhich are saved into clipboard.

See themanual related to Anitaliasing.

Another setting related to rendering which can influence the speed of drawing is in setting of View parameters. Mode
Rendered is faster thanRenderedwith edgeshowever the speed difference isnot so significant.

Drawing of lines
In case of projects with many drawing lines (e.g. imported from DWG), The speed of drawing can be increased (and
memory consumed by drawing objects decreased) by switching OFF vertexes on lines (subsequently it is not possible to
drag and drop endsof lines) and bydisabling tooltipson drawing lines.

Both those settingscan be done in View parameterssetting.
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Drawing of structure nodes
In the View parameters setting it is possible to select one of available types of displaying structure nodes (or to switch them
completelyOFF). Dot is significantly faster thanSphere.

Drawing of loads
In case the project containsmany loads the way of their displaying can significantly reduce the speed of drawing. Switching
of drawing style toSimple or Wired is very recommendable in case ofmodelwithmany loads (e.g. generated loads)
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Changing view point in 3D window
Each change of view point need recalculation of picture displayed and the screen. This recalculation can be accelerated by
the checkbox in theAdvanced graphicsetup.

Switching the acceleration ON causes small time gap before the manipulation with view point starts (informations must be
loaded into graphic card), then themanipulation is fully calculated bygraphiccardwhich is very fast.
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Zooming IN andOUT using themousewheel isby the operation systempresented asa set
of small zooming steps. During each this zooming steps the above mentioned time gap
occurs. Therefore it is much faster to use Ctrl+Shift+Right mouse button while
moving themouse up/down to zoom IN/OUT..

Grouping of properties
After selection of multiple entities in the 3D window the intersection of their property is displayed in the property grid. In case
of bigmodel and selection of big number of entities this can take a long time. Therefore there is a limit in the Setup / Options /
Environment which sets themaximal number of entitieswhich are used for evaluation of intersection of their property.

In the case displayed on the picture the propertiesare displayed in case there is selected less than 100 entities.

- 195 -



Chapter 3

Geometry / Graphics

This setting defines the precision of drawing of different types of entities. Higher precision can reduce the speed of dis-
playing and vice versa in case of big number of those entities.

Cross-section analysis
By default, thick-walled cross-sections are analysed using the advanced 2D FEM method which is required for an exact
shear and torsional analysis.

In case however shear and torsion are of less importance, the 2D FEMmethod can be de-activated through Setup / Cross-
sections.

Thiswill lead to a significant reduction of the time needed to run the analysis, especially in case arbitrarymembersare used.
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Setting of system
The SCIA Engineer uses very often files on hard drive in the folder with Temporary files. Therefore it is essential to put this
folder on fast hard drive. The best is to use the SSD drive. The increase of the working speed and SCIA Engineer
response is significant.

It is also essential to exclude the folder with Temporary files from antivirus check-
ing . Files can change very often in this folder and antivirus can block SCIA Engineer to
work with them until they are verified. This can lead to significant decrease fo the working
speed and sometimescan lead even to crashesof SCIAEngineer.
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Program settings

Language of the program
Bydefault, the program starts and works in the language chosen during the installation. For many users, however, another
language of the user interfacemaybemore suitable. The language of the application and language for outputs can be set in
the Setup >Optionsdialogue.

The procedure for adjustment of a required language

1. Open function Setup >Options :

1. usingmenu function Setup >Options,

2. using iconOptionssettings ( ) on toolbar Main.

2. Select tabOther.

3. In the group Language default select the required language for the program.

4. In the group Language default select the required language for outputs.

5. Confirm the settings.

Note: The change takesaffect onlyafter the restart of the program.

Application options
Environment settings
Parametersaffecting the user interface appearancemake up thisgroup of Environment settings.

Window settings

Show scrollbar in view This item specifies whether the graphical windows are equipped with scroll-bars on their right and bottom edges.

Rendering The item sets the mode that is used for drawing into application graphical windows.
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Antialiasing quality
Allows smoother rendering. Most visible on inclined lines displayed on rectangular pixel matrix of monitors with low
resolution.

Hidden lines This option specifies the mode for hidden lines of individual structural entities.

Display surfaces inter-
sections

This check-box allows user to display the intersection of two surfaces. Option is available only for some rendering
modes.

Line pattern length This item specifies the style of dashed lines.

Select pen width Allows user to defined the default width of pen for entities not included in Palette settings (Setup - Colours/Lines).

Rendering
Defines the type of rendering.

Disabled (vector hidden lines algorithm)

This mode disables
any rendering. The
drawing on the screen
is fast but reverse sur-
faces of the structure
cannot be hidden and
are shown.

Disable – wire

This mode is almost
identical to the one
above. It is however
modified to run even
on computers with old
types of graphical
cards where the mode
above may not func-
tion properly.

Enable (OpenGL - hardware)

If this option is selec-
ted, the hardware ren-
dering capability of
the computer is
employed. This option
may lead to a "dis-
torted" display on
some computers,
especially those with
older models of
graphic cards.

Software emulation (OpenGL)

This options tells the
computer to simulate
the rendering cap-
ability bymeans of soft-
ware algorithms. This
option should work
properly on all com-
puters. However, if
selected on slower
one it may lead to
longer response of
the computer during
regeneration of the
screen.
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From version 18, SCIAEngineer introduced the Navicube 3D navigation system. That sys-
tem is available only with hardware OpenGL rendering. Compatibility issues have been
noted on some computer systems, when 3D accelerations are not properly supported. For
more details, seeOpenGL textures troubleshooting.

Hidden lines
TheHidden linesoption servesasa substitute for full and proper rendering if theRendering itself isdisabled.

The available optionsare:

Invisible The hidden lines (hidden parts of entity surfaces) are not drawn at all.

Dashed The hidden lines are drawn in dashed style.

In addition to the above-mentioned options, it is possible to select whether the intersections of individual surfaces should be
calculated and displayed.

Note: The settingsmade here determine which mode of rendering and hidden line display
is set for the application. This setting does not mean that the rendering of the scene (i.e. of
what is displayed on the screen) is really applied. To do so, the renderingmust be switched
on for the required graphical window. This can be done bymeans of the appropriate view
parameter for the appropriate graphicalwindow.

Line pattern length
This item affects the style of dashed lines. The dashed lines may be used whenever within the projects. Any dashed line is
controlled by this item.

Small number meansshort linesused in the dashed linewith smaller gaps in between.

Large number means long linesused in the dashed linewith longer gaps in between.

Command settings

Following setting is related to using commands inCommand line.

Rightmouse button click generates End of function
If this option is ticked, the right mouse button generates End of
command when pressed in any opened function such as defin-
ition of a new 1Dmember,move of 1Dmember, etc.

Shift+Enter bypass input dialogue

If this option is ticked, the command is immediately performed
with last used set of properties (e.g. 'beam' command con-
firmed by Shift+Enter allows user to input the horizontal beam
with last set of properties directly and properties input dialogue
is skipped).

Show default commands
This button opens text file with the list of supported commands,
default short-cuts and simple explanation.
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Customize short-cuts (restart needed)

This button opens text file with the list of user-defined short-
cuts. User can define own short- cuts in format <com-
mand>=<user_ shortcut> (e.g. Struc-
ture.1d.Beam=usershortcut).

Skins

Following settings influence the visual appearance of SCIAEngineer.

Select skin This option allows the user select from pre-defined screen skins of the application.

Select style This option allows the user select from pre-defined colour schemes of the particular skin.

Transparency set-
tings

This option allows the user select the value of transparency for entities using transparency (e.g. floating undocked win-
dows).

Other parameters

Maximum number of grouping properties

This value determines the maximum number of entit-
ies that can be selected at a time so that the Property
window was filled with the parameters of the selected
entities. If the number specified here is exceeded, the
property window is left blank and can be filled in only
on user’s explicit request.

Maximum number of entities for default selection 'All'

This value determines if in Properties of result ser-
vices the DEFAULT (i.e. before the user change)
value of Selection is All or Current, related to the
number of entities in project. If the number of entities
in actual project is bigger than this limit, the default
value of Selection will be Current and in default no
results will be printed after refresh in order to prevent
the long presentation time on large projects.

F1 opens online help instead of locally installed help
By default, the F1 opens the online help. The local
help may be used when user works offline.
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Display pictures below properties
This check-box controls whether the explaining pic-
ture under the Property window is displayed or not.

Use vertical splitter in properties
Enables user to set the horizontal position of vertical
splitter in 'Properties' window.

Display global coordinates in status bar

By default, the status bar displays co- ordinates
defined in an active user co-ordinate system. In addi-
tion, the global co-ordinates may be displayed as
well.

Reset layout for dockable windows and toolbars (after restart)
This button loads the program-default settings of tool-
bars and windows layout. Reset will be taken into
effect after the restart of application.

Current style of toolbars
In this combo-box user can select the predefined set
of toolbars.

For setting of application optionssee chapter Adjusting the application options.

Graphic templates settings
This tab enables the user to define templateswhich new drawingswill be based on. This optionmaybe useful for example if
a title blockwith the company logo should be attached to everydrawing.

Print picture Defines the template for function Print picture.

Overview drawingsmanager Defines the template for drawings created in the Paper space gallery.

For setting of application optionssee chapter Adjusting the application options.

Directories settings
This dialogue allows the user to specify the location of SCIAEngineer files. The adjustment can bemade separately for indi-
vidual file types.
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Temporary files The folder stores any temporary files.

User setting files The folder stores all files with user-made settings.

Project files The folder stores projects created and saved by the user.

Database files The folder stores databases provided with the program.

Profile libraries The folder stores databases of cross-sections provided with the program.

User block libraries The folder stores all user blocks thatmay be arranged in sub-folders of thismain library folder.

User Templates The folder stores user templates (i.e. template projects created by the user).

Predefined shapes This folder contains predefined shapes such as cylinder, cone, etc.

Property layout directories This folder contains user defined layouts for Property window.

Licence files This folder contains licence files.

2D-1D upgrade templates This folder contains predefined templates for Upgrade 2D->1D export.

Open checks This folder contains user-defined SCIA Design Forms checks which can be used in 'Design FormsChecks' service.

Autosave This folder contains projects saved by Autosave functionality.

Note: The changesmade in this dialogue will take affect ONLY after the program is closed
and restarted. The items on this tab sheet CANNOT be edited if any project is currently
opened.

For setting of application optionssee chapter Adjusting the application options.
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Other settings

Action on start-up
Thispart offersa set of settings that relates to projectsopened in SCIAEngineer right after start of SCIAEngineer.

None No action is carried out when the application is started.

Last opened project The last opened project is automatically loaded into the application on its start.

ShowOpen project dia-
logue

When the application is started, the Open project dialogue is automatically displayed to allow for the selection of the
project to be processed.

Autosave
Thispart offerssetting that is related to automaticproject saving functionalitywhich protects the user against lossof data.

Enable autosave every If this check-box is checked, the projects are automatically saved in specified interval.

Clean files after If this check-box is checked, the automatically saved projects are deleted after specified time period.

In Directories tab it ispossible to specify the folder used for saving autosave files.

Language default
Thispart offers the selection of language of the environment and output.

Workspace User can select the language of the application environment.

Output User can select the default language of the outputs from the application (e.g. print preview).
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It is necessary to restart SCIA Engineer to take effect of language change of both Work-
space andOutput in all partsof software.

Language of output from Document or Engineering Report is controlled in particular doc-
ument/report properties.

System
Thispart offerssettings related to the systembehaviour.

Enable system information in properties
Display system informations in Property window just for debugging pur-
poses.

Enable data server information in properties
Display data server informations in Property window just for debugging
purposes.

Enable FastOpen for document (disk caching of document layout
data)

The cache file is created to speed up the loading of document data.

Enable MemSave (swapping unused objects to disk, slower but less
memory)

Unused objects are saved to disk which allows to free up the memory. Effi-
cient on computers with small memory.

Enable the Product Improvement Program (require administrator priv-
ileges and restart of SCIA Engineer)

This functionality allows to send statistics helping developers to improve
the software.

Question before deleting results
Thispart offerssetting regarding displaying the dialogue just before erase of results induced by the change ofmodel.

Enable question before deleting res-
ults

If check-box checked, SCIA Engineer asks the user after the change of model has been done whether to
accept the change and delete results or not.

Calculation time threshold [s] (0
means display always)

Defines how long last calculation must have taken to display the question. If last calculation lasted less
than specified time, the question will not be displayed.

Classic GUI
Thispart offersuser to activate the old styleGUI in some partsof SCIAEngineer.
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Old project man-
ager

If this check-box is checked, the old-style 'New project' dialogue is displayed instead of the newStart project dialogue.

Previewwindow
If this check-box is checked, the 'Preview' of results using old-style document is used instead of new 'Report preview' based
on Engineering Report technology.

One click on
main tree

If this check-box is checked, one click opening is active for main tree.

Old icon set If this check-box is checked, old icon set is used.

For setting of application optionssee chapter Adjusting the application options.

Protection settings
This tab summarises theProtection settings.

For more information read chapter about Protection.

Adjusting the application options
The procedure for the adjustment of application options

1. OpenOptionsdialogue

1. either: usingmenu function Setup >Options,

2. or: using button [Options] ( ) onMain toolbar.

2. Make required settingson individual tabs.

3. Confirmwith [OK].

The dialogue also contains three save/read buttons.

Read application
default

Reads settings as they were pre-defined by the developer of the program.

Read user default Reads settings that have been previously saved as user’s own default.

Save as user default
Saves the current settings as the user’s default settings. These settings may be later read by the above men-
tioned function.

Project settings
Basic project data
The basicdata of a project describe the project and define some of itsmain parameters.
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Project filename
It shows the nameof the project.

Project data
Thisgroup of itemsallows the user to enter some statistical data about the project

Name
name of the project

E.g. EddyMerckx's Airport – Brussel

Part
name of the project part, if the project is complex and consists of several partial sub-projects

E.g.Western hall + connection footbridge

Description E.g. variant A (underground parking, restaurants on first floor, check-in desks on second floor)

Author
name of the project author

E.g. Sven Nijs

Date
date of the last projectmodification, or date of the program creation, etc.

E.g. 02/02/02

Structure
Here, you can choose the type (or we can say "dimension") of the structure youwant tomodel. Depending on the type selec-
ted, some of the functions and options of the program may be disabled or hidden (e.g. in the case of 2D frame oriented in
plane XZ, the button for setting the sight of themodel from the direction of X and Z axes respectivelywon't be present on the
View toolbar). This feature leads to a significant simplification in the operation of the program for simpler typesof structures.
The functionsand options that are not appropriate (are not possible practically) for the particular type are hidden and do not
add to the complexity of the program. The idea behind this feature is: A complex task requires a complex tool, but a simple
taskcan get bya simple tool.

Truss
XZ

The 1D members of a model are capable of carrying axial forces only. That means that pin ends (hinges) are meaningless, supports
do not have rotation degrees of freedom defined and results consists of axial forces only. Only a 2Dmodel can be created.

Frame
XZ

The 1Dmembers can represent a planar frame structure. Only a 2Dmodel can be created.

Truss
XYZ

Thismode is similar to Truss XZ, but a real 3D structure can be created.

Frame
XYZ

This option is similar to Frame XZ, but a real 3D structure can be created.

Grid XY A horizontal grate can be modelled in thismode.

Plate
XY

This mode provides for analysis of combined 1D member and slab structure. All the members must be located in a horizontal plane.
Only a 2Dmodel can be created.

Wall XY Thismode is similar to Frame XZmode, but vertical walls can be inserted as well. Only a 2Dmodel can be created.

General
XYZ

This option allows the user to model and analyse a 3D structure consisting of any structural members: 1D members as well slabs
(plates, walls, shells).

Note: Item Structure is compulsory and the user has to make a choice from the available
variants.
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Material
This option tells the program which materials will be used for members of the structure. The advantage of this in advance
selection is that the program functions working with materials will know, which material the user is interested in. Therefore,
the functions will not offer other material types and, consequently, the dialogs, lists and similar items will be lucid and read-
able asmuch aspossible.

If the user realises later that some other material type is necessary, it is of course possible to call the setting dialogue any
time in the future andwiden the selection of usedmaterial types.

Note: At the beginning, i.e. at the time when a new project is being created, it is necessary
to select at least onematerial type.

Post-processing environment
Starting from version 17.0, it is possible to use a new post-processing environment for displaying of results. The new post-
processing environment can be enabled in theProject dialogue.

v16 and earlier functions for the evaluation of results are consistent with the appearance in previous versions (i.e. v16 and older)

v17 enhanced methods and possibilities of drawing style and other options for results are available

Note: Post-processing environment v17 covers linear calculation (except prestressing), lin-
ear stability, nonlinear calculation (beam local nonlinearity, 2nd order calculation, Initial
deformation and curvature) andmodal analysis. Eurocode building standards for concrete
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and steel are supported. Please, check content of your Engineering Report after cal-
culation. If youwant to use advance analysis typeschange Post-processing environment to
v16 and older.

Detailed description can be found in chapter "v17Post-processing environment " below

Model
One the project will contain a single model of a structure

Absence the project can contain some members thatmay be missing in some stages of the analysis

Construction stages the project will representmodelling of construction stages appearing during the execution of the structure

Code
The selection of the active code determineshow the programdealswith data related to a specific technical standard. In prac-
tice it means that the code selection affects:

l thematerialsoffered ascode-relatedmaterials, e.g. steel or concrete grades, etc.

l the procedures, algorithmsand possible parametersperforming and necessary to perform code checks.

Note: The choice of a particular national standard may have an effect on the layout and
even functionality of numerous functions. E.g. functions like Load case and Load group
have got parameters that depend on the current code of the project. That means that
these function offer the user different parameters for e.g. Czech standard than for let’s say
Eurocode. Also the functionality of some functions or services is different for different
codes.

The procedure for setting the parameters is the same as for other project parameters.

v17 Post-processing environment
SCIA Engineer (from version v17) provides the possibility to choose between two post-processing environments for dis-
playing resultsand performing the design.

Available options:

v16 and
previous

This option contains the functionalities of SCIA Engineer 16 and previous
versions (all analysis types, resultsand building standards).

Calculation dialog v16

v17

This option contains upgraded visualization styles and results handling
enhancements, as well as long term deflections analysis to the Eurocodes.
(Not all functionalitiesare supported yet)

Calculation dialog v17

- 209 -



Chapter 4

More in detail:
What does “post-processing environment” mean?
The post-processing environment providesaccess to stepsoccurring after the calculation: visualization of results,
code checksdesign.
The development of the new post-processing environment v17 included redesigning the interface to the solver,
to provide a varietyof enhancements to the user in termsof speed and accessibility of results.
Some insights into the v17 post-processing environment
The v17 environment covers most of the functionalities which enable you to perform linear calculation (except
pre-stressing), nonlinear calculation andmodal analysis.
Whenwithin thisenvironment you get several benefits in workingwith results, such as: a faster responsewhile dis-
playing results, new visualization options, a legend with displayed load case / combination, value, units, etc. next
to everypicture and enhancements in reactions (nodal reactionsand intensity in one view).
Some functionalities have not been implemented yet; below you can find an overview of functionalities which are
supported or not in the v17 environment.
All options which are supported within v16 and previous, but not yet in the v17 environment, are accessible by
switching between the two. There is full compatibility of themodel between the two environments.

Supported functionalities the in v17 post-processing environment
Linear calculation All standard functionalities

Subsoil

Pad foundation

Soil interaction

Soil loads

- 210 -



Programsettings

Dynamics Modal analysis

Nonlinearity

2nd order – geometrical nonlinearity

Beam local nonlinearity

Nonlinear soil spring

Initial deformation and curvature

General plasticity

Others

Initial stress

Propertymodifier

Linear stability

Functionalities not supported in the v17 environment -> please use the “v16
and previous” environment
Pre-stressing Pre-stressing

Dynamics

Harmonic band analysis

General dynamics

Non-proportional damping

Seismic

Nonlinearity

Membrane element

Pressure only 2Dmembers

Cables

Non-linear springs, gaps

Concrete

Concrete Advanced

Fire resistance

Hollow core slab

Voided Slab

Others

Climatic loads (3Dwind generator)

Parameters

Mobile loads

Absences and construction stages

Results on integration strip

Results on averaging strip

Results on averaging strip

2D/1D upgrade

Old document

Notes

Note1: Interaction between the two post-processing environments
The two post-processing environments are fully compatible. Existing projects from previous SCIA Engineer versions or
using the v16 post-processing can be run using the v17 post-processing and vice-versa. Every time the post-processing
environment is switched, a recalculation of themodel is required.
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It mayhappen that you start your project in “v17” and you realize that an advanced functionality you need ismissing. You can
switch back to v16 post-processing by the “project data” dialogue.

If you change the post-processing environment, asmentioned above you will use another export of the model to the solver,
but also another method of showing resultsand new algorithmswhichmight lead to slightlydifferent result values.

Note 2: Code design
In the Eurocode concrete design (except for theCDD calculationwhich isavailable only in “v17”), and steel checks, new res-
ultsoptionsare available from the propertywindow, independent from the chosen environment

Note 3: Engineering report
The Engineering Report is fully compatible with the two post-processing environments and can also contain images from
both environments. Checking the Engineering Report might be required if content from the other post-processing envir-
onment isused, to avoidmissing results fromunsupported features.

Note 4: New developments and the v17 environment
Usage of the v17 environment is recommended to get the benefits from some of the latest developments of SCIA Engineer
17: ability to run a selection of load cases or non- linear combinations, CDD (Code Dependent deflection) for concrete
according to theEurocode, upgraded result service. For more info: visit the pagewhat’snew SCIAEngineer 17

Functionality settings
SCIAEngineer offersawide range of capabilities. In order tomake the operation of the programasclear and simple aspos-
sible, the project settingsallow for selection of those features that are needed and required.

The Functionality settings dialogue comprises options that control both the appearance and function of the program.
That means that until some advanced feature is selected in this dialogue, the program neither performs the specific tasknor
even offers it in themenu.

The functionalityoptionsare divided into several groups.

Property modifiers
Certain properties of both 1D and 2Dmembers can bemodified for the calculation using special attribute called Propertym.
Properties that can be altered include: stiffness, self weight, mass.

Parametric input
Advanced users of SCIA Engineer may find it very useful to define some of the program input values as parameters. Para-
meters, if applied, provide for fast, easy and simple change of e.g. structure dimensions, load values, etc. One single modi-
fication of the appropriate parameter leads to automatic regeneration of themodelwith the new defined value.

Climatic loads
If wind or snow loadsare supposed to act on the structure, this functionalityoptionmust be set ON.

Mobile load
If ON, themodel of the structure can be subjected to different typesofmobile load.
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Subsoil
TheSubsoil functionality representsan important and powerful feature of the programespecially if the interaction of the ana-
lysed structure with its subsoilmust be taken into account. The Subsoil functionality is alwaysON. The following subfeatures
can be enabled:

Soil interaction
The interaction between the structure and subsoil can be analysed using the structure-soil interactionmodule.
Pile design
Design of pilescan be performed using theNENmethod.
Pad foundation check
Pad foundationscan be checkesusing the relevant code regulations.

Dynamics
When ticked the option makes the dynamic analysis features available to the user. The appropriate dynamics-related func-
tionsand parametersbecome available inmenusand solver adjustment dialogues.

Modal & harmonic analysis
If thisoption isON,modal analysisand dynamiccalculationwith harmonic loading can be performed.
Seismic spectral analysis
If thisoption isON, seismiccalculationscan be performed.
Dynamic time-history analysis
One or more time-dependant dynamic load cases can be defined with name, mass combination, damping, total
time and integration steps.Multiple time-dependant dynamic load functionscan be used asmodal and basic func-
tions. It ispossible to use the results in combinationwith other (static) load cases for further post-processing.
Non-proportional damping
Thisoption enables the user to define separate damping for selected partsof structure.
Dynamic wind
Available only for CSN.
Harmonic band analysis

New way of dealing with the calculations in harmonic analysis by doing multiple analysis on a range of frequencies. Har-
monic analysis is possible for a range of frequencies controlled by the user. The frequencyof the harmonic force varies over
a range and a harmonicanalysis isdone for manyvalues in that range.

Stability
Thisoption allows the user to calculate stability problems.

Non-linearity
This option controls whether the non-linear analysis is available in solver options and, therefore, whether the user can per-
form a non-linear calculation of his/her problem. The Non-linearity functionality comprises several sub-items. These sub-
itemsare independent on each other and onlysome of themmaybe selected for a particular project.

Beam local non-linearity
If this option is ON, functions for non-linear analysis of 1D members are available (e.g. 1D member acting only
under compression, etc. maybe analysed).
Support non-linearity/basic soil spring
If thisoption isON, functions for non-linear analysisof supportsare available.
Initial imperfections
If thisoption isON, functions for introduction of initial deformationsbefore calculation are available.
Geometrical nonlinearity
If thisoption isON, functions for geometricallynon-linear calculation are available.
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General plasticity
General plastic analysis of 2D members; several material models are available, such as Tresca, Von Mises,
Mohr-Coulomb, Drucker-Prager.
Compression-only 2D members
Masonryor plain concretewallsand similar structural elementscan be analysed using thisoption.
Cables
Specific1D member nonlinearity for the analysisof cables; combines the behaviours tension only, no bending stiff-
ness, initial stressand initial curved geometry.
Friction support/Soil spring
If ON, friction supportsmaybe defined in themodel, aswell asadvanced line soil springs
Membrane elements
Thin platescan be calculated asmembranes.
Sequential analysis
Two typesof calculation can be combined in one analysis.
Dynamic relaxation

Dynamic relaxation can be used asan alternative solver method for nonlinear problems.

Structural model
This option enables the user to use two different "shapes" in his/her model. Normally, the calculation model is created and
used for calculations, evaluation of resultsand design and checking to a particular technical standard.

In addition, the user may also define a structural shape that is derived from the calculation shape and can be used for
impressive drawingsand isalso useful during the design of connections.

IFC properties
This option is useful when the project is imported through the IFC format. The architect may have provided his/her model
with some requirementssuch as required fire resistance, fact that themember transfersno load, etc.

Advanced concrete checks
If ON, old concrete checks (see "Concrete CodeCheck") are still visible in tree asConcrete Advanced. Otherwise Concrete
is there only.

Some settingsare available also for the "material" used in the project.

Prestressing
Thisoption provides for calculation of prestressing.

Bridge design
Load combinations
Handling of specificEN code combinations for bridges
Concrete checks extension
Extension of standard concrete code checks for bridges

Slabs with void formers
Thisoption isnecessarywhen slabswith void formersare to be analysed.

Excel checks
If ON, checks in external applicationscan be performed and the resultsdisplayed directly in SCIAEngineer.
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Document
This setting enables using of "old" document. Please note this "old" document is not maintained and fixed any more. it is
recommended to useEngineeringReport instead.

Steel
Plastic hinge analysis
Thisoption enablesnonlinear analysisof steel frame structureswith plastichinges.
Fire resistance checks
The type of fire resistance for steelmembersmaybe defined after thisoption hasbeen selected.
Steel connections
Thisoption openspossibility for the definition and checkof steel connections.
Scaffolding
Enables the user to design and checkscaffoldings.
7DoF 2nd order analysis for LTB
Enables the user to either calculate the elastic critical moment for lateral torsional buckling numerically or to per-
forma 2nd order analysiswhich includes lateral torsional buckling.
ArcelorMittal

Enables the user to checkcellular beamsusing theArcelorMittalACBsoftware.

Girders with sinusoidal webs
Enables the user to checkwelded sectionswith sinusoidalwebs.

Aluminium
Scaffolding
Enables the user to design and checkaluminium scaffoldings.
7DoF 2nd order analysis for LTB
Enables the user to either calculate the elastic critical moment for lateral torsional buckling numerically or to per-
forma 2nd order analysiswhich includes lateral torsional buckling.

Concrete
Fire resistance
The type of fire resistance for steelmembersmaybe defined after thisoption hasbeen selected.
Available onlywhenOld concrete checksare active.
Hollow core slab checks
Thisoption isnecessarywhen hollow core slabsare to be designed.
Available onlywhenAdvanced concrete checksare active.
1D physical nonlinearity
The material nonlinearity can be taken into account in the nonlinear analysis of reinforced concrete frame struc-
tures.
2D physical nonlinearity
Plate or shell nonlinearityof SFRC 2D memberscan be accounted for.

CADS Composite add-on
AComposite beam or column can be designed using the CADS composite functionality when this option is set ON. Also fire
resistance of the composite elementscan be checked if required.

Composite beam
Design of composite beams.
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Composite column checks
Design of composite columns.
Fire resistance checks
Fire resistance checkof compositemembers.

Important: the Composite Analysis Model uses a different method and is not compatible
with this setting. See the chapter about the Composite Analysis Model for more inform-
ation.

Pipelines
Pipeline systemscan be calculated.

LTA Load cases
When thisoption isON specific load cases for Lattice Tower Applicationscan be defined.

Dynamics
When ticked the option makes the dynamic analysis features available to the user. The appropriate dynamics-related func-
tionsand parametersbecome available inmenusand solver adjustment dialogues.

Seismic
If thisoption isON, seismiccalculationscan be performed.
Harmonic band analysis
New way of dealing with the calculations in harmonic analysis by doing multiple analysis on a range of fre-
quencies. Harmonic analysis is possible for a range of frequencies controlled by the user. The frequency of the
harmonic force variesover a range and a harmonicanalysis isdone for manyvalues in that range.
General dynamics
One or more time-dependant dynamic load cases can be defined with name, mass combination, damping, total
time and integration steps.Multiple time-dependant dynamic load functionscan be used asmodal and basic func-
tions. It ispossible to use the results in combinationwith other (static) load cases for further post-processing.
Non-proportional damping
Thisoption enables the user to define separate damping for selected partsof structure.
Dynamic wind
Available only for CSN.

Initial stress
The option, when selected, opens possibility for the introduction of initial stress state in members of a structure being mod-
elled in SCIAEngineer.

Subsoil
TheSubsoil functionality representsan important and powerful feature of the programespecially if the interaction of the ana-
lysed structurewith its subsoilmust be taken into account.

Soil interaction
The interaction between the structure and subsoil can be analysed using the structure-soil interactionmodule.
Soil loads
Soil loadscan be applied to selected structuralmembers.
Pile design
Design of pilescan be performed using theNENmethod.
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Pad foundation check
Pad foundationscan be checkesusing the relevant code regulations.

Non-linearity
This option controls whether the non-linear analysis is available in solver options and, therefore, whether the user can per-
form a non-linear calculation of his/her problem. The Non-linearity functionality comprises several sub-items. These sub-
itemsare independent on each other and onlysome of themmaybe selected for a particular project.

Initial deformations and curvature
If thisoption isON, functions for introduction of initial deformationsbefore calculation are available.
2nd order – geometrical non-linearity
If thisoption isON, functions for geometricallynon-linear calculation are available.
Physical nonlinearity for reinforced concrete
The material nonlinearity can be taken into account in the design of concrete structures in Concrete Advanced
module.
Plate/shell nonlinearity
Plate or shell nonlinearity can be accounted for.
Beam local non-linearity
If this option is ON, functions for non-linear analysis of 1D members are available (e.g. 1D member acting only
under compression, etc. maybe analysed).
Support non-linearity/Soil spring
If thisoption isON, functions for non-linear analysisof supportsare available.
Friction support/Soil spring
If ON, friction supportsmaybe defined in themodel.
Membrane elements
Thin platescan be calculated asmembranes.
Press only 2D members
Masonryor plain concretewallsand similar structural elementscan be analysed using thisoption.
General plasticity
General plastic analysis of 2D members; several material models are available, such as Tresca, Von Mises,
Mohr-Coulomb, Drucker-Prager.
Cable
Specific1D member nonlinearity for the analysisof cables; combines the behaviours tension only, no bending stiff-
ness, initial stressand initial curved geometry.
Sequential analysis
Two typesof calculation can be combined in one analysis.
Dynamic relaxation
Dynamic relaxation can be taken into account.
Nonlinear line support
If ON, nonlinear line supportsmaybe used in themodel.

Stability
Thisoption allows the user to calculate stability problems.

Climatic loads
If wind or snow loadsare supposed to act on the structure, this functionalityoptionmust be set ON.

Prestressing
Thisoption provides for calculation of prestressing.
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Pipelines
Pipeline systemscan be calculated.

Structural model
This option enables the user to use two different "shapes" in his/her model. Normally, the calculation model is created and
used for calculations, evaluation of resultsand design and checking to a particular technical standard.

In addition, the user may also define a structural shape that is derived from the calculation shape and can be used for
impressive drawingsand isalso useful during the design of connections.

BIM properties
This option is useful when the project is imported through the IFC format. The architect may have provided his/her model
with some requirementssuch as required fire resistance, fact that themember transfersno load, etc.

Parameters
Advanced users of SCIA Engineer may find it very useful to define some of the program input values as parameters. Para-
meters, if applied, provide for fast, easy and simple change of e.g. structure dimensions, load values, etc. One single modi-
fication of the appropriate parameter leads to automatic regeneration of themodelwith the new defined value.

Mobile load
If ON, themodel of the structure can be subjected to different typesofmobile load.

Automated GA drawings
Automated General Arrangement Drawings can be created for the model. This option activates a whole service with sec-
tions, hatching and label styles, etc.

LTA Load cases
When thisoption isON specific load cases for Lattice Tower Applicationscan be defined.

CADS Composite Checks
AComposite beam or column can be designed using the CADS composite functionality when this option is set ON. Also fire
resistance of the composite elementscan be checked if required.

Composite beam
Design of composite beams.
Composite column
Design of composite columns.
Fire resistance
Fire resistance checkof compositemembers.

Important: the Composite Analysis Model uses a different method and is not compatible
with this setting. See the chapter about the Composite Analysis Model for more inform-
ation.

External application checks
If ON, checks in external applicationscan be performed and the resultsdisplayed directly in SCIAEngineer.
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Slabs with void formers
Thisoption isnecessarywhen slabswith void formersare to be analysed.

Property modifiers
Certain properties of both 1D and 2Dmembers can bemodified for the calculation using special attribute called Propertym.
Properties that can be altered include: stiffness, self weight, mass.

Document
This setting enables using of "old" document. Please note this "old" document is not maintained and fixed any more. it is
recommended to useEngineeringReport instead.

Old concrete checks
If ON, old concrete checks (see "Concrete CodeCheck") are still visible in tree asConcrete Advanced. Otherwise Concrete
is there only.

Some settingsare available also for the "material" used in the project.

Steel
Fire resistance
The type of fire resistance for steelmembersmaybe defined after thisoption hasbeen selected.
Connection modeller
Thisoption allows the user tomodel (not check) the connections.
Frame rigid connections
Thisoption openspossibility for the definition of frame connectionsof steelmembers.
Frame pinned connections
Thisoption openspossibility for the definition of pinned connectionsof steelmembers.
Grid pinned connections
Thisoption openspossibility for the definition of grid pinned connectionsof steelmembers.
Bolted diagonal connections
Thisoption openspossibility for the definition of bolted diagonal connectionsof steelmembers.
Expert system
If this option is ON, the user may use the expert system for the design of connections. User defined connections
maybe saved into this systemand the saved connectionsmaybe applied later to other joints.
Connection monodrawings
Thisoption activatesawizard that helps the user create drawingsof defined connections.
Scaffolding
Enables the user to design and checkscaffoldings.
LTB 2nd order
Enables the user to either calculate the elastic critical moment for lateral torsional buckling numerically or to per-
forma 2nd order analysiswhich includes lateral torsional buckling.
Plastic hinges
Thisoption enablesnonlinear analysisof steel frame structureswith plastichinges.
ArcelorMittal
Enables the user to checkcellular beamsusing theArcelorMittalACBsoftware.
Girders with sinusoidal webs
Enables the user to checkwelded sectionswith sinusoidalwebs.

- 219 -



Chapter 4

Aluminium
Scaffolding
Enables the user to design and checkaluminium scaffoldings.
LTB 2nd order
Enables the user to either calculate the elastic critical moment for lateral torsional buckling numerically or to per-
forma 2nd order analysiswhich includes lateral torsional buckling.

Concrete
Fire resistance
The type of fire resistance for steelmembersmaybe defined after thisoption hasbeen selected.
Available onlywhenOld concrete checksare active.
Hollow core slabs
Thisoption isnecessarywhen hollow core slabsare to be designed.
Available onlywhenOld concrete checksare active.
Code depend deflections
Calculation of long-termdeflection and deflection from creep.

Bridge design
Load combinations
Handling of specificEN code combinations for bridges
Concrete checks extension
Extension of standard concrete code checks for bridges

The procedure for setting the parameters is the same as for other project parameters.

Loads settings
The procedure for setting the parameters is the same as for other project parameters.

Acceleration of gravity
Thisparameter defines the acceleration of gravityg. Bydefault g = 9.81m/s2.

It is used in the following contexts (non exhaustive list):

l calculation of self-weight ofmaterialsbased on their massdensity (e.g. concrete density= 2'500 kg/m3 >self-weight
= 24.525 kN/m3)

l calculation of seismicacceleration in some response spectrumgenerators (e.g. IBC)

Wind region
This parameter defines the region where the modelled structure will be located. The region may influence wind loads that
the buildingwill be exposed to. The user maychoose from three options for this item:

None There is no wind load applied.

According
to code

The wind region is defined according to appropriate national standard.

User
defined

The user specifies the height-wind pressure curve. The real load is then defined as a force load but its type must be set to Wind.
The load value input by the user then represents the load width.

User The user specifies more height-wind pressure curves. The real load is then defined as a force load but its type must be set to Wind.
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defined -
more
curves

The load value input by the user then represents the load width. Each input load has defined a wind pressure curve in its prop-
erties.

Wind setup for IBC
If the option According to code isset for IBC code aWind setup dialog is shown.

Provisions Defines if formulas and values are used from provisions ASCE7-05 or provisions ASCE7-10.

Importance factor/Risk cat-
egory

Defines Importance factor category, value and hurricane regions for ASCE7-05 or Risk category and hurricane
regions for ASCE7-10.

Directionality factor Defines Directionality factor according to code for selected structure type.

Gust effect factor DefinesGust effect factor according to code for selected structure type.

Basic wind Defines a basic wind value.

Exposure and Topographic
factor

Defines Exposure and Topographic factor according to code.

Calculation method Defines a calculation method - All-heights/Low-rise for ASCE7-05 or Directional/Envelope for ASCE7-10.

Enclosure class Defines if building is enclosed, partly enclosed or open.

Library of wind pressures
When the option User defined is selected, it is possible to open [using the three-dot button] the Wind pressure database
manager. In thismanager the user may input the requiredwind curves.

Editing dialogue for the input of wind pressure
TheEditing dialogue for the input of wind pressure can be opened from theWind pressure databasemanager.

Thisdialogue contains the following controls.

Name Specifies the name of the wind curve.

Graphical
window

The diagram of the defined wind curve is displayed in this small graphical window. The graphical window offers standard functions
such as zoom-in and zoom-out, pan, copy to clipboard, save to file. The functions can be accessed through a pop-up menu or using
mouse move with the right button held pressed with simultaneously held Ctrl and/or Shift key(s).

Table
with curve
values

The table contains the values that define the shape of the curve.

Depending on the option in item Input, this table can be "read-only".

Input

User

The curve is defined manually by the user in the table with curve values.

EC-EN

The EC-EN-defined wind curve is used. For this option the table with curve values is "read only".

DIN

The DIN-defined wind curve is used. For this option the table with curve values is "read only".

NEN

The NEN-defined wind curve is used. For this option the table with curve values is "read only".

BS-EN

The BS-EN-defined wind curve is used. For this option the table with curve values is "read only".
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Height
range

This parameter defines the height range of the curve. This item is accessible only for code-based wind curves. It is disabled for user-
input curve.

Edit curve
This button opens a special where the parameters of the code-based curve can be edited. This item is accessible only for code-
based wind curves. It is disabled for user-input curve.

OK Confirms the changes and closes the dialogue.

Cancel Discards the changes and closes the dialogue.

Note: The defined wind curves can be reviewed and edited also through tree menu func-
tion Library >Loads >Wind pressures. This function becomes accessible only if parameter
Wind region in the project setup hasbeen set to Library.

Note: For more information about the generation of wind load see chapter Loads > Load
generators>Wind generator.

Snow region
This parameter defines the region where the modelled structure will be located. The region may influence snow loads that
the buildingwill be subject to. The user maychoose from three options for this item:

None There is be no snow load applied.

According
to code

The snow region is defined according to appropriate national standard.

Snow
weight

The user specifies the snow weight per square meter. The real load is then defined as a force load but its type must be set to Snow.
The load value input by the user then represents the load width.

Note: For more information about the generation of wind load see chapter Loads > Load
generators>Snow generator.

Pond load
TheModel factor concernsa reduction factor which isused during the calculation of Pond loads.

More specifically, during the deflection calculation of the water accumulation, the stiffness of the structure is divided by this
factor.

Note: More information about Pond loads is given in the chapter Loads > Load generators
>Pondwater.

Seismic combinations
For codes that support seismic load case combinations with concomitant direction components (e.g. Eurocode), the para-
meter Factor for concomitant components defines the coefficient applied to concomitant direction seismic load cases in a
seismic envelope. Typically, with 2 seismic load cases EQX and EQY and Factor for concomitant components = 0.30
(default), the seismicenvelopewill contain the following combinations:

l +/- 1.00 *EQX+/- 0.30 *EQY
l +/- 0.30 *EQX +/- 1.00 *EQY
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Note: More information about seismic combinations is given in the chapter Seismic com-
binations - Eurocode.

Combinations settings
This tab provides for the adjustment of load case parameters for automatic generation of load case combinations based on
a particular national standard.

The procedure for setting the parameters is the same as for other project parameters.

Units Set tab

In SCIAEngineer the user usescan setup "unit set" whichwill be used for project.

This set affect two aspectsof unitsVisualisation and default values.

Visualisation and default values

Visualisation

Affect unit in which the value is shown.

Example for Imperial unit set: Length - ft

L = 10 ft

Default val-
ues

When user creating any object in workspace, it uses this logic of default values:

1. Values from previously created object

2. Default value according to unit set, if is defined

3. Program default = values in SI (even if visualisation is set to any imperial based unit)

Example:

(1) I have already inputted column with my defined length of 12 feats. Now I am inserting column again - it
will use previously inputted value - 12 feats.

(2) I am inserting column for the first time - it will use default value for metric system - 10 feats.

(3) I am creating rectangle cross-section for the first time, and it is not supported by unit set - I will get
default values for SI (H = 19.685 inch ; B = 11.811 inch)

Unit "sets"
Metric Metric units visualisation and SI defaults will be used for newly created elements.

Imperial Imperial units visualisation and their default values will be used for newly created elements.

Unit set isautomaticallyapplied according to code in "basicdata" tab.
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EC and others=Metricunit set

IBC = Imperial unit set

Unit dialog
User is able to open and double-check / modify units for chosen set. This settings affects visualisation of units only,
not default values for new elements - these are set byunit set radio button (Metric / Imperial).

(1) Load program-
default settings

Load program default, based on chosen unit set

(2) Load user-
default settings

Load quick user default, which was saved by user

(3) Save user
default settings

Save and create quick user default

(4) Load settings
from file

Load settings from file which was saved by user, convenient when user usesmore than one set, or
when He wants to load settings saved in previous version of SEN

(5) Save settings to
file

Save current settings to file. This file can be used afterwards in next version or different project.

More information about Unitshere.

Measuring system
Measuring system isavailable when IBC code andMetric format unit isapplied together. More info here.

Procedure for setting project data
The procedure for the adjustment of project parameters is similar for all groupsof parameters.

1. Procedure for setting Basicproject data

2. Open dialogueProject data in one of the followingways:

1. UseMenu function Tree >Project.

2. ClickTreemenu itemProject.

3. Select the required tab (Basicdata / Functionality / Loads / Combinations / Protection / National annexes).

4. Adjust the required parametersor select options that should be applied in the project.

5. Click [OK] to confirm the settings.
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Display Setup palettes
SCIA Engineer uses a set of palettes to display project data (i) in the graphical window of the program, (ii) in the document
window, and (iii) on an external graphical device. The palette comprisessettingsof:

l colours,

l line styles,

l fonts,

l dimension lines,

l beam types,

l isolines.

It is possible to adjust separate palettes for individual output "directions". What’smore, it is possible to use settings from one
palette for another one, i.e. load settingsof one palette into the other one.

The available palettesare:

white back-
ground

Used for the screen, the structure is drawn in colours on white background.

black back-
ground

Used for the screen, the structure is drawn in colours on black background.

document –
colour

Used for the document, the structure is painted in colours.

document –
monochrome

Used for the document, the structure is painted in black-and-white style.

Important note: In order to have the pictures with result-isolines in the document black-and-white, it is necessary to have all the
pens / brushes in the Setup dialogue set to black / white / grey colour. Otherwise, if even a single pen is set to any other colour,
the whole output ismade as coloured.

graphic out-
put – colour

Used for the graphical output (paper space gallery), the structure is painted in colours.

graphic out-
put – mono-
chrome

Used for the graphical output (paper space gallery), the structure is painted in black-and-white style.

See the note in document – monochrome above.

The procedure for selection of palettes for individual output "directions"

1. Open anyof the followingSetup dialogues (all of themcan be found under function Setup of themainmenu):

1. Colours / lines,

2. Fonts,

3. Beam types.

4. Dimension lines.

2. At the top of the dialogue, select the tab corresponding to the "device" youwant to adjust.

3. In the combo boxnamedCurrent palette select the required palette.

4. If required, make any changes to the settings (see chaptersColours setup, Font setup, Beam type setup, Dimension line
setup for more information).

5. Confirmwith [OK].
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Loading and saving defined settings
Loading and saving settings for all the palettesat the same time

If required, you may use one the three buttons at the bottom edge of the dialogue to reload or save the settings for all the
palettesused in the program.

Load program default settings This option loads default settings as they were adjusted by the developer of the program.

Store user default setting This option saves the current settings for all palettes as your personal settings.

Store user default setting This option loads the settings that have been previously saved bymeans of the button described one line above.

Loading and saving settings for a separate palette
If required, you may use one the three buttons in the top part of tabs Screen, Document and Graphic output to reload or
save the settings for the selected group of parameters. Each of the following buttonsworks just with one sub-tab of themain
tabs, i.e. for examplewith tabScreen >Fonts, Document >Structural types, etc.

Load program default settings This option loads settings for the current tab as were define by the manufacturer.

Store user default setting This option saves the current settings as a user-defined default.

Load user default setting This option reads the settings that have been previously saved with button Store user default setting.

Load settings from other palette
This option enables the user to load into the current tab settings from the corresponding tab of any other
palette.

Convert colours to grey scale
This option converts the colours on the current tab into grey scale.

This option is not available for dimension lines.

Convert colours to black
This option converts all the colours on the current tab into black colour.

This option is not available for dimension lines.

Colours Setup
Adjustment of colours isa part of settingsmade for graphical palettes.

The adjustment of colour and line style can be made separately for each entity type and drawing part. The following para-
meterscan be adjusted for each available entityor symbol:

colour The user may select from a set of basic pre-defined colours or maymix his/her own shade.

line style The user may select from a set of available line styles.

width

This parameter defines the thickness of the line.

If the width type is set to pixels, the user may select the thickness in pixels of the screen.

If the width type is set to metric, the user may adjust the thickness in metric units.

width type

This options tell in which units the line thickness is specified.

Pixels are useful if the drawing is "tuned" for screen display.

Metric option is usually the right choice if the final drawing ismade on a graphical device such as printer, plotter, etc.

The procedure for adjustment of colours

1. Open dialogueColoursSetup usingmenu function Setup >Colours / lines,

2. Make the required settings.

3. Confirmwith [OK].
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Note: The settingsaremade separately for individual palettes. For more information about
the use of palettessee chapter DisplaySetup palettes.

Font Setup
Adjustment of fonts isa part of settingsmade for graphical palettes.

The following parameterscan be adjusted:

Character set
Several character sets are available. Proper choice of a character set is important especially when you want to
use characters that are specific for a certain language (e.g. diacritics).
Font type
Standard line fond and two variantsof true type fontsare available.
TT fonts smooth
If a true type font is selected, its smoothnesscan be adjusted here.

For each of the texts the following parameterscan be adjusted:

size Specifies the size of labels.

size defin-
ition

Specifies how the size is measured. It may be measured in units of graphical device or in absolute units (i.e. the units in which the
structure is defined).

colour This item specifies the colour of the text.

placement

The labelsmay be put into:

the plane of the screen

plane XZ

plane XY

line font
This option ismeaningful ONLY if a true type font is selected in the Font type item.

This item selects the font for the labels.

bold Labels are in bold letters.

italic Labels are in italic letters.

underline Labels are in underlined letters.

strikeout Labels are in stroked out letters.

The procedure for adjustment of fonts

1. Open dialogue FontsSetup usingmenu function Setup >Fonts,

2. Make the required settings.

3. Confirmwith [OK].

Note: The settingsaremade separately for individual palettes. For more information about
the use of palettessee chapter DisplaySetup palettes.

Beam type Setup
Adjustment of beam types isa part of settingsmade for graphical palettes.
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For each of the types the following parameterscan be adjusted:

colour The user may select from a set of basic pre-defined colours or maymix his/her own shade.

style The user may select from a set of available line styles.

width

This parameter defines the thickness of the line.

If the width type is set to pixels, the user may select the thickness in pixels of the screen.

If the width type is set to metric, the user may adjust the thickness in metric units.

width type

This options tell in which units the line thickness is specified.

Pixels are useful if the drawing is "tuned" for screen display.

Metric option is usually the right choice if the final drawing ismade on a graphical device such as printer, plotter, etc.

middle line This option specifies the style that is used to display 1Dmember middle line.

surface This option specifies the style that is used to display 1Dmember surface.

labels This option specifies the style that is used to display 1Dmember labels.

cross-section This option specifies the style that is used to display 1Dmember cross-section.

The procedure for adjustment of beam types

1. Open dialogueBeam typesSetup usingmenu function Setup >Beam types,

2. Make the required settings.

3. Confirmwith [OK].

Note 1: The settings are made separately for individual palettes. For more information
about the use of palettessee chapter DisplaySetup palettes.

Note 2: The Setup dialogue supports the standard Windows feature – multiple selection.
Therefore, if the same property should be set for several beam types, the types can be
selected at the same time and the property adjusted in one step. The multiple selection is
accessible via [Shift] + clickand [Ctrl] + clickcombination.

Note 3: For more information about structural types see chapter Geometry > Structural
model.

Dimension line Setup
Adjustment of dimension lines isa part of settingsmade for graphical palettes.

The dialogue enables the user to set the following parametersof dimension lines:

end mark style This option defines the shape of end mark (slash or arrow).

size definition
This option specifies how the size is measured. It may be measured in units of graphical device or in absolute units (i.e. the
units in which the structure is defined).

end mark size This parameters specifies the size of end mark.

font size This parameters specifies the size of dimension line font.
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plot line style This parameters specifies the style of plot line.

plot line offset This parameters specifies the offset of plot line.

1stdimension line
offset

This parameters specifies the offset of the dimension line closest to the dimensioned object.

next dimension
line offset

This parameters specifies the offset of other dimension lines.

The procedure for adjustment of dimension line style

1. Open dialogueDimension linesSetup usingmenu function Setup >Dimension lines,
2. Make the required settings.
3. Confirmwith [OK].

Note: The settingsaremade separately for individual palettes. For more information about
the use of palettessee chapter DisplaySetup palettes.

Adjusting the scales
The entities displayed on the screen are displayed in a specific scale. The user can control the scales through settingsmade
in theScalesmanager.

The scales are stored and can be adjusted in the Scales manager. This allows the user to have several "sets" of defined
scales for different purposesand to simplyswap between them.

The Scales manager always contains the set named "Current". The "Current" set is always associated to graphical win-
dows. All graphical windows use the same set of scales. In addition, you can define asmany user-defined sets of scales as
required.When you create a new set of scalesand assign it to the graphicalwindow, this set is stored in the Scalesmanager
under the name you define and it is also copied to the "Current" set. Thisway, the graphical windowsare alwaysassociated
with the "Current" set of scales.

Toolbar Scales

Scales toolbar contains the following controls:

Spin control for fast adjustment of scales for additional data
Thiscontrol enablesyou to quicklymultiplyall the scales for additional data by the factor in the spin control.
Button "Autofit scales for data" to recalculate the scales for additional data
This button recalculates the adjusted scales for additional data so that the drawing fits the screen. The ratio
between scales for individual entities is maintained, but the absolute value of the scales is changed. The button
performsno action if the Scale type in the "Current" set of scales is set to Symbol size.
Spin control for fast adjustment of scales for results
Thiscontrol enablesyou to quicklymultiplyall the scales for resultsby the factor in the spin control
Button "Autofit scales for results" to recalculate the scales for results
This button recalculates the adjusted scales for results so that the drawing fits the screen. The ratio between
scales for individual entities is maintained, but the absolute value of the scales is changed. The button performs
no action if the Scale type in the "Current" set of scales is set to Symbol size.
Button "Scales" for access to Scales manager
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Thisbutton opens theScalesmanager.

Scales manager
TheScalesmanager isa standard databasemanager. It can be used to:

a) create a new set of scales,

b) edit the existing set of scales,

c) activate one of the defined setsof scales,

d) copy, delete, export or import the setsof scales.

Note: The "Current" set of scalescannot be deleted.

Scales parameters
General parameters

Name
Specifies the nameof the set of scales. (The "Current" set of scalescannot be renamed).

Group data
Scale type
Symbol size
You define the absolute size of the symbol that is used for each type of entity. The multiplier is taken into account
during drawing.
Real ratio
You define the scales for individual types of entities. This scale is used directly (taking into account the multiplier)
to display the data.
Automatic ratio
You define the scales for individual types of entities. These scales, however, are used only to determine the
ratios between the size of individual entities. The absolute size is determined using the following algorithm: the
largest entity (e.g. the largest force) is so scaled, so that its size in the graphical window is 1metre. All other entit-
ies are scaled using the calculated ratios. The multiplier is taken into account, which means that if the multiplier is
set to 2, the size of the largest entity is2metres..
Multiplier
Thismultiplier isused to increase (or decrease) the real size of the displayed entities.
Point data
Thisvalue specifies the scale for "point" data such aspoint load, concentratedmoment, etc.
Line data
Thisvalue specifies the scale for "line" data such as line load, linemoment, etc.
Surface data
Thisvalue specifies the scale for "surface" data such assurface load, etc.

Group Result
Scale type
SeeGroupData (above).
If Symbol size option is selected for the results, the behaviour is similar to Automatic ratio, but each group of entit-
ies (beams, slabs, etc.) is treated separately. It means that the largest value isdetermined for everygroup of entit-
ies.
Multiplier
SeeGroupData (above).
Reaction, Deformation, Internal forces, Stress, Contact stress, Unity check, Other results
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The value specifies the scale for individual type of result value.
Group Symbols

Scale type
SeeGroupData (above).
Multiplier
SeeGroupData (above).
Point symbols, Line symbols, Surface symbols, Structure node symbol, Local axis symbols, Other
symbols
The value specifies the scale for individual type of symbols.

The procedure to open the Scales manager
a) Usemenu function Setup >Scales, or

b) clickbutton Scale ( ) on toolbar Scales.

The procedure to create a new set of scales
a) Open theScalesmanager,

b) Clickbutton [New].

c) Define the nameof the Scalesset and, if necessary, adjust the individual parameters.

d) Close theScalesmanager.

The procedure to assign a set of scales to the graphical window
a) Open theScalesmanager,

b) Select the required Scalesset.

c) Close theScalesmanager.

Document Setup
The Document Setup dialogue enables the user to adjust default values for the style of document. The parameters are
described in chapter Document >Adjusting the document default settings.

Picture gallery Setup
The Gallery Setup dialogue enables the user to adjust default values for style of pictures inserted into or created in the Pic-
ture gallery. The parametersare described in chapter Graphic output >Picture gallery>Picture gallerymanager > Inserting
a new picture into thePicture gallery>Adjusting the default values for new pictures.

Note: The settings adjusted in this dialogue are taken into account whenever a new draw-

ing is inserted into the picture gallery by means of Picture to gallery function ( ). For
example, if the default picture style is set to "wire", the drawing from the graphicalwindow is
inserted as "wired" even though it was e.g. rendered in the graphical window. The style
maybe later edited in thePicture gallerymanager.
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FE mesh Setup
Finite element mesh is generated automatically by the program. The user, however, may specify parameters that control
the generation process.

These parametersmaybe defined in the calculation dialogue or in the programsetup.

The setup dialogue can be opened usingmenu function Setup >Mesh.

Themeaning of individual parameters isgiven in chapter Calculation >Generating the FEmesh >Parametersof FEmesh.

Solver Setup
Thissetup dialogue provides for adjustment of basicparameterscontrolling the calculation.

Solver setup ispossible to open in twoways. Either in standard project tree in group "Calculation, mesh", or in the dialog "FE
analysis" just before the calculation isexecuted..

Parameters in Solver setup are divided into several groups according analysis type (Nonlinearity, Dynamics...), or as para-
meters for special functionality (Soil, Mass...).
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Solver setup groups of parameters
- General
Thisgroup of parameters isavailable for all type of calculations in the project.

There is only limitation in "type of structure" in "project data" dialog where there is no settings for slabs in for example project
type "frame".

Parameters for this group

- Neglect shear force deformation

- Bending theoryof plate/shell analysis

- Type of solver

- Number of sectionson averagemember
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- Warningwhenmaximal translation isgreater than

- Warningwhenmaximal rotation isgreater than

More information about these parameters ishere : " General calculation parameters"

- Effective width of plate ribs
Thisgroup of parameters isavailable for all type of calculations in the project.

There is only limitation in "type of structure" in "project data" dialog where there is no settings for slabs in for example project
type "frame".

Parameters for this group

- Number of thicknessof rib plate

- Parallelism tolerance for automatic calculation [deg]

- Span length ratio L/beff,max (1 side) for automatic calculation [-]

- Span length correction

Parameters in subgroup "Span length correction"

- Simplysupported beam

- Inner span

- End span

- Cantilever

More information about these parameters is here : "Automatic Calculation of the Effective
Width of PlateRibs"

- Nonlinearity
This group of parameters is available only for nonlinear calculation, in the project with some nonlinear functionality and non-
linear combination.

Parameters for this group

- Geometrical nonlinearity

- Method of calculation

- Number of increments

- Maximum iterations

- Solver precision ratio

- Solver robustness ratio

- Plastichinge code

- Geometrical nonlinearity

- Allow compression inmembranemembers

More information about these parameters ishere : " Staticnon-linear calculation"
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- Dynamics
Thisgroup of parameters isavailable only for dynamiccalculation, in the project with some dynamicLC and dynamic load.

Parameters for this group

- Type of eigen value solver

- Number of eigenmodes

- Use IRS (ImprovedReducedSystem) method

- Producewall eigenmode results (needed for ECTools)

- Enable advancedmodal superposition for seismic load cases

- Method for time historyanalysis

- Masscomponents in analysis

Parameters in subgroup "Mass components in analysis"

- Translation along globalXaxis

- Translation along globalYaxis

- Translation along globalZ axis

- Rotation around localXaxisof 1Dmembers (torsion)

More information about these parameters ishere : "Dynamicnatural vibration calculation"

- Stability
This group of parameters is available only for stability calculation, in the project with stability functionality and Stability com-
bination.

Parameters for this group

- Type of eigen value solver

- Number of critical values

- Soil
Thisgroup of parameters isavailable only if functionality "Subsoil" isavailable in the project.

Parameters for this group

- Soil combination

- C1x
- C1y
- C1z
- C2x
- C2y
- Thicknessof loose layer at contact level [m]
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More information about these parameters is here : "Required parameters for Soil- in cal-
culation"

Advanced geometry setup
The parameters in the first group are identical with some items from the Parameters controlling the alignment of the struc-
ture. These values are used for all geometrical operations and for your convenience they are added into this dialogue as
well

Geometric tolerances
Min. dis-
tance of
two nodes,
node to
curve

Specifies the min. distance of two nodes for which the two nodes are considered separate nodes. If the real
distance of two nodes is lower than this parameter, the two nodes are merged together.

This parameter is used by the function for connection of entities and by the function for check of data.

Max. dis-
tance of
node to
2Dmem-
ber plane

Specifies the maximal allowable distance of a node from the plane of a 2D member. If the actual distance is
larger than this limit value, the geometry is considered invalid and a corresponding warning is issued.

Note: The algorithm tries to find a new plane with normal vector, for the given definition points, which fulfils
the condition for maximum distance of the node to plane. It means if there is input a node outside the plane
then a new basic plane is found between these points. If all points are closer than the defined maximum
value then it is considered as a valid state.

Displaying
Precise member
surface

This parameter comes into account only if surfaces are switched on.

If ON, the shape is displayed as precisely as possible.

If OFF, only the schematic shape of the cross-section is displayed.

The parameter hasmeaning in particular for steel rolled sections.

Immediate
refresh of struc-
tural model

If ON, the structural model is automatically refreshed after all changes.

If OFF, the structural model is refreshed manually on user’s request.

Precision of dis-
played curves

This parameter control smoothness of curves and curved surfaces. The higher the number the
smoother the curve. On the other hand, the higher the number the slower the response of your com-
puter may be.

The parameter must be from interval <1, 10>.

The parameter does not affect the precision of the calculation.

Precision of cut-
outmesh

This parameter controls smoothness of the displayed shape of intersecting surfaces.

The parameter does not affect the precision of the calculation.
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Load panels
Disable auto-
matic update
of load panels

If ON, during manipulation, adding and removing members selection of beams and edges supporting
load panels is not updated. The update can be forced manually by pressing the action button Update all
load panels which is in Properties of each panel.

If OFF, beams and edges supporting load panels are automatically updated during manipulation
actions.

Code-check parameters and National Application Docu-
ments
National Application Documents

Scope of the chapter
This chapter describes the way the parameters for code checks of concrete, steel and aluminium structures according to
EC-EN code can be adjusted in SCIAEngineer 2010 and later versions. Themanual presents the environment in which the
parameterscan be set and explains the procedureshow to do it.

This chapter coversONLY the EN-EC code. The dialoguesand procedures for other codesmaybe different. For those dif-
ferenceswe refer to the other partsof the documentationwhere proper explanation isgiven.

In particular, Steel Code Checksmanual, Concrete Code Checksmanual and Aluminium Code Checksmanual are useful
sourcesof information.

Code Check Parameters
Code checks for any material require that numerous parameters appearing in the check formulas be properly defined.
Someof these parameters forma part of NationalApplicationDocument, some result from the procedures implemented.

The program enables the user to adjust all these parameters in what is called Concrete Setup, Steel Setup, Aluminium
Setup, etc.

The layout and behaviour of these Setups will be explained for the Concrete Setup. For other materials, the principles are
the same.

National Application Document versus other code-check parameters
The Concrete Setup can be opened from several places of the program, i.e. using different functions. The behaviour of the
Concrete Setup may differ depending on the way it was opened. This is important mainly for one reason. In order to make
the Setup dialogues clearer, you can never see in it together the (i) parameters of the National Application Document and
(ii) other parameters.

National Application Document parameters
To see, or modify, National Application Document parameters (hereinafter NAD parameters), youmust open the Concrete
SetupDialogue in the followingway:

1. In themain tree, double click itemProject.

2. Thisopens theProject data dialogue.

3. In it, click the three-dot button next to itemNational annex.

4. Thisopens theSetupManager dialogue.
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This dialogue s a standard database manager as e.g. Material Manager, Load Case Manager, etc. It means that you can
define asmany sets of NAD parameters as required and you can simply select the set that is the most appropriate one for
your current work. The setscan also be stored on the diskand read to another project.

By default, one set (EC-EN in the picture) is defined automatically by the program. This set ensures that even if you do not
open theSetupManager, the parametersare defined and the programcan use them.

What is important about thisdefault set is that it isREAD-ONLY. It means that you cannot alter the valuesof the parameters.
If you need different values for some parameters, youmust define a new set (e.g. asa copyof the default one) and then you
can adjust the required parameters.

List of defined sets of parameters
The top part of the dialogue listsall the sets that have been defined in the project.
Individual National Application Documents
The bottompart of the dialogue containsa list of individual codesand their parts. Each item isaccompaniedwith a
three-dot button that opens a separate dialogue where individual parameters can be reviewed or modified (with
the exception of the default set that is read-only).

Other code-check parameters
To see, or modify, other code-check parameters, you must open the Concrete Setup Dialogue from different place than
from theProject Data dialogue. There are severalways to do so, each of themshowing certain specifics.
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Libraries > Setup
Function Libraries > Setup (opened either from the tree menu or from the main menu) opens the Setup Dialogue with all
available parameters (except theNAD parameters).

Concrete > Design Defaults
Function Concrete Advanced >Design Defaults opens the Setup Dialogue with just the basic parameters (again except the
NAD parameters).

Concrete > Member Data
Button [Concrete Setup] in the input dialogue of function Concrete Advanced > Member Data opens the Setup Dialogue
with parameters that are relevant for the selected type ofmember (again except theNAD parameters).

Setup > Concrete Solver
Menu function Setup > Concrete Solver opens the Setup Dialogue with just the parameters relating to the solver for con-
crete structures (again except theNAD parameters).

Setup Dialogue
In general, the SetupDialogue consistsof four parts (see the picture below):

• filter window (A),

• treewindow (B),

• propertywindow (C),

• explanationwindow (D).
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Filter Window (A)
This window contains a list of “filters” that can be used to reduce the number of parameters displayed in other
partsof the dialogue.
Note: Thiswindowmaybe hidden for some configurationsof the dialogue.
Tree Window (B)
Thiswindow containsa list of parameter groupsarranged in a tree structure.
Clicking on a branch in the tree expanses the corresponding part of the property Window (with other branches
automatically collapsed).
Property Window (C)
This window lists all the parameters that are available for the current configuration of the dialogue. The para-
metersare sorted in groups (branches). Youmayexpand or collapse the required groups.
Explanation Window (D)
Once an item is selected in the Property Window, an explanation is displayed in this window. If possible, the
explanation isaccompaniedwith an illustrative picture.

National Annexes
Supported National Annexes
The current coverage of national annexes in SCIAEngineer can be found in the SCIAResourceCentre or on our Eurocode
microsite.

The parameters described in the National Determined Parameters (NDP) in the foreword to each EN Eurocode part have
been extracted and collected in one National Annex dialogue. On condition that the code of the project is set to Eurocode,
the user can select the required National Annex and the National Annex dialogue becomes available, where the National
Determined Parameters can be reviewed. All parameters are open, which means that the user can edit the values if
desired. In this way, the parameters can be adapted according to the appropriate National Annex. This gives the possibility
to use theNationalAnnexof eachEuropean country.

Furthermore, it is possible to save the settingsand use them in future projects.

Project Data dialoguewith openedNationalAnnexManager
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NationalDeterminedParameters for EC0
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Basic working tools

Selections
Introduction to selections
Whenever the user needs to do anything with any part of his/her model, s/he must, first of all, determine which part of the
model should be treated. In other words, the user has tomake a "selection" ofmembers that will be processed.

Once the selection is defined, the required operation may be started. The selection may be formed by a single entity or it
may hold asmany entities as required. Generally, the selection may contain entities of the same type, or it may contain sev-
eral entity types. Which of the two cases is applied depends on the intended operation. Some operations require specific
entity types, other operationsmaybe carried out with anyentity types.

In general, there are two approaches to start an operation:

l the user first makes the selection and then starts the appropriate function (the function then deals with the prior made
selection),

l the user first starts the required function and then (i.e. fromwithin the function) makes the selection.

Which approach isactuallyapplied dependsonlyonworkhabitsof a particular user.

To sum up, the selection can be not onlymade and utilised in a function, but it can be also modified (reduced or extended),
cleared, saved into a file for later use or loaded froma previously created file.

Selectionsare controlled by:

l MenuView >Selections,

l Selections toolbar.

Making a selection
In order tomake a selection, the programmust be in the selection-enabledmode. Thismode is the default mode of the pro-
gram and only a limited number of functions changes this mode into a selection-disabled mode. The selection-enabled
mode is identified by the mouse cursor that looks like a diagonally oriented arrow with a small square attached to the tip of
the arrow.Once this cursor ison the screen, it is possible tomake selections freely.

There are two basic ways to make a new selection: using the mouse or typing a command on the command line. In both
ways it isa piece of cake.

In addition, a selection can also be made via filters. That means, that the user specifies a condition that should be fulfilled by
all selected entities. For example, the user may specify the condition that the cross-sectionmust be a rolled IPE 300. The fil-
ter-controlled selection then looks for and selectsall 1Dmemberswith such a cross-section.

Making a selection by the mouse cursor
When using themouse cursor, there are several selectionmodes:

single
selection

One entity is selected each time the user clicks the mouse button.

intersection The user draws a line (or a polygon) on the screen. The program selects all entities that have an inter-

- 243 -



Chapter 5

line section with the drawn line.

rectangular
cut-out

The user draws a rectangle on the screen. The program selects all entities located inside the rectangle or
overlapping it (see the paragraph below for details about this selection mode).

polygonal
cut-out

The user draws a closed polygon on the screen. The program selects all entities located inside the poly-
gon.

working
plane

The program selects all entities located in the current working plane.

select-all All currently displayed entities are selected

previous Activates the lastmade selection.

How to activate the required selection mode:
selection mode via toolbar Selections via menu Tools > Selections

Single selection click button [Selection bymouse] call function Selection bymouse

Intersection line click button [Selection by cut-out]
call function Selection by intersection
line

Rectangular

cut-out
click button [Selection by intersection line] call function Selection by cut-out

Polygonal cut-out click button [Selection by polygonal cut-out]
call function Selection by polygonal
cut-out

Working plane click button [Select by working plane] call function Select by working plane

Select all click button [Select all] call function Select all

Previous click button [Previous selection] call function Previous selection

Single selection
mode toggle

swaps between "First found" and "All found"
mode

see paragraph Selection of entities
with overlapping edges

Selection mode
toggle

swaps between "Select" and "Deselect" mode
see topic Removing the entities from
selection

Visibility selection
mode

swaps between "normal" selection mode and
a special mode for OPGL

see paragraph Visibility selection
mode

see also paragraph Visibility selection
acceleration

Single selection
In order tomake a selection, the user has to:

1. place themouse cursor on the entityhe/shewants to select,

2. click the left mouse button.

That is all that is necessary to make a selection by mouse. To add another entity, the user just puts the cursor on another
entityand clicks the left mouse button.
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Intersection line
When this mode is invoked, all entities that are intersected by a defined line are added into the selection. The line may be
either a single straight line or a polygon consisting of straight lines.

The procedure to define a polygon

1. Position themouse cursor to the placewhere the polygon should start.

2. Click the left mouse button.

3. Position themouse cursor where the end point of the polygon line segment should be located.

4. Click the left mouse button.

5. Repeat the previous two stepsasmany timesas required.

6. Close the polygon, ie. either

1. press [ESC] key, or

2. invoke the pop-upmenu, select End polyline command and run it, or

3. define the last point with a double-clickon the left mouse button.

Cut-out
Thismode enables the user to select all entities located inside a mouse defined cut-out. There are two different kinds of the
cut-out. The first one serves for selection of entities located fully inside it. The other one can be used to select entities that are
both fully inside and overlap the cut-out.

The procedure to define a cut-out that selects inside-located entities only

1. Place themouse cursor to the TOPLEFT corner of the rectangular cut-out.

2. Press the left mouse button and hold it down.

3. Drag themouse to theBOTTOMRIGHT corner of the rectangular cut-out.

4. Release the button.

The procedure to define a cut-out selecting both inside-located and overlapping entities

1. Place themouse cursor to the TOPRIGHT corner of the rectangular cut-out.

2. Press the left mouse button and hold it down.

3. Drag themouse to theBOTTOMLEFT corner of the rectangular cut-out.

4. Release the button.

Polygon
Thismode is similar to the previous one. The difference is that the user draws an arbitrarily shaped closed polygon instead
of a simple rectangle.

The procedure to define a polygonal cut-out

1. Position themouse cursor to the placewhere the polygon should start.

2. Click the left mouse button.

3. Position themouse cursor where the next vertexof the polygon should be located.

4. Click the left mouse button.
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5. Repeat the previous two stepsasmany timesas required.

6. Close the polygon:

1. either press [ESC] key, or

2. invoke the pop-upmenu, select Close polygon command and run it.

Working plane
In thismode, the programautomatically selectsall entities located in the current working plane.

Select-all
All displayed entitiesare automatically selected.

Selection of entities with overlapping edges
In a real-life model it is frequent situation that several entities (e.g. beams, walls) meet in one place (joint, corner). In that
case it may be difficult to select the proper entity, because when you place the mouse cursor over the intersection of these
entities, the program does not know, which one to select. To solve such situations, the program offers a special toggle:
Single selection. This switch enablesyou towork in twomodes:

First found
In thismode, the first entity found by the selection algorithm isselected (usually, it is the entity that was input first).

All found
In this mode, the program finds all entities under cursor and offers you a list of them so that you may decide yourself which
one(s) should be selected.

Imagine a simplemodel of threewalls.

If you place the cursor over the corner in which the three walls meet and click the left mouse button, the program opens a
small dialoguewith a list of found entities.

You may roll the mouse cursor over the list. The entity over which the cursor is just placed is highlighted in the graphical
screen, so it iseasy to find out which entity iswhich.
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If youwant to select a particular entity, just clickon itsname in the list. Youmayselect asmanyentitiesasyouwant.

When you press the green-markbutton, the selection is confirmed.

Visibility selection mode
In the "normal" selectionmode, youmust select an edge of an entity in order to select it.
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However, if the Visibility selectionmode is activated, youmay just put themouse cursor anywhere on the displayedmember
and it can be selected. The onlyprecondition is that Rendering displaystyle isactive.

TheSingle selectionmode toggle is taken into account in the Visibility selectionmode.

Examples (the little cross in the blue circle indicates the position of themouse cursor):

A) Single selectionmode toggle set to FIRST FOUND

B) Single selectionmode toggle set to ALL FOUND
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Please note that the cursor changes its shape when the program is in the visibility selection
mode.

Visibility selection acceleration
When you use the Visibility selection mode, the acceleration can be used to speed up the manipulation with large models.
However, it is important to know that the final effect of the acceleration depends on the model of the structure and that the
accelerationmay, under certain circumstances, even slow down the program response.

The principle of the acceleration is that themodel that isdisplayed in the graphicalwindow isconverted to anOPGL scene (a
special graphical scene optimised for the graphical card) that is usually processed faster by the graphical card. However, in
order to allow for selections, the OPGL scenemust handle also a list of all members that are displayed. And thismay be the
core of the problem. If the "workload" related to the management of this list exceeds the "workload" related to displaying of
the graphical scene, the effect of the accelerationmaybe negative. This can be better understood on the following example.

Let ushave a structuremodel composed of 1000members (beamsand columns).

A) All the members have a rectangular cross-section. It is quite a simple task for the graphical card to display such a simple
shape (even if it is repeated 1000 times). On the other hand, the maintenance of the list of 1000 items is a rather complex
matter. Asa result, if the acceleration isON, the response of the programwill bemost likely slower.

B) All the members have a circular (pipe) cross-section. It is more complex task for the graphical card to display such a
shape. As a result, the acceleration will probably have no effect. In other words, the time saved during the display operation
equals the time needed for themanagement of the list of themembers.

C) All the members have a cross-section of a complex shape (e.g. a complex aluminium profile). In this case, the time sav-
ings reached due to faster display operation aremuch greater than the time-losses due to themanagement of the list of the
members.Whichmeans that the acceleration hasa positive effect.

The acceleration can be switched on/off inmenu Tools>Selection.

Filter-controlled selection
The filter-controlled selection is useful if the user wants to select all entities that meet a specific condition. This type of selec-
tion isdescribed in the following chapter.

Making a selection from the command line
Aselection can be alsomade (sometimesveryeffectively) from the program’scommand line.

The procedure is similarly simple as the "mouse procedure". The user typesa command on the command line and the selec-
tion ismade.

Command syntax
SEL [switch] parameter [parameter2] [parameter3] [etc.]

or

SELM [Enter]

name1 [Enter]

name2 [Enter]

...

END [Enter]
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The latter alternative provides fo multiple selections. SELM + [Enter] starts the multi-selection mode. Then you can type the
names of required entities one by one – each one followed by [Enter] key. The selection can be completed with command
END (followed by [Enter] key).

Switch

switch meaning

+ adds into selection

- subtracts from the current selection

| inverts the current selection

Parameter

parameter example description

entity name
SEL
BEAM23

selects entity named BEAM23

entity name with a wild-
card

SEL
BEAM2?

selects all entities whose name starts with BEAM2 and is followed with a single
character

SEL B?
if 1Dmembers are named B and numbered, this command selects all "one-digit"
1Dmembers

SEL B??
if 1D members are named B and numbered, this command selects all "two-digit"
1Dmembers

SEL B* selects all entities whose name starts with letter B

SEL B1 B2 selects entities named B1 and B2

NONE SEL NONE clears the selection

Examples

sel
none

clears the selection

sel * selects all entities

sel N1 selects entity N1

sel +
N*

adds into the current selection entities whose name starts with N

sel –
B*

removes from the current selection entities whose name starts with B

sel |
B1

inverts entity B1 in the selection (i.e. if the entity WAS in the selection, it is removed; if the entity WAS NOT in the
selection, it is added)

Making a selection of a mesh node from the command line
To select amesh node by itsnumber, commandSELMN can be used.

Procedure to select required mesh nodes
1. Type commandSELMN in theSCIAEngineer command line and pressEnter.

2. The selection function starts.
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3. Type the number of the node to be selected and pressEnter. The node ismarkedwith an arrow.

4 . If required, repeat step 3.

5. PressEsc to end the command.

IMPORTANT: In order to see the arrow denoting the selected node(s) it is necessary to
switch ON the appropriate flag in the View parameters settingsDialogue - Miscellaneous>
Calculation info >Displayarrow onmesh elements.

Procedure to remove the highlighting arrow from selected mesh nodes
1. Select the arrow or the accompanying text with themouse cursor.

2. Press key Delete on your keyboard OR use the Delete function from the pop-up menu OR use the Delete function from
theModifymenu.

Removing the entities from selection
When using complex and extensive selections, it may be necessary or at least useful to remove a particular entity or entities
from the alreadymade selection.

In general, there are two ways to remove an entity from an existing selection: "[Ctrl] key" method and "Inverted selection
mode" method.

"[Ctrl] key" method ("[Shift] key" method)
All the selection modes for making a selection can be used aswell for removal of specific entities from the current selection.
In order to activate the "subtract from selection" mode, the user must pressdown and hold [Ctrl] keyon the keyboard.

Note: The [Ctrl] keymethod in fact INVERTS the selection (i.e. it is not REMOVAL from the
selection, but an unselected item isselected and a selected item isdeselected).

Note: The [Shift] key can be used instead of the [Ctrl] key - these two keys are inter-
changeable (in this function).

Example 1:

Let’sassume that a selection of some entitieshasbeen alreadymade. Now, the user needs to remove one particular entity.

The procedure will be:

1. Position themouse cursor over the entity that should be extracted from the selection.

2. Pressdown and hold [Ctrl] key.

3. Click the left mouse button.

4. The entity is removed from the selection.

5. Release [Ctrl] key.

Example 2:

Let’sassume that a selection of some entitieshasbeen alreadymade. Now, the user needs to remove a few entities that are
parallel to each other and located close to each other.
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The procedure will be:

1. Select Intersection line selectionmode.

2. Position themouse cursor next to the first entity that should be removed from the selection and outwards from the others.

3. Pressdown and hold [Ctrl] key.

4. Define the intersection line, i.e. the line or polygon intersecting all the required entities.

5. Close the intersection line.

6. Release [Ctrl] key.

"Inverted selection mode" method

It is also possible to press button [Selection mode toggle] ( ) on toolbar Selections. All the selection modes described in
chapter Making a selection then remove entities from the previouslymade selection.

Note: It is also possible to remove entities from selection using command "SEL" typed on
the command line with the appropriate switch and parameter. For more information see
chapter Making a selection.

Making a selection based on a specific property
Very often the user needs to select all entities that meet some specific condition. For example, to select all 1D members
made of onematerial type or all supports allowing for freemovement in X-direction, the filter-controlled selection is the right
choice.

The procedure to apply a filter-controlled selection

1. Select one entity thatmeets the required condition.

2. In the property table click the left column cell of the row that contains the required condition.

3. Click icon [Quickselect] ( ) at the top of the propertydialogue frame.

Note: This type of selectionmaybe used to select e.g.

- all the 1Dmembersof the same cross-section,

- all the slabsof the same thickness,

- all the entities located in the same layer, etc.
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Adjusting the filter for selections
Sometimes it may be very useful to limit the selection on some entity types only. SCIA Engineer enables the user to specify
the filter for selections.

There are three filter options:

OFF The filter is OFF and any entity of any type may be selected.

For service Function for making a selection recognises only those entities which the active service can deal with.

For tree The type of entities that can be selected is defined by the position of cursor in the tree.

Remark: In case of active one click main tree option is turned ON, selection in main tree is
set on right-click

Filter for service
If this filter option is selected, the set of entities for selections is defined by the currently opened service. The user can select
only those entities that the service can dealwith.

For example, if service Loads is open, and this filter option is ON, only 1D members, nodes, and loads of all types can be
selected.

Filter for tree
If this filter option is selected, the set of entities for selections isdefined by the currently opened service. and by the position of
cursor (by the focus) in the tree menu. The user can select only those entities that are specified by the function "under
focus".

For example, if service Loads is open, and this filter option is ON, and the focus in on function Line force on beam, only line
loadscan be selected.

The procedure to adjust the required filter

1. Clickbutton [Filter] on theStatusbar.

2. A short menu isopened.

3. Select the required filter.

The alternative procedure for the adjustment of the required filter

1. Press in button [Filter for selection on/off] ( ) on Selection of objects toolbar in order to select Filter for service.

2. Thisactionmakesanother filter button available – [Filter byservice tree on/off] ( ).

3. Press in button [Filter byservice tree on/off] on Selection of objects toolbar in order to select Filter for tree.

Modifying a selection
Anyexisting and active selectionmaybemodified, i.e. some of the selected entitiesmaybe removed from it and some other
entitiesmaybe added to it.
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Removal of entities from the selection
In order to remove an entity from the current selection, follow the procedure given in chapter Removing the entities from
selection.

Adding another entity into the selection
In order to add another entity into the current selection, simply follow the procedure for making the selection. Until you clear
the selection, anynew selected entitiesare added to the current selection.

Applying a selection
A selection is usually made to carry out an action (i.e. call one or more of SCIA Engineer functions). In fact, vast majority of
SCIA Engineer functions works with a selection and modifies the entities in the selection according to defined functionality.
Therefore, it must be clear how to associate the selection with the required action. Fortunately, this crucial step is completely
automaticand absolutely straightforward in SCIAEngineer despite the fact that there exist two opposing approaches.

Applying a pre-created selection
Thisapproach leads to the following steps:

1. Select the required entities.

2. Start the function.

3. The function "works" with the previouslymade selection.

Applying a post-created selection
On the other hand, thisapproachmeans:

1. Call the required functions.

2. Select the entities that should be treatedwith the function.

3. The function then processes the in-function-defined selection.

Both approaches have their advantages. The latter is useful mainly if the user wants to apply the same function on several
different selections. It is possible to change the function parameters for each particular selection, but the main function itself
must be called just once.

Clearing a selection
If a selection is no longer useful, or if it wasmade improperly (e.g. wrong entities have been selected), or if anyother reason
occurs, the selection may be cleared. It means that the selected entities are removed from the selection but NOT from the
project. Just the selection isemptied.

There are severalways to clear a current selection:

l Press [ESC] key,

l Click [Cancel selection] ( ) button on theSelections toolbar,

l Call functionCancel selection frommenuTools>Selections.

All the possibilitiesare equivalent to each other.
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Saving and reading a selection
Anyselectionmade for anypurpose can be saved to a disk for later re-use.

Any selection can be saved or loaded through appropriate functions from the Selections toolbar or via menu Tools > Selec-
tions.

The selections are stored with the project. It is however possible to export the selections out of the project and use them in
another project. Thisexport can bemade in theSelectionmanager (see below).

There are, in principle, three actions that can be donewith selections:

l a new selection can be saved (done throughSave selection dialogue),

l an existing selection can be loaded (done throughSelectionmanager dialogue),

l an existing selection can be updated (done throughSelectionmanager dialogue).

In addition (as already stated), any selection can be exported from the project to an external file that can be later imported
into another project.

Note: Be careful when using one selection (EPS) file with multiple projects. The program
makes no special checks and mechanically reads the selection from the file. However, the
entitiesstored in the selection that do not exist in the project are, naturally, ignored.

Saving a new selection
When a selection isbeing saved, the Saved selection dialogue isopened on the screen.

Saved selection dialogue
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Name You can assign an arbitrary name to each saved selection.

Edit selec-
tion

The selection that was made in graphical window before invoking this dialogue can be further modified or
reviewed in the Make selection dialogue – see below.

This option can be also useful when a new selection ismade directly in the Selection manager – see below.

Select pic-
ture

Each saved selection can be accompanied with an illustrative picture – e.g. screen copy – that may be
worth thousand words in explaining which entities are in the selection in question.

Comment You may add e few lines of comment.

Description This field contains an automatically generated list of all entities included into the selection.

Make selection dialogue

On condition that you know the names of individual entities in your project, you can manually add or remove the required
entities to or from the selection.

Available
(entities)

This list contains a list of all available entities that can be included into the selection. This list does not contain
the entities that have been already inserted into the current selection.

Selected
(entities)

This list names the entities that have been inserted into the currently edited selection.

Button [--]
This button collapses all the branches of the tree with the list of (available/selected) entities.

Each list in the dialogue has its own button.

Button
[++]

This button expands all the branches of the tree with the list of (available/selected) entities.

Each list in the dialogue has its own button.

Button [>] Use this button to move the highlighted item from the "available" to the "selected" list, i.e. add it to the selec-
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tion.

Button
[>>]

Use this button to move all the items from the "available" to the "selected" list, i.e. add them to the selection.

Button [<]
Use this button to move the highlighted item from the "selected" to the "available" list, i.e. remove it to the
selection.

Button
[<<]

Use this button to move all the items from the "selected" to the "available" list, i.e. remove them to the selec-
tion.

Loading a saved selection
Once a selectionwassaved, it is possible to load it back for usewith any function that workswith selections. Anysaved selec-
tion can be loaded through the Selection manager. The Selection manager is a standard SCIA Engineer database man-
ager.

Selection manager
New Creates a new selection.

Edit Edits the existing selection.

Copy Creates a copy of an existing selection.

Delete Deletes the existing selection.

Undo,
Redo

Takes back the last action done in the manager.

Read from Reads a selection that was saved to an external EPS file.
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disk

Save to
disk

Saves the selection into an external file with extension EPS.

Selection
properties

The right-hand side of the Selection manager dialogue contains the information about the selection. The
content is identical to the Saved selection dialogue described above.

Updating a saved selection
Any saved selection can be updated any time later, if required. The update ismade through the Selection manager. That is
however modified a bit. The button load is replacedwith button [Update].

The fact that the update uses the Selection manager has one major advantage. Let us assume that you loaded a saved
selection, modified it in the graphicalwindow, started function Update named selection and only then you realise that you do
not want to lose the original selection – that it is still useful and necessary. You are in the Selection manager, so instead of
selecting (and updating, i.e. changing) one of the existing named selections, you can create a new selection and use it for
the update function. In other words, you can swap from "Update" to "Save as new" even if the update function is already in
the progress.

The procedure to save a new selection to a disk

1. Make a selection.

2. Start function Save selection (either on toolbar Selectionsor inmenuTools>Selections).

3. Select Save asnew from the submenu.

4. Fill in the parameters in theSaved selection dialogue.

5. Confirmwith [OK].

The procedure to update the existing selection

1. Load the required selection (see below for the procedure).

2. Modify the selection as required.

3. Start function Save selection (either on toolbar Selectionsor inmenuTools>Selections).

4. Select Update existing from the submenu.

5. TheSelectionmanager isopened on the screen.

6. Select the selection to be updated.

7. (If you change youmind, you can create a new emptyselection to be "replaced" by the updated selection).

8. Confirmwith [Update].

The procedure to read a selection from a disk

1. Start function Load selection (either on toolbar Selectionsor inmenuTools>Selections).

2. Select the selection youwant to read.

3. Confirmwith [Load].
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Selections versus editing of properties
Selectionsare very advanced feature of SCIAEngineer. Theydo not provide just for the passive selection of entities that will
be further treated in someway. The selections represent a powerful tool for editing of the project.

The principle is that whenever whichever entity is inserted into a current selection, itspropertiesare automaticallyand imme-
diatelydisplayed in the propertywindow of the application.

If multiple entitiesof the same type are selected then the intersection of their properties is displayed in the window. If multiple
entities of different types are selected, the user may choose the type whose properties should be displayed. It is of course
possible to simplyswap between the typesonce the parameters for one type have been reviewed.

What’smore, anydata displayed in the propertywindow can be edited and the change is immediately recorder.

Editing in the property window for one selected entity
If just one entity is selected, the property window shows it’s properties and, if possible, co-ordinates of its endpoints. Once
the user changesanyof the values in the propertywindow, the change is recorder and the entity is re-displayed to reflect the
changes.

Editing in the property window for multiple selected entities of the same type
If several entities of the same type are selected, the property window displays the intersection of their properties. That
means that the dialogue containsvaluesof those parameterswhich are identical. If anyparametersare of different value for
different 1Dmembers in the selection, the value cell in the propertywindow is left blank.

The user mayonce again edit any item in the propertywindow. This relates even to the blank cells. If a value is input into any
of the cells, that value isassigned to all the entities in the selection.

Editing in the property window for multiple selected entities of various types
Here the same can be said as in the paragraph above. What’smore, the combo box at the top part of the property window
contains a list of all typeswhose entities are in the current selection. When the used selects any item from this list, the prop-
ertiesof thisentity type are shown in the propertywindow.

The user may then review or edit themasdescribed above.

Note: See also chapter Controlling the selection-versus-editing process.

Controlling the selection-versus-editing process
The principle of editing in the Property window as described in chapter Selections versus editing of properties can be con-
trolled bymeansof settingsmade in theEnvironment settings.

The Environment settings dialogue contains item Maximum number of grouping properties. This items tells the program
what is themaximumnumber of entities for which the "selection-versus-editing" processshould be started.

In other words, if the user selects fewer entities than specified in the parameter Maximum number of grouping properties,
the Propertywindow is filled inwith the parametersof selected entities. Consequently, the parameterscan be easilyedited.

On the other hand, if the number of selected entities isgreater than the number specified in parameter Maximumnumber of
grouping properties, the Propertywindow is left blank. If required, the Propertywindowmaybe filled inmanuallybypressing

button [Update propertydialogue] ( ) located at the top right corner of the Propertywindow..

This featuremaybe useful particularly for large projectswith a great number of entities. The time that is necessary to collect
and sort all the parameters of all selected entities is growing with the number of selected entities. In addition, it is assumed
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that usually the user will select only a limited number of entities for direct editing in the Property window. And, if the user
selects a really vast number of entities, it is assumed that the selection wasmade for some of manipulation functionsand not
for direct editing.

Therefore, it is possible tomake as large selection asnecessaryand applyanyofmanipulation function to it, but the Property
window is not filled in for excessive selections. If, however, the user doeswant to edit directly even the enormousnumber of
entities, he/shemay fill in the Propertywindowmanuallybymeansof the abovementioned button.

Selections of slabs with openings
If a slab hasan opening or a subregion, there are a few rulesconcerning the selection of such a slab.

Let’sassume a simple rectangular slabwith an opening.

Adjust the view parametersso that only themiddle line of a slab isdisplayed on the screen

If you select the outline of themain slab, themain slab ishighlighted and also selected.

In order to select the opening, youmust select the opening itself.
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And now, let’s change the view parametersand let also the surfacesof the slab displayed.

If you select the surface outline of themain slab, themain slab is highlighted and also selected. In addition, the surface of the

opening is highlighted aswell, BUT be careful, it is NOT selected (see the middle line of the opening – it is NOT high-
lighted).

In order to select the opening, youmust select the openingmiddle line itself.
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Activity
Introduction to activity
The concept of activity is based on the assumption that it is convenient to hide a part of themodelled structure and work only
the remaining part. This is useful mainly for larger projects where a great number of 1D members and other entities may
reduce the lucidityand comfort of performed operations.

The activity feature provides for selection of only those members that are essential for a certain manipulation or operation.
The rest of the structure is temporarily hidden from the user’s view.

In SCIAEngineer the activity can be realised bymeansof two approaches:

l Layers - see chapter Layers for more details

l Activity functions– see individual activity functions.

Activity types
There are several approaches the user may choose to determine which part of the structure should be active (i.e. visible
and available for manipulations).

Layers
The activity is completely controlled by layers.

See chapter Basic working tools > Layers > Displaying and hiding a layer.

Working plane Onlymembers located in the current working plane become active.

Selection
Onlymembers being currently selected become active.

Optionally, the selected membersmay become inactive and all the others remain active.

Clipping box Onlymembers located inside the current clipping box become active.

Switching the activity On or Off
Despite the currently selected type of activity, the user may decide whether the activity as a whole should be switched on or
off. In other words, whether only the "active" part of themodelled structure should be visible or whether the whole structure
should be displayed and available for manipulations.

The procedure to switch the activity (i.e. to switch it ON if the activity is OFF and vice versa)

l Either call function Tools>Activity>ActivityOn (or ActivityOff).

l Or clickbutton ActivityOn (or ActivityOff) on Activity toolbar ( ).

Note: Both the menu item and the tooltip of the function mentioned above contain the
information about the current Activity type.

Activity according to layers
When this activity type is selected, the information specified in the Layers manager controls the activity of structure mem-
bers.

For more detailsabout layersand their use see chapter Basicworking tools>Layers>Displaying and hiding a layer.
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The procedure to adjust the activity according to layers

l Either call function Tools>Activity>Activityby layers.

l Or clickbutton Activityby layersonActivity toolbar ( ).

Activity according to current selection
The user may simply select (using standard SCIAEngineer selections) members that he/she wants to make either active or
inactive. In general, there are two approaches:

l selectedmembersare let active; all the othersbecome inactive,

l selectedmembersbecome inactive; all the othersare let active.

Making the selected members active
The procedure to adjust the activity according to selection – selected members become active

l Either call function Tools>Activity>Activitybyselection (SelectedmembersOn).

l Or clickbutton Activitybyselection (SelectedmembersOn) onActivity toolbar ( ).

Making the selected members inactive
The procedure to adjust the activity according to selection – selected members become inactive

l Either call function Tools>Activity>Activitybyselection (SelectedmembersOff).

l Or clickbutton Activitybyselection (SelectedmembersOff) on Activity toolbar ( ).

Adjusting the activity for ribbed plates
When the 'Activity according to selection' function is used for any type of ribbed plates or for plates composed of beams, it is
important to know that the parentmembers (plates) control the activityof the ribs (beams).

The following picture with a composite slab is an example of such situation. Even thought the beamsare selected, the result
would be that thewhole structurewould be set inactive:

- the columnsare not selected, so theywill become inactive,

- the slab itself isnot selected, so it will become inactive,

- the beams belong to the slab, so they will become inactive as well (even thought they are selected - but they are sub-
ordinate to the plate).
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Activity according to working plane
When this activity type is selected, the members located in the currently adjusted working plane become active. All other
membersbecome inactive.

For more detailsabout working plane see chapter Basicworking tools>working plane >Adjusting aworking plane.

The procedure to adjust the activity according to working plane

l Either call function Tools>Activity>Activitybyworking plane.

l Or clickbutton Activitybyworking plane onActivity toolbar ( ).

Activity according to clipping box
When this activity type is selected, the members located inside the currently adjusted clipping box become active. All other
membersbecome inactive.

For more detailsabout clipping boxsee chapter Advanced tools>Clipping box> Introduction to clipping box.

The procedure to adjust the activity according to clipping box

1. Activate the clipping boxand adjust it in requiredway.

2. Adjust the activity type to "byclipping box":

1. Either call function Tools>Activity>Activitybyclipping box.

2. Or clickbutton Activitybyclipping boxonActivity toolbar ( ).
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Activity by storyes
‘Storey activity’ is a tool that allows for visualising of the model entities based on storey allocation. Allocated members on a
(or multiple) storey(s) can be displayed and edited in theSciamodelling environment while all other entitiesare hidden.

This activity option is located on the ActivityToolbar and it contains three buttons– ‘Activity by storey,’ ‘Move activity by storey
up,’ ‘Move activitybystoreydown.’

There are threeways to use ‘Storeyactivity.’

The options linked to ‘Activity by storey’ define which type of activity is used – ‘Single storey activity,’ ‘Unallocated members’
or user-defined settings.

One storey activity
The user can onlyactivate a single storey. All storey levelsare available for selection via the combobox.

Unallocated members
Amodelmaycontainmembers that are not allocated to anystorey. There are also object typeswhich cannot be allocated to
any level at all (linegrids, a storey itself, etc.). Those itemscan be displayed by the option ‘Unallocatedmembers.’

Multiple levels together – Settings
The third option displaysselected levels together. This type can be created byuser.
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The user selects the active levels by checkboxes. All storeys can be activated and deactivated at once by the two buttons at
the bottom right corner of the dialogue.

The ‘Storey activity’ dialogue may contain more user-defined settings to address different needs. New settings can be
added by the button ‘New’on the toolbar. The namesof settingsare user-defined.

Move activity by storey up/down
The two additional buttonscan be used onlywhen the storeyactivity is selected.

The first onemoves the storeyactivity in the dialogue to the next one, the second to the previous.

Example:
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1. The initial setting – “basement+1” isactive, thus, onlyFL1 and FL2 are visible in the 3Dwindow.

2. User presses the “Move activitybystoreyup”.

3. Themodel is changed. Three levelsare now visible – FL1, FL2, and FL3. The active setting in the dialog is changed from
“basement+1” to “middle.”
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Inverting the activity
If required, the currentlyadjusted activitymaybe inverted so that:

l the currentlyactivemembersbecome inactive,

l the currently inactivemembersbecome active.

The procedure to invert the activity

l Either call function Tools>Activity> Invert current activity.

l Or clickbutton Invert current activityonActivity toolbar ( ).

Controlling the display style of inactive members
The user maydecidewhether themembers that are currently inactive should be partly visible or completelyhidden.

The procedure to display inactive members

l Either call function Tools>Activity>Draw inactivemembers.

l Or clickbuttonDraw inactivemembersonActivity toolbar ( ).

Note 1: When visible, the inactive members are drawn in a style defined for Inactive mem-
bers in Colours setup (see chapter Program settings > Project settings > Display style set-
tings>Colour setup).

Note 2: The function works like an ON / OFF switch. That means that if the inactive mem-
bers ARE NOT drawn, the function makes them appear. If the inactive members ARE
drawn, the function hides them.
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Clipping box
Introduction to clipping box
Clipping box isa verypowerful tool that facilitatesmanipulationmainlywith excessive structures. TheClipping boxdefinesan
area (3D-area) that is visible on the screen. The rest of the structure located behind the given area is temporarily hidden
from the user’s view.

Defining a new clipping box
The definition of a new clipping box is similar to the adjusting of the clipping box in the setting table.

The procedure for the definition of a new clipping box

1. On toolbar View clickbutton [Clipping box for active view] ( ) and select functionClipping box - new.

2. Define the origin (i.e. the centre) of the clipping box.

3. The setup dialogue appearson the screen.

4. Fill in the table.

5. Confirmwith button [OK].

Defining the clipping box around the working plane
Sometimes it maybe very useful to define the clipping box in such a wayso that only entities located in the working plane are
visible.

The procedure for attaching the clipping box to the working plane

1. On toolbar View clickbutton [Clipping box for active view] ( ) and select function Attach toworkplane.

2. The clipping box isadjusted accordingly.

Defining the clipping box around an entity
Sometimes it maybe veryuseful to define the clipping box in such awayso that only selected entitiesare visible.

The procedure for adjusting the clipping box around selected entities

1. On toolbar View clickbutton [Clipping box for active view] ( ) and select function Around selected entity.

2. The clipping box isadjusted accordingly.

Defining the clipping box around the model
Sometimes it maybe veryuseful to define the clipping box in such awayso that it "outscribes" thewholemodel.
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The procedure for adjusting the clipping box around the whole model

1. On toolbar View clickbutton [Clipping box for active view] ( ) and select function Around all entities.

2. The clipping box isadjusted accordingly.

Using the clipping box
The procedure to switch the clipping box ON or OFF

1. On toolbar View clickbutton [Clipping box for active view] ( ) and select functionClipping boxOn/Off.

2. The clipping box isactivated or switched off accordingly.

Example of clipping boxapplication

view
without
clipping
box

view
with clip-
ping
boxON
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view
with clip-
ping
boxON
after
being
zoomed
in

Adjusting the clipping box in the setting table
The procedure for tabular adjustment of the clipping box

1. On toolbar View clickbutton [Clipping box for active view] ( ) and select function Alphanumerical edit.

2. The setup dialogue appearson the screen.

3. Fill in the table.

4. Confirmwith button [OK].

Note 1: If the clipping boxwasnot displayed before the setup dialoguewas invoked, the clip-
ping box is switchedON on confirming the settingswith [OK] button.

Note 2 : If the clipping box is ON and has been defined around the current working plane,
the setting dialogue looksdifferent and allows the user to specify the depth around thework-
ing plane.

Adjusting the clipping box using the mouse
The procedure to adjust the clipping by mouse

1. Turn the clipping boxON.

2. Position themouse cursor over one of the clipping boxborders.

3. Click the left mouse button to select the clipping box.

4. Special box-editing symbolsare displayed in the centre of all clipping boxsurfaces. The ball symbol provides for resizing of
the box, the cylinder symbol enables the user to rotate the box.

5. Select corresponding symbol for requiredmanipulation.

6. Position themouse cursor over the symbol.
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7. Press the left mouse button and hold it down.

8. Drag themouse to adjust the clipping boxas required.

9. Release themouse button.

10. Repeat steps5 to 9 asmany timesas required to tune the adjustment of the box.

11. Press [Esc] key to close the adjustment function.

The alternative procedure for mouse controlled adjustment of the clipping box

1. On toolbar View clickbutton [Clipping box for active view] ( ) and select functionGraphical edit.

2. The clipping box is turnedON and swapped into the editingmode.

3. Follow the procedure described above.

4. Confirmwith button [OK].

Note: If the clipping box was not displayed before the graphical dialogue was invoked, the
clipping box is switchedON before enabling the adjusting.

Moving the clipping box
If required, the current clipping boxcan bemoved to a new location. The size of the clipping box remainsunchanged, only its
position in space isaltered.

The procedure for moving of the clipping box

1. If it is not the case, activate the clipping box (i.e. switch it on).

2. On toolbar View clickbutton [Clipping box for active view] ( ) and select functionMove.

3. Define the new origin (i.e. the centre) of the clipping box.

4. The clipping box ismoved accordingly.

Layers
Introduction to layers
One of the important entity properties that should be understood well is the layer property. Experienced users definitely use
layers all the time and that is why their work is so effective. Good use of layers is one of important aspects of a good model-
making-and-evaluating practice.

Basically, layers are the computer equivalent of tracing overlays on a drawing board. However, layers are much more
powerful because you can have many layers in a single project and you can control the visibility and colour of layers inde-
pendently. Thismakesworkingwith verycomplicated projectsmuchmore efficient.

When you start a new project, it has only one layer. The first thing you should do, therefore, when you start a new SCIA
Engineer project is to create some new layers.
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Layers manager
The Layers manager is a tool to control the layers defined in a project. The Layers manager provides for creating, editing
and deleting of layers.

The manager itself uses the same "manager philosophy" as other SCIA Engineer managers do. It contains control buttons
for standardmanager operations:

New It creates a new layer. The new layer is created with default properties thatmay be later edited.

Edit It opens an editing dialogue where the layer’s propertiesmay be changed.

Copy This function creates a copy of the selected layer.

Delete It removes the selected layer from the project database.

Undo / Redo It performs an Undo or Redo operation.

Text Output It opens a small document windowwith a table that summarises properties of selected layers.

In order to open the Layersmanager use either menu function Tools>Layersor treemenu function Tools>Layers.

The Layersmanager can also be opened from various property dialogues that contain item Layer. Such an item contains a
button to open the Layersmanager.

Displaying and hiding a layer
The Layersmanager also enables the user to specifywhich layersshould be visible andwhich onesshould be hidden.

Defining a new layer
Anew layer can be defined in the Layersmanager.
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The procedure to define a new layer

1. Open the Layersmanager.

2. Clickbutton [New] to create a new layer.

3. If required, clickbutton [Edit] to change the default layer parameters (name, colour, visibility).

4. If required, repeat steps2 and 3 asmany timesasyou need.

5. Close the Layersmanager.

Applying defined layers
A defined layer may be applied in the property dialogue of each particular entity. One of the table items contains the layer
name. This itemdefines the layer that the entity isput into.

Once the layer is specified in the property dialogue of an entity, the entity may be displayed or hidden according to the set-
tingsmade in the Layersmanager.

The picture above shows the selection of the appropriate layer for a 1Dmember.

Displaying and hiding a layer
One of the important features of a layer is that it can be hidden. Let’s assume that the user have finished modelling of one
part of the structure. Let’s suppose that now s/he needs to workon another part of the same structure and that the new part
is independent on the first part. The best s/he can do is hide the whole first part or at least itsmajor part. This can be done by
switching the appropriate layersoff. The new part of the structure then can bemodelled in new layers.

The layerscan be switchedOFF or ON (i.e. displayed or hidden) in the Layersmanager.
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The procedure for hiding (or displaying) a layer

1. Open the Layersmanager.

2. In the right hand side part of the dialogue is located a layer property table containing optionDisplay.

3. Select the layer or layersyouwant to display.

4. Tick the optionDisplay.

5. Select the layer or layersyouwant to hide.

6. Remove the tick from the optionDisplay.

7. If necessary, repeat the steps3 to 6 asmany timesas required.

8. Close the Layersmanager.

Ignoring selected layers in calculation
It may happen that a calculation model of a structure maybe quite simple. Simultaneously, the structure may contain a lot of
additional parts that have no load-bearing function but that are important for production of nice-looking and accurate draw-
ings.

Such a situation calls for using of special type of layers – layers used in structural model only and ignored in the calculation.
This featuremaybe adjusted in the Layersmanager.

The procedure for extracting the layer from calculation

1. Open the Layersmanager.

2. In the right hand side part of the dialogue is located a layer property table containing option structuralmodel only.

3. Select the layer or layersyouwant to ignore in calculation.

4. Tick the option Structuralmodel only.

5. Select the layer or layersyouwant to consider in calculation.

6. Remove the tick from the option Structuralmodel only.

7. If necessary, repeat the steps3 to 6 asmany timesas required.

8. Close the Layersmanager.

User co-ordinate system (UCS)
Introduction to a user co-ordinate system
The definition of pointsmaybe facilitated by the application of a user co-ordinate system. This system can be so defined (i.e.
positioned and oriented) that it reflects the geometryof themodel (or itspart) that isbeing defined.

The user can define asmanyuser co-ordinate systemsasnecessary. However, onlyone of themcan be active in one graph-
ical window at a time. Nevertheless, the user may swap between individual user co-ordinate systems at any time. What’s
more, even a new user co-ordinate systemmaybe defined any time it isnecessaryor efficient to do so.

The active user co-ordinate system is indicated on the programstatusbar.
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Adjusting a user co-ordinate system

UCS defined by three points
A new UCS can be defined bymeans of three points that do not lie on the same line. Each of the points has a precisely spe-
cifiedmeaning:

1st point It defines the origin of the new co-ordinate system.

2nd point It defines the direction of X-axis of the new co-ordinate system.

3rd point It defines the side to which the Y-axis of the new co-ordinate systemwill point.

Note: Please readRules for using aUCS.

Horizontal UCS defined by one point
A new co-ordinate system is defined by a single point. The point defines the origin of the new user co-ordinate system
(UCS). The axesof the user co-ordinate systemare parallelwith corresponding global co-ordinate axes.

Thatmeans that:

l the X-axisof theUCS isparallelwith the X-axisof the global co-ordinate system (GCS),

l the Y-axisof theUCS isparallelwith the Y-axisof theGCS,

l the Z-axisof theUCS isparallelwith the Z-axisof theGCS.

TheXYplane of thisuser co-ordinate system isalwayshorizontal.

Note: Please readRules for using aUCS.

Vertical UCS defined by two points
Anew co-ordinate system isdefined by two points (or one line).

The first inserted point defines the origin of the new co-ordinate system. The second point defines the direction of the X-axis
of the new system. However, the X-axis is not defined precisely by the second point. The X-axis is always horizontal, and
therefore, the second inserted point specifies the direction of the X-axis of the new user co-ordinate system. The Y-axis of
the new user co-ordinate system isalwaysvertical.

TheXYplane of thisuser co-ordinate system isalwaysverticalwith the Y-axispointing upwards.

Note 1: The two inserted pointsdefining the new systemMUST NOT lie on a vertical line.

Note 2: Please readRules for using aUCS.

Vertical UCS perpendicular to global X-axis
Anew user co-ordinate system isdefined bya single point. The point defines the origin of the new user co-ordinate system.
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The axesof the user co-ordinate systemare oriented in such awayso that:

l the X-axisof the user-coordinate system isalwayshorizontal,

l the Y-axisof the user-coordinate system isalwaysvertical,

l the XYplane of the user-coordinate system isperpendicular to the globalX-axis.

TheXYplane of thisuser co-ordinate system isalwaysverticalwith the Y-axispointing upwards.

Note: Please readRules for using aUCS.

Vertical UCS perpendicular to global Y-axis
Anew user co-ordinate system isdefined bya single point. The point defines the origin of the new user co-ordinate system.

The axesof the user co-ordinate systemare oriented in such awayso that:

l the X-axisof the user-coordinate system isalwayshorizontal,

l the Y-axisof the user-coordinate system isalwaysvertical,

l the XYplane of the user-coordinate system isperpendicular to the globalY-axis.

TheXYplane of thisuser co-ordinate system isalwaysverticalwith the Y-axispointing upwards.

Note: Please readRules for using aUCS.

UCS identical with the global co-ordinate system
Anew user co-ordinate system is identicalwith the global co-ordinate system.

Note: Please readRules for using aUCS.

UCS perpendicular to the current UCS's X-axis
Anew user co-ordinate system (UCS) isdefined according the following rules:

l the X-axisof the newUCS isput into theY-axisof the current UCS,

l the Y-axisof the newUCS isput into the Z-axisof the current UCS.

Note: Please readRules for using aUCS.

UCS perpendicular to the current UCS's Y-axis
Anew user co-ordinate system (UCS) isdefined according the following rules:

l the X-axisof the newUCS remainsunchanged,

l the Y-axisof the newUCS isput into the Z-axisof the current UCS.
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Note: Please readRules for using aUCS.

UCS defined according to an entity's LCS
Anew user co-ordinate system isdefined bymeansof an existing entity (e.g. beam).

The new user co-ordinate system has got its origin in the starting point of the selected entity. The axes of the user co-ordin-
ate systemare identicalwith the local co-ordinate axesof the selected entity.

Note: Please readRules for using aUCS.

UCS defined from a view direction
Anew user co-ordinate system is calculated from the current view direction. In other words, the X-axis of the new co-ordin-
ate system appears horizontal on the screen, the Y-axis of the new co-ordinate system appears vertical on the screen, and
the Z-axisof the new co-ordinate systempoints towards the user’seyes.

Note: Please readRules for using aUCS.

Editing a user co-ordinate system

UCS Manager
The UCSmanager gives the user full control over the existing user co-ordinate systems. Similarly to other database man-
agers, it provides for the definition of a new UCS, for the modification or copying of existing systems, and for removal of no-
longer-used co-ordinate systems.
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Association of the active graphical windowwith a particular UCS
The UCS manager is also used to select a particular UCS and associate it with (assign it to) the active graphical window.
TheUCS that is selected (highlighted) in the list of definedUCSsbecomes the one associatedwith the graphicalwindow.

The procedure for the selection of UCS for the active graphical window

1. Open theUCSmanager:

1. in treemenu call function Tools>UCS,

2. on statusbar clickbutton showing the nameof UCSassociatedwith the active graphicalwindow.

2. Select theUCS that should be assigned to the active graphicalwindow.

3. Close theUCSmanager.

Modifying an existing UCS
An existing user co-ordinate systemmaybe edited and thus its origin or direction of axesor bothmaybe altered. In general,
there are twoways tomodifyan existingUCS:

l type valuesof UCSparameters into the editing dialogue of theUCS,

l apply one of manymodifying functions collected in submenu UCS (opened either frommenu Tools >UCS, or under but-

ton [Setting of UCS for active view] ( ) on toolbar View) (see chapter Adjusting a user co-ordinate system).
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The procedure for direct editing of UCS parameters

1. Open theUCSmanager.

2. Select theUCSyouwant tomodify.

3. Clickbutton [Edit] to adjust parametersof the newUCS.

4. Type in the required values for the origin of theUCSand for direction of itsaxes.

5. Close the editing dialogue.

6. Close theUCSmanager.

The procedure for the modification of a UCS by means of UCS submenu functions

1. If it is not the case that theUCSyouwant tomodify is the current (active) one,make it current first.

2. Open submenu UCS (either in menu Tools > UCS, or under button [Setting of UCS for active view] ( ) on toolbar
View).

3. Select the requiredwayofmodification.

4. If necessary, input required parameters (i.e. required point or points).

5. TheUCShasbeenmodified and isnow kept as the current UCS.

6. Open submenu UCS (either in menu Tools > UCS, or under button [Setting of UCS for active view] ( ) on toolbar
View).

7. Select function Store the current UCS ( ).

8. Select the nameof theUCS that hasbeenmodified and rewrite it with the new adjustment.

Defining a new UCS
UCS manager
TheUCSmanager can be used to define completely a new user co-ordinate system if the user knowsnumerically the para-
meters of the system. That means, if the user knows the exact global co-ordinates of the UCS’s origin and the exact dir-
ection vectors of individual UCS’s axes. Otherwise, the UCS manager is used to create a new UCS instance, and one of
numerousUCS-modifying functions is later applied to specify the origin and orientation of theUCSexes.

The procedure for the definition of a new UCS from within the UCS manager

1. Open theUCSmanager.

2. Clickbutton [New]. This createsa copyof the current UCS.

3. Clickbutton [Edit] to adjust parametersof the newUCS.

4. Type in the required values for the origin of theUCSand for direction of itsaxes.

5. Close the editing dialogue.

6. Close theUCSmanager.
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The procedure for the definition of a new UCS parameters using a menu/toolbar function

1. Open submenu UCS (either in menu Tools > UCS, or under button [Setting of UCS for active view] ( ) on toolbar
View).

2. Select the requiredwayof definition.

3. If necessary, input required parameters (i.e. required point or points).

4. Once more open submenu UCS (either in menu Tools > UCS, or under button [Setting of UCS for active view] ( )
on toolbar View).

5. Select function Store the current UCS ( ).

6. Type the nameof theUCSand confirmwith [OK].

7. That’s it. A newUCS isdefined andwill appear in theUCSmanager.

Copying an existing UCS
Anyof alreadydefinedUCSsmaybe copied. The copymaybe further modified to define a new unique user co-ordinate sys-
tem.

The procedure to make a copy of an existing UCS

1. Open theUCSmanager.

2. Select theUCSyouwant to copy.

3. Clickbutton [Copy] to create a newUCS that is identical in itsparameterswith the selected one.

4. If required, click button [Edit] to adjust parameters of the new UCSand type the required values for the origin of the UCS
and for direction of itsaxes. Then close the editing dialogue.

5. If required, repeat steps2 to 4 asmany timesasnecessary.

6. Close theUCSmanager.

Moving an existing UCS
An existing UCS can be moved to a new origin. The orientation of the system remains unchanged, only the UCS’s origin
moves to a new position.

The procedure to move a UCS to a new origin

1. If it is not the case that theUCSyouwant tomove is the active one,make it active first.

2. Callmenu function Tools >UCS>Move (Youmayaswell activate toolbar function Setting of UCS for active view >Move
from toolbar View).

3. Define the new origin of theUCS.

Note: Please readRules for using aUCS.

- 281 -

javascript:RelatedTopic0.Click()


Chapter 5

Rotating an existing UCS
An existing UCS can be rotated by a specified angle. The origin of the system remains unchanged, only the direction of
UCS’s axes changes accordingly. The rotation is performed in the adjusted working plane, i.e. the axis of rotation is normal
to the current working plane.

The procedure to rotate a UCS

1. If it is not the case that theUCSyouwant tomove is the active one,make it active first.

2. Make sure that the working plane is adjusted properly, i.e. that it is oriented in such a way that a normal to the working
plane isparallelwith the axisof intended rotation.

3. Call menu function Tools > UCS > Rotate (You may as well activate toolbar function Setting of UCS for active view>
Rotate from toolbar View).

4. Type the angle bywhich theUCSshould be rotated.

5. Close the dialogue.

Note: Please readRules for using aUCS.

Deleting an existing UCS
It mayhappen that some of the previously user co-ordinate systemsare no longer necessary, or even that some of the user
co-ordinate systemshave been defined bymistake. Such user co-ordinate systemsmaybe removed from the project.

The procedure to delete an existing UCS

1. Open theUCSmanager.

2. Select theUCSyouwant to delete.

3. Clickbutton [Delete].

4. If required, repeat steps2 and 3 asmany timesasnecessary.

5. Close theUCSmanager.

Storing the user co-ordinate system
AnyUCS created by the user may be stored as a named UCS. The user can specify the name and once stored, the UCS is
listed in theUCSmanager.

The procedure to store the UCS as named UCS

1. Adjust theUCSas required.

2. Callmenu function Tools>UCS>Store the current UCS (Youmayaswell activate toolbar function Setting of UCS for act-
ive view >Store the current UCS from toolbar View).

3. Input the required name.
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Using a user co-ordinate system

Rules for using a UCS
There are some rulesconcerning the use of user co-ordinate system that should be clearly stated here in order to prevent a
possible confusion.

UCS in windows
Each graphical window can have a different UCS. The UCS can be assigned to a particular window from the UCS man-
ager.

The procedure for association of a particular graphical windowwith a particular UCS

1. Select the graphicalwindow you need to associatewith the requiredUCS.

2. Open theUCSmanager.

3. Select the requiredUCS.

4. Close theUCSmanager.

Modification of an existing UCS in the UCS manager
If a UCS isedited in theUCSmanager (i.e. edited numerically), the changesaremade to theUCS that isbeing edited.

Modification of an existing UCS by means of modification functions
If a current UCS assigned to a particular window is edited by means of a function for modification of UCS, IT IS
IMPORTANT TO KNOWthat:

l Before themodification itself, thewindow isassociatedwith the default (called current) UCS.

l Themodification ismadewith the current UCS.

l The current UCS is let associatedwith thewindow.

If a named user-created UCS was associated with the window before the modification has been performed, that UCS
remainsunchanged.

If a named user-createdUCSshould bemodified usingmodification functions, the following proceduremust be executed.

The procedure for modification of a named user-created UCS

1. Usemodification function or functions to define theUCSas required.

2. Call function for storing of the current UCS.

3. Rewrite the original named user-createdUCSwith the newlydefined one.

Using a UCS in the graphical window
The origin of the current user co-ordinate system is always displayed in the graphical window. Also directions of individual
co-ordinate systemaxesare shown.

If the program is in point definition mode or point selectionmode, the co-ordinates of themouse cursor are displayed on the
programstatusbas. The co-ordinatesare given in user co-ordinate system.

- 283 -



Chapter 5

Note: If required, the co-ordinates of position of themouse cursor mayalso be displayed in
the global co-ordinates.

Using a UCS from the command line
If co-ordinates of an inserted point are typed on the command line without any prefix, the co-ordinates are considered to be
in the current UCS. For more information about the syntax of the command line see chapter Command line in book Layout
and operation >User interface.

Working plane
Introduction to a working plane
A working plane is a plane in which the mouse cursor moves in the three-dimensional modelling space. The working plane
can be adjusted arbitrarily to reflect the current needs of the user. The working plane is always placed into one of the basic
planesof a user co-ordinate system (UCS). It means that theworking plane isverycloselybound toUCS.

Adjusting a working plane
A working plane can be adjusted in any direction. There is only one limitation. A working plane is always bound to the cur-
rently set user co-ordinate system. The working planemaybe oriented in one of themain planesof this co-ordinate system,
i.e. into XY, XZ or YZ plane.

Therefore, in order to adjust the working plane into the required direction, the user mayneed to adjust the user co-ordinate
system first.

The procedure to adjust the working plane into the required UCS main plane

1. Verify that the current UCS isdefined as required.

2. Adjust theworking plane into XYor YZ or XZ plane of theUCS:

1. Either using toolbar View and itsbutton [Setting of UCS for active view] ( ),

2. Or calling function Tools>UCS,

3. In both cases, select one of the following items: XYworkplane, YZ workplane, or XZ workplane.

Cursor SNAP modes
Introduction to SNAP modes
Whenever the user needs to define a new point (e.g. an end-point of a new 1Dmember), it is possible to do so by typing the
point co-ordinates on the command line. It is clear that this approach will not be always the most efficient one. Very often, a
new point is identical with one of the already defined points (e.g. individual 1D members are connected to each other).
What’smore, the geometry of the structure is usually regular in some way, and therefore, end-points of individual entities fit
into a regular scheme. Both of these factshave been taken into account during the design of SCIAEngineer’sSNAPmodes.

A SNAP mode is a mode for locking a mouse cursor into alignment with an invisible rectangular grid or with characteristic
pointsof alreadydefined entities (such as their end-points, middle points, centresof circles, etc.).
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When the SNAPmode is on, the screen crosshairs and all input coordinates are snapped to the nearest point on the grid or
to the nearest characteristicpoint.

Grid SNAP modes
The grid SNAPmode is a SNAPmode where the mouse cursor is locked into alignment with a grid. SCIA Engineer offers
two typesof grid:

l a dot grid (thatmaybe either orthogonal or radial),

l a line grid (thatmaybe both two- and three-dimensional).

When thisSNAPmode ison, the screen crosshairsand all input coordinatesare snapped to the nearest point of the grid.

The grid SNAPmode can be combinedwith the object SNAPmode if required.

The activation of the grid SNAPmode can be done in theCursor snap setting dialogue.

Object SNAP modes
The object SNAPmode isa SNAPmodewhere themouse cursor is locked to commonlyneeded points, or we can saychar-
acteristicpoints, on entities (such as their end-points, middle points, centresof circles, etc.).

If required, the object SNAPmode can be combinedwith the grid SNAPmode.

A required kind of the object SNAPmode can be selected (activated) in theCursor snap setting dialogue.

The picture above shows "in action" the SNAPmode set toMidpoints.

Adjusting a SNAP mode
Adjustment of the required SNAPmode or modes can be done in the Cursor snap setting dialogue Default keyboard short-
cut is set to F6.
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The dialogue offersa vide range of SNAPvariants:

Line grid The cursor is locked to the vertices of a defined line grid.

Dot grid The cursor is locked to the points of a defined dot grid.

Only
snapped
points

If this option is ON, the first two variants are automatically turned OFF and only characteristic points of
already defined entitiesmay be used to snap to. In other words, only the object SNAP mode is enabled.

Midpoints Middle points of entities are used as snap points.

Endpoints /
Nodes

End points of entities are used as snap points.

Intersections Intersections of entities are used as snap points.

Orthogonal
points

This option snaps to a point which forms a perpendicular with the selected object.

Tangential
points

The Tangential point SNAP mode snaps to a tangent point on a circle.

Arc / circle
centre

This option snaps to the centre of a circle, arc or polyline arc segment. The cursor must pass over the cir-
cumference of the circle or the arc so that the centre can be found.

Points on
line / curve -
length

The program automatically "creates" SNAP points in the defined distance from the beginning and/or end
of the line/curve.

Points on
line / curve
N-th

The program automatically divides a selected entity into N segments and thus generates (N+1) points on
an entity under cursor. The pointsmay be used to snap to.

Points in
line / curve

This option is similar to the one above. But the division of a 1D member is defined by percents and not by
the number of segments.
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% of length

Surface
edges

This option is available only if at least one of the above listed object SNAP modes is ON.

If this option is ON, the mouse cursor snaps also to the surface lines of entities.

General
solids

This option snaps to characteristics points of general solids.

The number defines the number of characteristic points that are generated for the SNAP purposes. The
number-parameter is useful especially if there are complex solids in the model. Such solids can have a
huge number of characteristic points. If all of them were offered for snapping, the scene in the graphical
window would be unclear. Therefore, the parameter can be used to limit the number of offered snapping
points.

The procedure for the adjustment of the required SNAP mode:

1. Open theDot grid setting dialogue. The dialogue can be opened in twoways:

1. via [Snapmode] button on theStatusbar,

2. via [Cursor snap setting] button ( ) on the toolbar at the command line.

3. usingmenu function Tools>Cursor snap setting.

2. Select the required SNAPoption or options.

3. Pressbutton [OK] to close the dialogue.

Adjusting the temporary one-step SNAP mode
Sometimes it may be useful to let the current SNAPmode AS IS, and change the SNAPmode just and only for a single step
(single action). For example, all new end-points of a set of 1D members are defined as end-points of existing entities, but
suddenly it mayhappen that one particular point would be easilydefined asamidpoint.

In SCIAEngineer the user maychange theSNAPmode temporarily for a single step only.

The procedure for the adjustment of a temporary SNAP mode

1. Once a function requiring the definition of points is started a toolbar isdisplayed at the top of the command line.

2. Proceedwith the opened function up to themoment you need to change temporarily the SNAPmode.

3. Click the required icon on thementioned toolbar.

4. TheSNAPmode is temporarily re-adjusted for the following single step.

5. Once you define the point, the SNAPmodes returns to the original setting.

Tracking
Introduction to tracking
The tracking is a tool for easier modeling in the 3D window. It helps user to define directions and distances by tracking rays
and tracking points.
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Tracking uses already defined nodes and its coordinates in the project. The new node overtakes coordinate from the ori-
ginal one. It ispossible to overtakemore coordinates, e.g. X coordinate fromnodeAandYcoordinate fromnodeB.

The distance fromone point to another can be defined byvalue in the command line.

Tracking options allows adding user defined angles for tracking rays. This can be convenient for structures which are not
perpendicular.

The organizing of the project ismuchmore clearer, easier and proper.

See the videotutorialsonweb:

1) Tracking ray: http://campaigns.nemetschek-scia.com/scia-movies/movies/model/tracking_insert.htm

2) Tracking line: http://campaigns.nemetschek-scia.com/scia-movies/movies/model/tracking_point+line.htm

Tracking options
The tracking is switchedON andOFF bya button on the bottomwindow toolbar.

The settingsare in the dialogueDot grid and tracking settings.

The dialogue consist from two parts.
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1. The list of user defined angels for tracking rays
2. Settings for tracking lines

User defined angles
The default angles are according to the global coordinate system. When user needs more, the additional angles can be
inputted to the tracking settings.

Settings for tracking lines
The second part of the dialogue contains settings for the tracking lines. The first checkbox defines if the tracking lines are
used - Snap to lines. The second checkboxdefines the position of the start point for tracking on the line.
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See the separate chapter to learn how to switch the common geometry to the tracking line.
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Unchecked Revert lines
The start point of the tracking line is defined during the switching the tracking line on. The node closer to the cursor move-
ment isused asa start point.When the second checkbox in the dialogue isunchecked, it works thisway .

1 - begin node of the line
2 - end node of the line
The begin node isset asa start point and distancesare calculated from it.

Checked Revert lines
The start point isdefined during the switching again, but this time the farther node isset as the start point.

1 - begin node of the line
2 - end node of the line
The end node isset asa start point and distancesare calculated from it.
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Tracking tools

Tracking point
The point is displayed by a light blue rectangle. The last inserted point is automatically switched to the tracking point. Other
tracking pointsare user defined. It can be switched snapping point or tracking point placed anywhere byuser.

There isno geometry (or add data) createdwhen user creates the tracking point, it is only an assistant point. It helps to track
another position.

There are two typesof tracking points:

1. The first with the crossed blue rectangle is the last inserted point in the project and it cannot be disabled. It is the default
point for creating the nextmember.

2. The second point isuser defined. It can be disabled. User creates it from the snapping point or it is inserted asuser
defined tracking point anywhere in the project.

The tracking pointsare automaticallydeactivatedwhen the actual command is finished or canceled.

The active tracking point isdisplayed by thicker rectangle. It is the tracking point fromwhich the tracking ray isdisplayed.

The tracking points can be inputtedmore times to the project.

How to disable the tracking point - see the separate chapter.

Switched tracking point
The snapping point is displayed by moving the cursor over the point, it is displayed by the red rectangle. This point is
switched to the tracking point bymoving the cursor over the snapping point and holding theSHIFT key.

No clicking isneeded.
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The tracking points can be created on all typesof snapping points.

The displaying of the snapping pointsdependson its settings.

User defined tracking point
The user defined tracking point can be inserted anywhere in the project . This point is created byholding the SHIFT keyand
clicking to itsposition.

Tracking ray
This is the dot linewhich isdisplayed from the active tracking point.

The directions are according to the global coordinate and according to the user defined angles. When the tracking line cor-
responds to the coordinate direction, it has the same colour. If user defined angle is used, the tracking ray is displayed by the
yellow colour.

The cursor isautomatically snapped to the rayso it iseasy tomove on it.
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Tracking line
This toolworkswith already inserted linesand polygons in the project (center line, edge, 3D line).

It is similar to the tracking ray. It doesn't display the dot line, but it marks geometry as a tracking line. The colour of the track-
ing line is light blue (the same colour as we have for the tracking point). The major difference is, that tracking ray doesn't
have the begin and end node but the tracking line has it because it is limited by the used geometry.

Start point on tracking line
The start point on the tracking line is displayed as a blue circle. It is begin or end node of the line - it is controlled by the track-
ing settings.
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Disable switched tracking point or tracking line
The tracking point (line) can be disabled bymoving the cursor over the tracking point with holding SHIFT +CTRL key.

The original snapping point or line isdisplayed again.

Intersection point
The intersection of two tracking rays (or the tracking line and ray) isdisplayed bya small circle. Thispoint isexact intersection
and user can snap to it.

Between two tracking rays:
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Between the tracking rayand tracking line:

Using grid step on tracking ray and line
The settings for dot grid can be used on tracking raysand lines.

The snap to the dot gridmust be switchedON.

The step is taken from the Dot grid and tracking setting. The cursor is snapped to stepson the tracking rayand tracking line.
The start tracking point isalways taken aszero and itsposition hasno influence on the steps.

Tooltip
The tooltip contains all information about the cursor position and distance from the start point. It also displays information
about intersection point. Colourscorrespond to the global axisdirections.
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Tooltip on the tracking ray - there isa green part which displays the distance from the start
point in the Ydirection. The start point is the first structural node in this case.

Tooltip on the tracking line - there isa light blue part which displays the distance from the
start point. The start point isa begin node on the line in this case.

Tooltip for the tracking intersection point - there are two values, one green and one red. It
displaysdistancesof the cursor from the start pointson both rays.

User defined distance
The value typed to the command line is taken asa distance from the start point. Thisoption can be used on tracking raysand
tracking lines.The structural node iscreated after the confirmation the value byENTER key.

There are two conditionwhichmust be fulfilled:

1. The tracking rayor tracking linemust be displayed
2. The cursor shows the correct direction for the typed distance

The picture shows the typical situation:
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1 - the starting point for the typed distance
2 - the position of a new structure node (after the confirmation of the distance)
3 - the user defined direction

Process:

a) The tracking line isdisplayed and the start point is set to the begin node of themember.
b) User wants to place a new structural node 1,5m from the start point.
c) The cursor is placed on the line to show the direction and user types 1,5 to the command line. The value is
confirmed byENTER .
d) The new node is inserted 1,5m from the begin node.

Tracking shortcuts summary
SHIFT - inserting the user defined tracking point

CTRL - switch the geometrical line to the tracking line

SHIFT+CTRL - disable tracking point or line

Ortho functionality
The ortho isa simple functionalitywhich allowsuser tomover the cursor only in an orthogonal system.

The ortho is switchedON andOFF by the button on the bottomwindow toolbar.
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This functionalityworks only in the working plane and directions are always according to the global coordinate system. User
can’t use points, raysand linesas in the tracking. User defined distancesaren't supported.

How to use tracking mode to insert a new structure
Create a simple structure using trackingmode:

Buildingwith 2 floorsand one inclinedwall on the second floor.

Introduction to basic tracking tools - point, line, intersection:
Tracking point - point which isa starting point for a tracking rays
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Tracking line - geometry line or polylinewhich can be used in the samewayas tracking ray

Tracking intersection - isa point where one raycross the other ray

Start with a new empty project:

1. Open a new emptyproject with concrete. Tracking is controlled by the button on the bottomof the 3Dwindow. Switch it

on.

2. The tracking settings for isunder “Dot grid and tracking settings".
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3. We need to set one angle of rays. Open dialogue “Dot grid and tracking settings” and use button – “Setup for tracking…”.
We use the tracking raywith thisangle for inserting inclinedwall on the second floor.

4. Add a new angle 30°.Write the value to the row and use the button "Add". Check if the checkbox for “Snap to lines” isact-
ive.

Modeling

1. Create the first level of our building onworking plane.Wewill create 4walls, 1 plate and someopenings. Activate the dot-
grid snapping to define the size by the simplest way.

2. It ispossible to snap to the dotgrid and also see the distance in the tooltip.

3. The 1st wall starts in point 0,0,0. The length is5m. The tracking tooltip shows the distance

.
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4. Create the 2ndwall fromend point of the 1st wall. Length of the 2ndwall is6m. See the next picture.

5. We use a new type of intersection tracking point to create the 3rdwall. The length of the 3rdwall is5m.

How to create the tracking intersection point:

a. Insert 1st point of the 3rdwall.
b. Move over the node in 0,0,0 and hold SHIFT. Thisnode isautomaticallymarkedwith theblue rectangle.
c. Thispoint nowworksas tracking point – it means that we can use rays from thispoint. Nowwe have two pointswith rays.
d. Intersection point ison the intersection of those two rays. New intersection point isautomaticallymarkedwith little circle.
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5. Insert a plate onwalls. Create some openings in thewalls.
6. Use tracking raysduring the creating openings. Sizesare defined by the dotgrid.
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7. The second floor isdefined by5wallsandwe use rayunder 30 °angle to create the 3thwall as inclinedwall.
8. The 1st wall has the same size aswall under it.

9. The 2ndwall has thethe same size as thewall under it. The 3rdwall is shorter – the length isonly4m.
10. Create the 4thwall using the tracking rayunder angle 30°. Start from the end point of the 3rdwall and use the user-

defined tracking point on the starting point of the 1st wall. The intersection point is created by rayunder 30°and the ray
from the new tracking point on the left corner. See the picture.
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11. Create some opening on the second floor.
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Create a roof using user-defined length in the command line.

12. Weuse command line (prompt) to define atticheight.
13. Start a command for inserting a new plate but don't create anypoint.
14. Set a new user-defined tracking point on the top node.

15. Move the cursor on the raydownwards to define the correct direction.Write 0,3 to the command line (just write 0,3 on key-
board, the value isautomatically inputted to the command line) and pressEnter. The first inserting point of the plate is cre-
ated.
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16. Move the cursor on the ray from last point next corner – see the picture.
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17. Define the edge of thewall asa tracking curve.Move cursor over the edge and holdCRTL. Curve isautomaticallyhigh-
lighted by the blue color.

18. There isan tracking intersection point on the tracking curve and the tracking ray.
19. Use the sameapproach for creating thewhole roof – using tracking lineson edgesand tracking rays from the last inser-

ted points.
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The final structure is in the project "final_track.esa".

Dot grid
Introduction to a dot grid
A dot grid is an area in the graphical window covered with regularly spaced dots to aid drawing. The spacing between grid
dots isadjustable. The grid dotsare not plotted.

The dot grid is always put into the current working plane, so that it can be used for the definition of points (e.g. end points of
individualmembers) bymeansofmouse.

Properlyadjusted dot gridmaysignificantly speed up the processof geometrydefinition.

SCIAEngineer offers two typesof the grid: orthogonal and radial.

Adjusting dot grid parameters
The dot grid can be adjusted to meet the needs of a particular project. Sometimes, it may be good idea to re-adjust the grid
settings from time to time, especially if the geometry of the whole structure is not regular and varies from one part to
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another.

The procedure to adjust dot grid parameters

1. Open theDot grid setting dialogue:

1. Either using toolbar View and itsbutton [Setting of the dot grid] ( ),

2. Or viamenu function Tools>Dot grid settings

2. Select the required type of the grid: orthogonal or radial

3. Type in the parametersof the grid (the individual parametersare self-explicable).

4. Close the dialogue.

7. The adjusted grid will be displayed on the screen unless it is switched off.

Using the dot grid
The dot gridmaybe used to insert points if the following conditionsaremet:

l the dot grid is switched on (i.e. it is displayed),

l the snapmode isadjusted to stick to the grid points,

l the program is in the point definitionmode.

To be precise, the first condition doesnot have to be fulfilled and the dot grid may still be used. But as the dots of the grid are
not visible, it is not recommended to use this configuration (unless you are a really advanced and skilful user of SCIA Engin-
eer).

Displaying the dot grid
The dot gridmaybe switched on and off usingmenu function View >View >Show / hide dot grid.
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Setting the snap mode to use the dot grid
The capability of the snap mode to stick to the dot grid can be set in two different dialogues. The result is the same regard-
lessof which dialogue isused.

Setting in Snapmode dialogue

1. Open theCursor snap setting dialogue.

2. Tick the optionDot grid on or off (as required).

3. Close the dialogue.

Setting in Dot grid settings dialogue

1. OpenDot grid setting dialogue.

2. Tickoption Snap cursor to dot grid on or off (as required)

3. Close the dialogue

Line grid
Introduction to a line grid
A line grid is a kind of a three dimensional grid. Individual vertices of the grid can be used to define points of the modelled
structure.

One can imagine the line grid as a set of wire cubes placed one next to another to create a larger wire cube. The vertices of
individual small wire cubes are the vertices of the line grid. What’s more, the cubesmay be not only regular cubes, but also
other solids like a tetrahedron, irregular hexahedron, etc. The grid may be of either regular or irregular (variable) dimen-
sions in anydirection.

The tool is extremely useful for the definition of complex 3D structures on condition that at least some parts of the structure
are regular (i.e. of the same spansor of the same height).

Types of line grid
A line gridmaybe of several types. Each typemaybe useful for different "configuration" of the geometryof amodelled struc-
ture.

Cartesian
This line grid represents the basic type. The vertices of the grid are defined in Cartesian co-ordinates and
the grid as a whole resembles a regular rectangular prism.
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Oblique

This type is based on the previous one. In addition, the user may define two angles that make the grid
oblique.

Spherical

Vertices of this grid type are defined bymeans of spherical co-ordinates.
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Cylindrical

Vertices of this grid of this type are defined bymeans of cylindrical co-ordinates.

Line grid manager
The Line grid manager provides for operations related to line grids. It can be used to create a new line grid, to switch the
existing line gridson or off, tomodifyan existing grid, to copy it or delete it.

Themanager isoperated the samewayasanyother SCIAEngineer databasemanager.

To open the Line gridmanager clickbutton [Line gridmanager] onView toolbar.

Creating a new line grid
Similarly to a great number of other "objects" in SCIA Engineer, a new line grid can be created in the appropriate database
manager. The Line gridmanager hasbeen designed to create and edit line grids

The procedure to create a new line grid

1. Open service Line grid and storeys.

2. Select function 3D line grid..

3. The editing dialogue isopened.

4. Specifygrid dimensions.

5. Adjust itsdisplayparameters.

6. Close the editing dialogue.

Note: If no line grid hasbeen defined in the current project so far, step 1 leadsdirectly to opening of the editing dialogue. Asa
result, step 2 isautomatically skipped.

Adjusting line grid parameters
Each line grid isdefined bymeansof:
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l dimensions in individual directions,

l location of itsorigin (i.e. the insertion point),

l possible rotation,

l anglesof obliqueness (for oblique line grid only),

l name,

l parametersof itsdisplaystyle.

Line grid type
The combo boxat the bottompart of the dialogue selects the required grid type.

Line grid dimensions
Depending on the grid type, the dimensionsare defined inCartesian, spherical, or cylindrical co-ordinates.

There are twoways to define the individual "spans" and "storeyheights":

l the user inputs the dimensionsof individual "spans" and "storeyheights",

l the user inputs the co-ordinates of individual line grid vertices (i.e. co-ordinates of end-points for individual "spans" and
"storeys").

The approaches are independent for each direction. In other words, the user can specify the dimension of the grid in X and
Y direction by means of "span" lengths and then use grid absolute co-ordinates for the definition of individual "storeys" (in
the case of Cartesian type) or vice versa. Which approach will be used can be set in the combo box located above the table
for each particular direction.

Another general rule is that:

l either each "span" and each " storey" of the line grid isdefined explicitly,

l or a "span" or "storey" dimension is input only once and the number of repetition of this dimension is added (if "spans" or
"storeys" of the same dimension are adjacent to each other).

The latter can be user for grid with repetitious "spans" andmaysignificantly speed up the definition of the grid.

Insertion point and rotation
Thispoint defines the location of the grid in the global co-ordinate system.

If required, thewhole line gridmaybe rotated around the globalZ-axis.

Name
The name serves for easy identification of individual line grids if more than one grid are defined.

Parameters of display style
The user can control theway the line grid isdisplayed on the screen.

Adjusting the display style of line grid
The user can easily control the appearance of the grid on the screen bymeans of a few parameters. The parameters are
grouped on theDrawing setup tab of the line grid editing dialogue.
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Base plane This parameter specifies which plane is the base plane for the labelling system of the grid.

Lines between
planes

Connecting lines may be or may be not drawn between individual grid layers (i.e. "floors" or
"spans" depending on the base plane).

Label format The user can control the format of the labels.

Visibility of grid lay-
ers

Individual grid layers (i.e. "floors" or "spans" depending on the base plane of the grid) may be vis-
ible or hidden.

Labelling of grid lay-
ers

Individual grid layersmay be labelled.

Dimensioning of
grid layers

Dimension linesmay be added to individual grid layers.

Base plane
The base plane defines the plane where themain grid labelswill be located. The user can select from the three base planes
oriented in the threemain planesof the global co-ordinate system (XYplane, YZ, plane, XZ plane).

Lines between planes
The individual grid layers (e.g. "floors" in case of XY base plane) may be graphically connected to each other or may be
drawn as separate layers. If the lines are drawn, the final line grid looks like a three dimensional solid. If the lines are not
drawn, the final grid resemblesof a set of sheetsput one above the other.

Label format
The user mayadjust the format of the labels. The following parameterscan be specified:

l position of labels,

l offset of labels,

l text size,

l a circle drawn around labels.

Visibility of grid layers
Each layer can be separately set asvisible or hidden. Thismaybe veryuseful especially for large and complex line grids.

Labelling of grid layers
Labelsare added to individual layersaccording to the user’s settings. There are two typesof labels:

l labels for individual "spans" in a grid layer,

l labels for thewhole grid layer.

Each of the types is controlled bya separate parameter.

Dimensioning of grid layers
The individual grid layersmaybe equippedwith dimension lines. The dimension linesmaydimension:

l either individual spans in individual directions,

l or the total dimension in individual directions.

Displaying and hiding a line grid
A line grid can be switched on / off (in other wordsdisplayed / hidden or activated /deactivated) in the Line gridmanager. It is
possible to switch on asmanydifferent line gridsas required.
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The procedure for switching a line grid on / off

1. Open the Line gridmanager.

2. In the list of defined line gridsselect the line grid youwant to switch on or off.

3. In the grid property table tick option Visible in order to switch the grid on, or remove the tick from this option to hide the
grid.

4. Repeat points2 and 3 asmany timesas required.

5. Close the Line gridmanager.

Using a line grid
In order to use a previouslydefined line grid, two conditionsmust bemet:

l at least one line gridmust be switched on,

l the SNAPmodemust be set to pickpointsof line grid.

Once the two conditions are met, the vertices of the displayed line grids may be used to define points. When the mouse
cursor is positioned on a line grid point (vertex), the program automatically detects it, snaps to it and shows its co-ordinates.
If the user wants to use the highlighted point, the only thing he/she have to do isclick the left mouse button.

The picture above shows the use of line grid for the insertion of columnsduring creation of amodel of a hall.

Editing an existing line grid
Theway to edit parametersof an alreadydefined line grid is verystraightforward and simple.
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The procedure to edit an existing line grid

1. Open the Line gridmanager.

2. Select the grid youwant tomodify.

3. Clickbutton [Edit] to open the editing dialogue.

4. Change the required parameterson the Input data tab.

5. Change the required parameterson theDrawing setup tab.

6. Close the editing dialogue.

7. Close the Line gridmanager.

If a defined line grid isno longer needed it maybe deleted. The Line gridmanager’sbutton [Delete] can be used for thisoper-
ation.

2D Linegrid
2D linegrid
2D linegrid isa tool for simple orientation in the project. It is located in the service Line grid and storey.

There are three different typesof 2D linegrid: Free line, Rectangular andCircular.

2D linegrid isa object similar to the 3D linegrid.
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2D linegrid isalways inserted toGCSof project. It can be displayed higher onlybystoreysview parameterssettings.

Overall settings
Linegrids are non-editable in the 3D window when the service Linegrid and Storeys is not active. This is controlled by view
parameters.

Linegrid manager
All linegrids in the project are displayed according the settings in the Linegridmanager.

It can be found on the bottomof the 3Dwindow.

The dialogue contains all linegrids in the project and checkboxes set if the linegrid is visible or hidden. The right part shows
propertiesof the selected linegrid.

Linegridsare grouped according to is types, so all linegrids fromone type can be hidden byone checkbox.
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Linegrid and Storeys service
Chapter about Free lines

Chapter about Rectangular linegrid

Chapter about Circular linegrid

Generate name automatically
The checkbox for automatic generation is available for 2D rectangular and circular linegrid (it is also available in the dialogue
for 3D linegrid).
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Automatic naming is defined by the first name and numbers are generated automatically. When the checkbox is unchecked
then user can define anynamewithout automatic function. Re-check the functionality starts automatic generation according
to the first name.

Checkbox isunchecked automaticallywhen anyname ischanged byuser except the first one.
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Explode

The explode functionality split up the whole Linegrid to the separate Free lines. There are properties of a free line displayed
in Propertywindow.

Explodeworksonly for 2D Linegrid.

Free lines
It is a simple line which works like linegrid line. It is displayed by the dashed line and label. The curve is defined in the same
wayasgeometricalmembers.

There isa possibility to convert the general 3D line to a Free line. This isdone bya standard
toolbar button "Select line".
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Name
Standard property for all entities in SCIAengineer
Label
Description in label
Label display
Position of label according to the linegrid orientation
Draw label in
Shape of label
Label shift
The distance of the label from linegrid
Label rotation angle
Rotation of labelwith respect to the linegrid

Example of free line linegrid:

Rectangular linegrid
This type is created by the grid. There are two grids, one for x direction and one for y direction. User fills in the coordinates
and number of repetition. The dialogue showsalso a preview of the linegrid.
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The values for distancescan be set by two types:

1. Coor – user inserts coordinates to the second columns, the third and the fourth columnsare inactive.
2. Span – user insertsdistancesbetween linegrid lines to the third column and number of repetition in the fourth one. The

second column is inactive.

The setting SLmarks the line bya special label.
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Name
Standard property for all entities in SCIAengineer
Type
Type of the grid
Co-ordinates X, Y
Values from the grid
Rotation
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Rotation of linegrid
Label X, Y
Values from the grid
Direction X (Direction Y)
Position of the labels in Xdirection according to the linegrid orientation –None, Begin, End, Both
Label shift X (Label shift Y)
Distance of the label from linegrid in Xdirection
Draw label in
Shape of label
Dimension – direction X (Dimension – direction Y)
Position of dimensions in Xdirection according to the linegrid orientation
Grids dimensions
Visible/hidden dimensionson grids– distancesbetween linegrid lines
Overall dimensions
Visible/hidden overall dimensions– distance from the first to the last line
Style name
Dimension style

Example of Rectangular linegrid:

Circular linegrid
This type of linegrid is similar to the rectangular one. There isone grid for coordinatesand one for angles.
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TheYdirection can be defined byanglesor bycoordinates:

1. Angle – user sets the values for angles to the third column and sets the number or repetition.
2. Coors– user setsdistances fromone linegrid line to another.
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Name
Standard property for all entities in SCIAengineer
Type
Type of inserting values in table
Create grid as
Linegrid can be displayed ascircle or polygon
Co-ordinates Radius, Angle
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Values from the grid
Rotation
Rotation of linegrid
Label Radius, Theta
Names for labels from the grid
Label Display - Radius
Position of labels in radius–None, R-Start, R-End, Both
Label Display - Theta
Position of labels in theta –None, Theta-End
Draw label in
The shape of the label
Label shift
The distance of the label from linegrid
Dimension Display - Radius
Position of dimensions–None, R-Start, R-End, Both
Dimension Display - Theta
Position of dimensions–None, R-Start, R-End, Both
Grids dimensions
Visible/hidden dimensionson grids– distancesbetween linegrid lines
Overall dimensions
Visible/hidden overall dimensions– distance from the first to the last line
Style name
Dimension style

Example of circular linegrid:
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2D linegrid dimensions
Linegrids can be adapted in the 3D window by 2D linegrid dimensions. Those dimensions are developed specially only for
linegrids. The 2D linegrid dimensions are inserted to the working plane, it cannot be used in the same way as 3D dimen-
sions.

Dimensions types– Linear, Circular andAngular

Placing of 2D dimension is similar to the placing 2D Linegrid.

The linegrid dimension has itsown type of dimensionsstyle – Linegrid.
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Dimension line properties
There is a possibility to adapt the dimension line geometry in the properties or display the library of Dimension styles and
adapt the style.
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Name
Standard property for all entities in SCIAEngineer.
Layer
Standard property for all entities in SCIAEngineer.
Style name
Tellswhich predefined dimension style isused for creating dimension line.
Type
Inactive, type of used dimension.
Plotline offset type
1) Style – the plotline offset is loaded from theDimension style
2) User defined – the user can set the value for offsetmanually in the properties

Extension line
1) Length – user set the size of extension line beyond endmark
2) Offset – user set the size from inserting point of the dimension line to the end of the extension line
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Extension line offset
The value for offset from the dimensioned point to the starting point of extension line.

Rotate angle
Value specifying the rotation of the dimension line from theworking plane, examplewith 25°.

Label prefix
Thisvalue can be used asprefix for text label of dimension line.
Display only prefix
Here the user can check if he wants to use only the prefix on selected dimension lines, then hewill have all dimen-
sionswith same text label on them.
Label suffix
Thisvalue can be used assuffix for the text label of dimension line.
Display units as suffix
Thischeckboxautomaticallyaddsunitsassuffix to the text label of dimension line.
Dimension label
Above, Inline, Below –movesposition of the text label

Dimension style manager
Definition of Dimension style for dimension lines in 2D and 3D window is set in Dimension style manager. It’s a standard LIB
manager with possibility to save (load) styles to the format DB4.
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When the plotline offset type is set on Style in the properties, the offset is taken from the library. When it is switched to the
User defined, valuescan bemodified in propertiesof the selected dimension.

Name
Standard property for all entities in SCIAengineer
Dimension type
Filter for 2D, 3D and Linegrid dimension style
Selected palette
Defines palette: White background – 3D model, Graphic output – 2D window..., for this palette are the settings
under this comboboxpredefined
Font from palette
Text font used for dimension, adjustment ispossible throughPalette settings– linkShow font palette

Palette text size, Palette size definition, Palette font name
Valuesare taken from thePalette settings– it is inactive
Text width factor
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Width of text
Plotline offset
The dimensions line offset from its inserting nodes
Baseline spacing
Offset between dimension linesand itsbaseline dimension line

Endmark style
Shape of endmark
Size definition
Settings for endmark– if it will be displayed according to theGraphicdevice or Structure geometry
Endmark size
Size definition
Extend beyond dimension
Length of the line beyond the endmark, it is also dependent on theSize definition

Window pop-up menu
Introduction to window pop-up menu
Every graphical window that is created in SCIAEngineer hasa pop-upmenu associated with it. This pop-upmenu provides
for fast access to frequently used functions. Themenu can be invokes by clicking the right mouse button if themouse cursor
ispositioned inside thewindow.

The list of functionsoffered in the pop-upmenu dependson several factors:

l whether any function isopened (hasbeen activated),

l whether some entitiesare selected,

l whether themouse cursor ispositioned on someentity (at themoment when the rightmouse button isbeing pressed),

l if themouse cursor ispositioned on someentity ,what kind of entity it is.

In addition to the pop-up menu in graphical window, SCIA Engineer offers also a similar menu in a document window. This
particular type of pop-upmenu isdescribed in chapter covering the document.

Functions of the pop-up menu
The pop-upmenu of the graphical is created dynamically. That means that the functionsoffered in themenu vary according
to the current state of the program.

Standard pop-up menu
Zoom all Displays the whole model.

Zoom – cut-
out

Displays the selected cut-out so that it fits the whole area of the graphical window.
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Set view para-
meters

Opens the dialogue for adjustment of view parameters, i.e. the parameters that control the way the mod-
elled structure is displayed on the screen.

Cursor snap
setting

Opens the dialogue for adjustment of required SNAP mode.

Copy picture
to clipboard

Copies the contents of the graphical window into clipboard ofWindows system.

Export picture
to file

Saves the contents of the graphical window into an external file. The user may choose from a list of sup-
ported file formats.

Picture to doc-
ument

Inserts the contents of the graphical window into the document as a new picture.

Picture to gal-
lery

Inserts the contents of the graphical window into the Picture gallery as a new picture.

Print picture Opens the graphic output dialogue and allows the user to carry out the print set-up before the print itself.

Wire model in
manipulations

If the option is ON and the view direction or zoom is being adjusted by means of mouse (i.e. appropriate
control keys and right mouse button held down during mouse movement), only a simplified wire rep-
resentation of the structure is displayed during the operation of adjustment.

If the option is OFF, the normal (or full) display is used during the operation.

It is clear that the latter may lead to slower response of the program.

Picture wizard
Starts the wizard for generation of pictures.

See appropriate chapters in the Picture gallery.

Pop-up menu if a function is opened
If a function (e.g. Insert a new beam, Define load, etc.) is opened, SCIAEngineer adds an additional function to the pop-up
menu.

End of com-
mand

This command may be used to close the currently opened function. The command closes just the function
and lets the current service opened.

Pop-up menu if some entities are selected
If at least one entity is selected, the contents of the pop-up menu is rearranged in order to provide for common manip-
ulationswith the selected entities. The pop-upmenu consistsof the following functions:

Set view parameters
(for the selected entit-
ies only)

Opens the dialogue for adjustment of view parameters, i.e. the parameters that control the way
the modelled structure is displayed on the screen. The settings made here are applied to the
selected entities only.

As this function deals with a specified set of entities, the range of the view parameters in the set-
ting dialogue is limited to parameters related to the selected entities.

Set view parameters
for all entities

Opens the dialogue for adjustment of view parameters, i.e. the parameters that control the way
the modelled structure is displayed on the screen.

The settingsmade here are applied to all entities in the model.

Cursor snap setting Opens the dialogue for adjustment of required SNAP mode.

View This sub-menu comprisesmajority of the standard pop-up menu functions.

Move Start function for move of 1Dmembers.

Rotate Start function for rotation of 1Dmembers.

Scale Starts function for change of the scale of 1Dmembers.
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Stretch Opens function for stretching of 1Dmembers.

Mirror Opens function for mirroring of 1Dmembers.

Copy Starts function for copying of 1Dmembers.

Copy Add data
Starts function for copying of additional data.

This item is only available if at least one entity of additional data is in the current selection.

Move Add data
Starts function for moving of additional data.

This item is only available if at least one entity of additional data is in the current selection.

Delete Opens function for deletion of selected entities.

Picture wizard
Openswizard (i.e. a set of dialogues) that helps the user generate pictures of the modelled struc-
ture.

Pop-up menu if the cursor is positioned over any entity
If the mouse cursor is located over an entity at the moment the mouse button is clicked, the program adds a few special
items that are related to the veryentityunder the cursor.

Brief information about
the entity under cursor

This menu item contains type and name of the entity under cursor. This item performs no
action, it just says the user which entity the mouse cursor is positioned over.

Edit properties
Opens the property dialogue for the entity under cursor. In this property dialogue the para-
meters of the entity may be changed as required.

The picture below shows a sample pop-up menu that was invoked with the mouse cursor positioned over an entity called
B3.

Using the window pop-up menu
The pop-upmenu of the graphicalwindow can be invoked any time the graphicalwindow isdisplayed and holds the focus.
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The procedure for opening and using the pop-up menu

1. Place themouse cursor into the drawing area of the required graphicalwindow (please notice that several graphicalwin-
dowsmaybe opened at a time and therefore the cursor must be put into the required one).

2. If required, position the cursor over particular entity.

3. Click the rightmouse button.

4. The pop-upmenu appearson the screen.

5. Select the function that should be invoked and click the left mouse button.

6. The function starts or is performed (if the function does not require any parameters or response of the user, it is carried
out immediately).

7. Finish the opened function.

Note: If the pop-up menu is invoked accidentally, just place the mouse cursor anywhere
into the empty area of the graphical window and click the left mouse button. The pop-up
menu disappears.

Adjusting the viewpoint (view direction + zoom)
Introduction to view adjustment
If a simple two-dimensional structure is being modelled and analysed, it may be sufficient enough to have just one side view
of the structure during the whole design and evaluation process. However, if a complex three-dimensional structure is
handled, the user needs to:

l view the structure fromdifferent sides,

l zoom in important details,

l zoomout to get the overall view,

l possibly limit the view to onlya part of the structure.

All the pointsmentioned above can be covered byone term– the user needs to adjust the view.

This taskmaybe carried out bymeansof numerousview adjusting functions that SCIAEngineer offers in itsmenusand tool-
bars.

Adjusting the view
The adjustment of the viewmayconsist of two separate operations:

l definition of the view direction (i.e. fromwhich side the structure is looked at),

l specification of the distance of the view point from the structure (i.e. how big the structure appears to be on the screen).

SCIAEngineer offersawide range of functions to adjust the required view. Some functionsperform just one of the twomen-
tioned operations, othersmerge both of them into one action.
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Menu functions for adjustment of the view
View > ZOOM
> Zoom +

Zooms in.

View > ZOOM
> Zoom -

Zoom out.

View > ZOOM
> Zoom Cut-
out

Requires to define a cut-out for the zoom. The cut-out is then magnified in order to fit into the whole area
of the graphical window.

Once the function is started the mouse cursor changes. Position it to the upper left corner of the cut-out.
Press the left mouse button and hold it down. Drag the mouse to place the cursor to the bottom right
corner of the cut-out. Release the button.

View > ZOOM
> ZoomAll

Zoom in or out in order to fit the whole structure into the whole area of the graphical window.

View > ZOOM
> Zoom All –
Selection

Zoom in or out in order to fit the selected entities into the whole area of the graphical window.

View > View >
View X

Adjusts the view in such a way so that the structure is viewed from the positive X-axis direction. Sim-
ultaneously zooms in or out to fit the whole structure into the whole area of the graphical window.

View > View >
View Y

Adjusts the view in such a way so that the structure is viewed from the positive Y-axis direction. Sim-
ultaneously zooms in or out to fit the whole structure into the whole area of the graphical window.

View > View >
View Z

Adjusts the view in such a way so that the structure is viewed from the positive Y-axis direction. Sim-
ultaneously zooms in or out to fit the whole structure into the whole area of the graphical window.

View > View >
View AXO

Sets the view point vector to (1, -1, 1). Simultaneously zooms in or out to fit the whole structure into the
whole area of the graphical window.

Toolbar functions for adjustment of the view
Functions for the adjustment of the view are arranged on toolbar View.

View in
direction
X

Adjusts the view in such a way so that the structure is viewed from the positive X-axis direction. Simultaneously
zooms in or out to fit the whole structure into the whole area of the graphical window.

View in
direction
Y

Adjusts the view in such a way so that the structure is viewed from the positive Y-axis direction. Simultaneously
zooms in or out to fit the whole structure into the whole area of the graphical window.

View in
direction
Z

Adjusts the view in such a way so that the structure is viewed from the positive Y-axis direction. Simultaneously
zooms in or out to fit the whole structure into the whole area of the graphical window.

View in
direction
AXO

Sets the view point vector to (1, -1, 1). Simultaneously zooms in or out to fit the whole structure into the whole
area of the graphical window.

Zoom in Zooms in.

Zoom
out

Zooms out.

Zoom by
cut-out

Requires to define a cut-out for the zoom. The cut-out is then magnified in order to fit into the whole area of the
graphical window.
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Once the function is started the mouse cursor changes. Position it to the upper left corner of the cut-out. Press
the left mouse button and hold it down. Drag the mouse to place the cursor to the bottom right corner of the
cut-out. Release the button.

Zoom all Zoom in or out in order to fit the whole structure into the whole area of the graphical window.

Zoom all
– selec-
tion

Zoom in or out in order to fit the selected entities into the whole area of the graphical window.

Window scroll-bar wheel-like buttons for adjustment of the view
Each graphicalwindow hasgot threewheel-like buttonson the scroll-bar. If the scroll-bar is visible the "wheels" maybe used
to adjust the required view. The function of the threewheel-like buttons is:

Zoom (located on the bottom scroll-bar) Zooms in or out.

Rotate horizontally (located on the bottom scroll-
bar)

Rotates the structure around the vertical axes (i.e. vertical axis of the
screen).

Rotate vertically (located on the right hand side
scroll-bar)

Rotates the structure around the horizontal axes (i.e. horizontal axis of
the screen).

The operation of thewheel-like buttons is simple. Just place themouse cursor over the "wheel", press the left mouse button,
hold it down and "turn thewheel" with left-right, or up-down,movement of themouse over the pad.

Mouse controlled adjustment of the view
In addition to the standard menu and toolbar functions SCIA Engineer offers also a set of fast-access functions for the view
adjustment.

Zoom
in Press [Ctrl] and [Shift] keys simultaneously and hold them down. Then press the right mouse button and hold it

down aswell. Move the mouse up (away from you) over the pad.

Zoom
out

Press [Ctrl] and [Shift] keys simultaneously and hold them down. Then press the right mouse button and hold it
down aswell. Move the mouse down (towards you) over the pad.

Rotate Press [Ctrl] key and hold it down. Then press the right mouse button and hold it down as well. Move the mouse
over the pad in order to get the required view direction.

Shift Press [Shift] key and hold it down. Then press the right mouse button and hold it down as well. Move the mouse
over the pad in order to get the required position of the structure on the screen.

Zoom
All

Double-click the middle-button of your mouse to invoke function ZoomAll.

Rotation of view
The centre of rotation dependson initial conditions.

No entity is selec-
ted

The centre of rotation is put into the point that forms a centroid of an imaginary rectangular prism
outscribed around the existing model.

Some entities are
selected

The centre of rotation is put into the point that forms a centroid of an imaginary rectangular prism
outscribed around the selected entities.

One node is selec-
ted

The selected node is the centre of rotation.

Clipping box is ON The centre of rotation is put into the point that forms a centroid of the current clipping box.
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Limiting the view
If a modelled structure is larger and complex, it may be convenient to display only a limited part of it. This "limitation" can be
achieved in two different ways:

Activity
or layers

The parts of the structure that are not necessary for the current operations may be hidden, in other words
removed from the view.

This approach is described in chapter Basic working tools > Layers or Basic working tools > Activity.

Clipping
box

The view can restricted to a three-dimensional area (defined as a rectangular prism) called clipping box. If the
clipping box is defined, only entities located inside it are displayed.

Features of the clipping box are described in chapter Advanced working tools > Clipping box.

Adjusting the view numerically
The view direction may be specified also numerically by means of view direction vector. The vector can be defined in the
View parameters dialogue on tab View. The three numbers in the table represent the X, Y, and Z components of the view
direction vector.

Examples:

View direction vector View

-1.0

1.4

-1.0

-1.0

-1.4

-1.0
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0

0

1

Adjusting perspective projection
Bydefault, an orthogonal projection isused to display three-dimensionalmodelson the screen. Asan alternative, also a per-
spective projection can be activated.

The perspective projection can be set using:

l Either: Menu function View >View >Perspective view,

l Or: Button [Switch view to perspectivemode] ( ) on toolbar View.

Special view settings
In addition to the adjustment of the viewpoint (view direction and zoom), some other propertiesof the view can be controlled
by the user.

Wire model in manipulations
Thisoption can be set in:

Either: MenuView >View >Wiremodel inmanipulations,

Or: Rightmouse button pop-upmenu of the graphicalwindow.

Option
is ON

Only a simplified representation of the structure is displayed during the mouse controlled adjustment of the view.

This option increases significantly the response of the computer during the above mentioned operation. It is
therefore more than recommended for standard speed computers and other than very simple models.

Option
is OFF

This option results in "fully displayed structure" during the mouse controlled adjustment of the view.

This option may lead to slow response of the computer and is recommended only for very state-of-the-art and
fast computers and simple models.

View parameters
Introduction to view parameters
Each entity that is defined in SCIA Engineer is not "just a geometrical shape". There is a good number of various attributes
attached to each entity. The attributesmaybe for examplematerial, cross-section, layer, name, construction type, etc. Each
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of the attributes that isdefined for a particular entity can be displayed on the screen.

What’smore, some of the attributessuch as for example cross-section or surface can be drawn in severalways. SCIAEngin-
eer enables the user to control theway individual entitiesare displayed bymeansof view parameters.

These view parameters tell the program which particular attribute of each entity should be shown and which graphical rep-
resentation should be used.

View parameters can be defined en block for the whole structure asunique, or theymaybe defined separately for individual
entities. Each entity can be displayedwith different view parameters.

Overview of view parameters

Available view parameters
TabStructure Tab Labels TabModel
Tab Loads TabView TabMiscellaneous

Note: In addition to these general view parameters, there are a few specialised tabs with
view parameters for a particular advanced module, e.g. Steel code check, etc. These tabs
are not shown until such amodule is initialised.

Note : The following list contains the available view parameters. It should be noted that not
all of them are always offered in the Setup dialogue. The Setup dialogue offers only those
parameters for which the appropriate entity type has been already defined. E.g. until you
define at least one support in your model, view parameters for supports are not shown in
the dialogue.

Tab Structure

Tab Structure > Group Service
Display on opening the service
If ON, entities appropriate for the service are automatically displayed as soon as the service is opened (in the tree menu). If
OFF, no change of display takesplacewhen a service isopened.

Tab Structure > Group Structure
Style + colour
It controls the style and colour ofmembersof themodel (beams, plates, shells, etc.)

normal: settingsmade in Setup >Colour/Linesdialogue are used,

by layers: eachmember isdisplayed in the colour of the appropriate layer, allmembersassigned to the same layer are of the
same colour,

bymaterial: eachmember is displayed in the colour of the appropriatematerial, allmembersmade of the samematerial are
of the same colour,

by cross-section: each member is displayed in the colour of the appropriate cross-section, all members of the same cross-
section are of the same colour,

according to structuraltype: eachmember isdisplayed in the colour corresponding to its structural type.
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Note : If e.g. two materials, two layers, two cross-sections have assigned the same colour, than the same colour is used for
membersof different controlling property.

Drawmember system line
The system line (midline) isdrawn if thisoption isON.

Note: If thisoption isOFF and alsoMember surface isOFF, then thewhole structure disappears from your view.

Member system line style
It controls the style of themember's system line (midline)

Definitions: System line is a line connecting the nodesof amember. This line iswhat you define when you input a newmem-
ber. Fine elementsare also generated on this system line. Reference line coincideswith the system line if no eccentricity of a
member is defined. If eccentricity is defined, the reference line is the centroidal axis of the member. Even if eccentricity is
defined, the finite elements are generated on the system line (and the defined eccentricity is used in the relevant formulasof
the finite elements). Bar is a highlighted system line. However, the bar is not drawn from the node to the node. It just indic-
ates themember and leavessome space around the node for further information to be displayed.

system line: the system line ofmembers isdrawn.

system line + reference line: system line (solid) and possibly reference line (dashed) isdisplayed

bar: highlighted "system line" isdrawn

system line +bar: the system line isdisplayed and it ishighlightedwith the bar
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Model type
You can define different geometryparameters for the "calculationmodel" of your structure and for the " structuralmodel" of
your structure. The calculation model is used for the numerical analysis, the structural model can be used for drawings,
detailing, attractive presentations of your project, etc. For example, you can define different eccentricities in the twomodels,
you can define cut-offs at ends of 1D members in the structural model, etc. This parameter tells the program which model
youwant to see on the screen.

analysismodel: the parameters relating to the calculationmodel are used to display the structure

structuralmodel: the parameters relating to the structuralmodel are used to display the structure

Example:When you open the property table of amember, the calculation-model-parametersare in the top part of the table.
The structural -model-parametersare grouped lower in the table under heading structuralmodel.

Member surface
It defineswhether the surface ofmembersshould be displayed.
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Rendering
specifies the style the surface ofmembers isdisplayed

wired: only thewired schemeof the surface isdisplayed

hidden lines: the real surface is calculated and those surface lines that are hidden from the view are not drawn

renderedwith edges: the real rendered viewwith outlined edges isdisplayed

rendered: the real rendered view isdisplayed

transparent: the surface is filled but it is transparent (this rendering style may be e.g. useful when you want to present
designed steel frame connections - the structuremaybe transparent, the connectionmaybe fully rendered)
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Example: The picture shows the combination of transparent rendering style for 1D member and full- rendering for con-
nection.

Draw cross-section
Thisoption tells if the cross-section of a 1Dmember should be displayed.

Cross-section style
If the previousoption isON, this itemdefines the style of the displayed cross-section.

section: one section is drawn about in the middle of each 1D member. The section is 3D oriented, i.e. it is displayed AS IS in
the structure and in some viewsmaynot be clearly recognisable.

in screen plane: one section is drawn about in the middle of each 1D member. The section is transformed into the screen
plane so that it is clearly recognisable in all view of the structure.

longitudinal XZ: a short part of XZ projection of the 1D member surface is drawn. In other views than side view, the section
maybe hardly recognisable.

longitudinal XY: a short part of XZ projection of the 1D member surface is drawn. In other views than plan view, the section
maybe hardly recognisable.

Tab Structure > Group Structural node
Display
The FE nodes of the structure can be displayed or hidden. Especially in very large models, it may be convenient to hide the
nodeswhen a picture of thewholemodel is to be drawn.

Mark style
Specifies the style )shape) of the nodemark.
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Mark size
Specifies the size of the nodemark.

Tab Structure > Group Member parameters
Buckling lengths
Buckling lengths (in all directions) for individual 1Dmembersare displayed.

Member non-linearities
If a non-linearity isassigned to amember, a symbol isdisplayed indicating the type of the assigned non-linearity.

FEM Type
Various FEM types can be assigned to individual members (tension only, normal 1D member) and a description indicating
the selected type isdisplayed if thisoption isON.

Tab Structure > Group Mesh
Drawmesh
The generatedmesh isdisplayed (themesh can be displayed only if it hasbeen alreadygenerated).

Draw refinement
TheFEmesh can be refined inmanuallydefined area and the defined refinementsare displayed if thisoption isON

Note : The finite element mesh can ONLY be displayed if at one calculation has been
alreadyperformed and its resultsare still available.

Tab Structure > Group Local axes
Nodes
Axesof local coordinate systemsof individual nodesare displayed.

Members 1D
Axesof local coordinate systemsof individual 1Dmembersare displayed.

Members 2D
Axesof local coordinate systemsof individual plate and shellmembersare displayed.

Tab Structure > Group Sections
Members 1D
Sections (i.e. sections for the evaluation of results) on 1Dmembersare displayed.

Members 2D
Sections (i.e. sections for the evaluation of results) through plate/shellmembersare displayed.

Tab Structure > Group Calculation info
Display singularity
If a calculation fails, the problematicplace is shown.
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Tab Labels

Tab Labels > Group Beam labels
Display label
It controls the group asawhole - if ON, the selected labelsare displayed, if OFF, no labelsof the group are shown.

Name, Cross-section name, Cross-section type, Length, Layer, Type and priority
Individual labels correspond to individual items in the property table of amember.

Tab Labels > Group Node labels
Themeaning ismore or lessself-explanatory.

Tab Labels > Group Slab labels
Themeaning ofmost of the view flags ismore or lessself-explanatory.

Edges
Each edge of a slab hasa unique number (uniquewithin the single slab) and these edge numbersare displayed if thisoption
isON.

Tab Labels > Group Mesh
Display label
see above

Nodes
FE-node numbers

Elements 1D
Numbersof 1D finite elements.

Elements 2D
Numbersof 2D finite elements.

Note: The finite element mesh can ONLY be displayed if the calculation has been already
performed and its results are still available or if the mesh has been generated bymeans of
functionCalculation >Generatemesh.

Tab Labels > Group Buckling lengths
Display label, Name

Themeaning ismore or lessself-explanatory

Label
Description of the buckling length including the dimension.

Tab Labels > Group Sections
Display label, Name
Themeaning ismore or lessself-explanatory.
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Tab Labels > Group Non-linearities
Display label
The label of the defined type of non-linearity.

Tab Model

Tab Model > Group Service
Display on opening the service
If ON, entities appropriate for the service are automatically displayed as soon as the service is opened (in the tree menu). If
OFF, no change of display takesplacewhen a service isopened.

Tab Model > Group Supports
Themeaning ofmost of the view flags ismore or lessself-explanatory.

Tab Model > Group Other model data
Themeaning of the view flags ismore or lessself-explanatory.

Tab Model > Group Support labels
Displays the label of supports.

Tab Model > Group Labels of other model data
Displays the label of other model data such as hinges, cross-links, etc. This view parameter displays or hides the label for all
the typesof other model data at the same time. It isnot possible to attach the label to e.g. one type of other model data only.

Tab Loads

Tab Loads > Group Service
Display on opening the service
If ON, entities appropriate for the service are automatically displayed as soon as the service is opened (in the tree menu). If
OFF, no change of display takesplacewhen a service isopened.

Tab Loads > Group Display loads
Display
If OFF, no load isdisplayed at all. This item controls thewhole tab.

Style
If the style Colour by action type is selected, the loads are displayed depending on the type of action (forces, wind, snow,
imposed displacement, temperature, etc...). Line colour and style can be configured in the palette for each type of action.
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If the styleColour by load type is selected, the loadsdisplayed depending on the type of force (point force, line force, surface
force). Line colour and style can be configured in the palette for each type of load. Please note, that generated loads have
their own, separate line styles.
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Please note, that the style of some typesof loads/actionsdo not depend on the selected displaystyle. Those exceptionsare:

l Unused loads
l Displacement loads
l Thermal loads

Load case
You can select here the load case to be displayed.

Plane load generator
Displays the loading polygon of the plane load generator.

Absences
Displays the absences.
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Absence
You can select here the absence group to be displayed.

Tab Loads > Groups for individual type of load
Themeaning of the view flags ismore or lessself-explanatory.

Tab Loads > Groups Labels of loads
Display label
This item controls the displayof load labels.

Name
If ON, the nameof the load isattached to every loading impulse (force,moment, temperature load, etc.)

Value
Shows the "input" value of the load.

See the note below.

Total value
Shows the "real" value of the load.

See the note below.

Note: ItemsValue and Total value are significant for loads that are not defined directly by its
force or moment impulse, but that were defined by means of a wind generator, load gen-
erator, or as a predefined load. For such loads, SCIA Engineer can display two different
types of data. First, the input value (e.g. width load) can be shown, i.e. the value. Second,
the calculated load per meter of length can be displayed (i.e. the total value).

Tab Loads > Groups Masses
Displays themasses.

Tab Loads > Groups Labels of loads
Display label
This item controls the displayofmass labels.

Name
If ON, the nameof themass isattached to themasssymbol.

Value
Shows the size of themass.

Tab View

Tab View > Groups Display tools
Disable tooltips
If ON, no tooltips in the graphicalwindow are shown. I.e. no information concerning the entityunder cursor isdisplayed. This
optionmay reduce the response time in large projects. It also reduces the size of images in thePicture gallery.

Before thisoption takeseffect, the screenmust be regenerated.
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Disable layers
If ON, no information on layers is stored in the data for the graphical window. This option may reduce the response time in
large projects. It also reduces the size of images in thePicture gallery.

However, if thisoption isON, it isnot possible to e.g.make export of the drawing intoDXF file including layers– onlyone "uni-
versal" layer isexported.

Before thisoption takeseffect, the screenmust be regenerated.

On the other hand, this option doesnot prevent you from using e.g. activity by layers. This feature is fullyworking regardless
of thisparameter.

View vector X, Y, Z
Enables the user to numericallyadjust the view direction.

Clipping box
Switches theClipping boxON/OFF.

Tab Miscellaneous

Tab Miscellaneous > Group Results diagram
Results
Displays the result diagramsonmembers.

Tab Miscellaneous > Group Construction stages
Display
Displaysdata relating to construction stages.

It controls the group asawhole - if ON, the selected labelsare displayed, if OFF, no labelsof the group are shown.

Already installed
Already installedmembersare displayed.

Currently installed
Currently installedmembersare displayed.

Not yet available
Members that are not yet available are displayed.

Already removed
Members that have been already removed are displayed.

Tab Miscellaneous > Group Construction stages data labels
Label local beam history
Attaches labels to the local 1Dmember history.

Tab Miscellaneous > Group Connection force
Display
Displays the forces in connections (in jointsof several 1Dmembers)
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Tab Miscellaneous > Group Connection force labels
Display label
Displays the labelsof connection forces.

It controls the group asawhole - if ON, the selected labelsare displayed, if OFF, no labelsof the group are shown.

Name
The name isattached to connection forces.

Tab Miscellaneous > Group Connection force 
Display arrow onmaximal deformation
Shows the view flags “Maximal translation” and “Maximal rotation” which are available after the calculation

Display arrow on small mesh elements
Displays themark (arrow) on elementswhose angle is smaller than 5°after themesh generation, if any

Display arrow onmesh node
Displays themarkon themesh nodes, if anywasdefined by the user using commandSELMN

Adjusting the view parameters
In general there are threeways to adjust the view parameters:

l in the Setup dialogue,

l using the fast-accessgroup-commands,

l using the fast-accesswindow-buttons for certain typesof entities.

Adjusting the view parameters using the Setup dialogue
The Setup dialogue provides for the adjustment of all available view parameter. In addition to the parameters themselves,
the dialogue containsalso other controls. Theyare grouped at the bottomof the dialogue.

Check /
uncheck
group

If the cursor is placed on the name of a group of view parameters (in any of the tabs), it is possible to use this
check box to select or deselect the whole group.

Lock pos-
ition

You can move the dialogue to any position on your screen and check this option. When you closed the dia-
logue and open it again, it is not displayed in the centre of the screen (which is the default position), but in the
place you "locked" it.

Check /
uncheck
all

This check box can be used to select or deselect all the view parameters on the active tab.

The procedure to open the Setup dialogue
TheSetup dialogue can be opened using:
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l the button Fast adjustment of viewflags on whole model (or if required Fast adjustment of viewflags on selection) on the
button-bar of the graphicalwindow and selecting commandSetup dialogue,

l the pop-upmenu (opened bya clickof the rightmouse button on the area of the graphicalwindow) and selecting the func-
tion Set view parameters for all (or if required Set view parameters for selected).

Adjusting the view parameters using the fast-access group-commands
For selected groups of entities (the groups in termsof the overview of available parameters) fast-access group-commands
are available in themenu opened through the button Fast adjustment of viewflagsonwholemodel (or if required Fast adjust-
ment of viewflagson selection) on the button-bar of the graphicalwindow.

Most groups from the Setup dialogue can be quickly controlled (switched ON/OFF) through these commands. Each com-
mand in the menu can be used to display or hide the entities (labels) covered by the corresponding group. The commands
work like a togglemenu item: one clickon themselects the group, next clickdeselects the group, etc.

Detailed "toggling"

The fast-accessgroup-commandscanwork in twomodes. The requiredmode can be set in themenu that openswhen you
clickon the button Fast adjustment of viewflagsonwholemodel (or Fast adjustment of viewflagson selection) on the button-
bar of the graphicalwindow.

Default

(i.e.
Detailed
Off)

In thismode, whenever you turn the corresponding group OFF, the whole group becomes hidden.

Whenever you toggle the group ON, the whole group is displayed.

Detailed

(i.e.
Detailed
On)

In this mode, whenever you turn the corresponding group OFF, the whole group becomes hidden (so far it
is the same as in the perviousmode).

But, whenever you toggle the group ON, the only those entities are displayed that are "ticked" (selected) in
the Setup dialogue.

See the example below.

Note: TheDetailedmode isnot available until you at least once open the Setup dialogue for
View parameters, make your settings there and confirm themwith [OK] button.

Example

Let us take groupOther model data. It can offer the following entities:

l hingeson 1Dmembers,

l hingeson slabs,

l cross-link,

l rigid arm,

l relative node,

l internal node,

l internal edge.

Let ussuppose that you use Fast adjustment of viewflagsonwholemodel.

First, let us talkabout theDefault mode. If you toggle the groupOFF, all the above listed entitiesbecome invisible. If you then
toggle the groupON, all the above listed entitiesare displayed on the screen.
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Now, let usmove to the Detailed mode. Let us suppose that in the Setup dialogue, the following settings were made when
the dialoguewasedited last time:

hinges on beams

hinges on slabs

cross-link

rigid arm

relative node

internal node

internal edge

If you toggle the group OFF, all the above listed entities become invisible. There is no difference in hiding the group.
However, when you toggle the group ON, only the selected entities are shown on the screen (i.e. hinges on 1D members,
cross-link, rigid arm, relative node) while the entities that are not marked in the Setup dialogue remain hidden (i.e. hingeson
slabs, internal node, internal edge).

Thismode is intended for such a style or phase of workwhen you need to check your model repeatedly and you want to see
and hide in turnssome part of your model.

Adjusting the view parameters using fast-access window-buttons for certain types of entit-
ies.
The button bar of the graphical window offers a set of buttons for fast displaying or hiding of certain types of entities or their
labels.

Show / hide surfaces Displays / hides the surface outline ofmembers (1Dmembers, slabs, shells).

Render geometry SwitchesON/OFF rendering ofmembers.

Fast adjustment of view-
flags on whole model

Offers a menu with fast-access group-commands (see above) or opens the Setup dialogue
(see above).The adjustment is valid for all entities in the model.

Fast adjustment of view-
flags on selection

Offers a menu with fast-access group-commands (see above) or opens the Setup dialogue
(see above). The adjustment is valid for currently selected entities.

Show / hide label of
nodes

Displays / hides numbers of nodes. It effects the whole model.

Show / hide label ofmem-
bers

Displays / hides numbers ofmembers (1Dmembers, slabs, shells). It effects the whole model.

Show/hide dot grid Displays / hides the dot grid.

Select load case for dis-
play

Selects the load case that will be displayed if the view parameter for load is switched on.

Note: Please note that some view parameters always relate to the whole structure. For
example, it is not possible to display reinforcement in selected 1D members only, it is either
shown in the whole structure, or hidden everywhere. In order to see e.g. the mentioned
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reinforcement in selected 1D members only, function Activity must be used to hide (or dis-
play in greycolour) the "unwanted" members.

Note: Not all view parameters are always offered in the Setup dialogue or in themenu with
fast-access group-commands. The Setup dialogue and the menu with fast-access group-
commands offer only those parameters for which the appropriate entity type has been
already defined. E.g. until you define at least one support in your model, view parameters
for supportsare not shown.

Predefined view parameters settings
Full and complete setting of all the view parameters may be awkward and tiresome task. Especially if the user needs to
repeatedly swap between two typesof display.

Consequently, SCIA Engineer offers several sets of predefined settings. The predefined sets should cover most of com-
monlyneeded cases. The predefined setscan be found inmenuView >Set view parametersand theyare:

Model of
structure

This variant displays the structure itself as is. Any supports, loads, etc. are not shown to provide for clear view of the structure.

Analysis
model

This option displays the model with the focus laid on the numerical calculation. Therefore, only axes of individual 1D mem-
bers are displayed and they are accompanied with supports, loads, local co-ordinate systems and other data that are import-
ant from the calculation point of view.

Struc-
tural
model

This variant shows the structural model of the structure.

Other predefined viewsmaybe found in themain Viewmenu.

Wired
This option displays the wired representation of the model.

Surfaces ofmembers are switched on.

Rendered This option switches on the rendering of entities. Surfaces ofmembers are switched on.

Transparent This option displaysmembers using transparent rendering. Surfaces ofmembers are switched on.

Note: The number and types of predefined views may vary depending on the "skin" and
mode you select for SCIAEngineer.

Drawing of input data with eccentricity

Terminology
system line
The line inputted by the user, it hasnodesat itsends.

eccentricity of beam
The offset of a 1Dmember defined in the local coordinatesof the 1Dmember.We have the eccentricity in y- and z-direction.
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reference line
The reference line of a 1D member if obtained when the eccentricity is added to the system line. The reference line cor-
responds to the centroidal axisof the 1Dmember.

eccentricity of loads
The offset of the load (or wemaysayadd-data in general) related to the reference line.

Current status

Recent versions of SCIA Engineer drew loads relatively to the system line of the cor-
responding 1D member. Consequently, users could not check their real position on the 1D
members, which could result in the wrong interpretation of input data and also results as
we have to realise that resultsare related to the reference line and not to the system lines.

A related topic is the drawing of surfaces (and reference lines) of 1D memberswith regard
to Construction Stages (CS). Cross-sections could change their shapes over time (in gen-
eral the shapemaydiffer for everyCS). This influences the position of the reference linesof
1Dmembers in individualCSand, of course, it also influences the drawing of loadsand res-
ultson 1Dmembers.

Drawing of input data with the eccentricity taken into account
Loads
So far, the load was displayed on the system line of the 1D member. Thiswas a correct solution only if the load was defined
without any eccentricity and if the reference line (centroidal line) of the 1D member coincided with the system line (i.e. in the
case of a straight 1D member the line connecting the end nodes of the 1D member). However, as soon as any eccentricity
was introduced either to the 1Dmember or to the load, thisdisplaystyle becamemisleading.

The new solution isbased on the principle that all the loads (and other displayed quantities such ashinges, and even results)
are alwaysdisplayed in their real position.

A few examplesdealingwith input data follows.

A1Dmember with a one-side haunch subjected to a distributed load.

Asyou can see, the load follows the reference line (centroidal axis) of the 1Dmember.

A1Dmember with a one-side haunch subjected to an eccentricdistributed load.
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Here, the load acts on eccentricity defined in the z-direction. In the next picture, also the eccentricity in y-direction was intro-
duced to the load.

When required, also a line showing the defined eccentricity of the load can be drawn. Thus, you can more easily see what
the real action of the load is. In addition, in the case of several eccentrically loaded 1Dmembers located close to each other,
it will be unambiguouswhich load belongs towhich 1Dmember.

The procedure to display the "eccentricity lines"

1. OpenView parameterssettingsdialogue.

2. Select Tab Loads/Masses.

3. TickoptionDisplayeccentricity.

4. Confirmwith [OK].
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In addition to the "eccentricity lines", you can also display themagnitude of the specified eccentricity.

The procedure to display the eccentricity label

1. OpenView parameterssettingsdialogue.

2. Select Tab Loads/Masses.

3. Tickoption Labelsof loads>Display label and Labelsof loads>Eccentricity label.

4. Confirmwith [OK].
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Note: Loadsare alwaysdrawn at their real location. View parameter Miscellaneous>Draw-
ing style for Model+Loads>Show add data, resultsat hasno effect on the loads.

Supports
Let us have two beams supported at the end. One of the beams is defined with the system-line in the centre line of the
beam. The second beamhas the system line at the bottom surface.
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The support is displayed where its real location in the calculation model is: (i) in the first case at the centre line of the beam,
(ii) in the second case at the bottomedge of the beam.

Note: Supports are allways drawn at the system line of the beam. View parameter Mis-
cellaneous > Drawing style for Model+Loads > Show add data, results at has no effect on
the supports.

Hinges
Hinges, which also belong to additional data of the SCIAEngineer model, can also take into account possible eccentricity of
the 1Dmember at which theyare defined.

Unlike loadsand supportshowever, hingesallow the user to decide on the drawing style.
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The procedure to select the display mode

1. OpenView parameterssettingsdialogue.

2. Select TabMisc..

3. Set the optionDrawing style for Model+Loads>Show add data, resultsat to:

1. Reference line in order to see the real position of the hinge (the hinge is put on a short rigid arm that is not drawn in the
screen).

2. System line in order to see the schematicposition of the hinge.

4. Confirmwith [OK].

Results

Note: Results are always drawn in the system line. (Despite the specification, it was not
done in this version.)

Structural model

Note: The display of eccentric entities relates exclusively to the analysis model. It has no
relation to the structural shape.

Lights
If rendering is switched on in View parameters, you may control the direction of the light used to illuminate the graphical
screen.

The following examplesgive the idea of what the effect of the light direction is.
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The dialogue for the adjustment of the light direction can be opened through menu function: View > Light. When the dia-
logue is opened, the light direction can be adjusted by a single click on the picture of the ball in the dialogue. The effect is
immediately shown in the graphical window, so it is quite easy to find the required light direction. When the light is adjusted
appropriately, close the dialogue.

Regeneration of view
Introduction to regeneration of view
It is a common phenomenon in CAD and similar "drawing" programs that once the drawing becomes excessive or is being
edited and modified, the "current state" displayed on the screen may happen not to reflect completely the "reality". This is
due to the fact that it is not possible to guarantee a flawless automatic regeneration of the view. If the automatic regen-
eration of the view had to be ensured, it would result in unbearably slow response of the program.

Therefore, SCIA Engineer, similarly to other graphically oriented program, offers the user the possibility to regenerate the
viewmanuallyat any timewhen necessary.

Redrawing the active graphical window
This function redraws the graphical window if some changes affecting the displayweremade and the window has not been
regenerated automatically.
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The procedure to regenerate the contents of the graphical window

1. Pressbutton [Redraw] ( ) on toolbar View.

2. The contentsof the activewindow is regenerated and redrawn.

Calculator
Calculator
Any time you enter a number into an edit box or command line, youmayuse the internal calculator. This calculator provides
for basic operations: addition, multiplication, subtraction and division. You may use brackets, basic goniometric functions
(tan, sin, cos) and it ispossible to calculate powersof numbers. The calculator takesaccount of prioritiesof operators.

If youwant to use the calculator to calculate the value in the input box, youmust start with the equalssign (=).

As soon as you type the first character, a temporary field - "bubble" - appears just below the input box. This new field cal-
culates the result of the input formula. If the field shows "error" than the syntaxof the formula is invalid.

Valid operatorsand functions

= obligatory, this character must start the formula

+ addition; e.g. 1+2

- subtraction; e.g. 2-1

* multiplication; e.g. 1*1

/ division; e.g. 2/1

^ power;; e.g. 2^3

() brackets; e.g. 2*(3+3)

e exponential notation, useful for large numbers; e.g. 1e5

sin() sinus; e.g. sin(45)

cos() cosine; e.g. cos(30)

tg() tangent; e.g. tg(45)

The calculator maybe used also in the situation when set of numbers is to be input, e.g. when point coordinatesare defined.
In such a case anyof the coordinatescan be input as formula, and anyof the coordinatescan be input asnumber.

Example 1

The input of point

1;=2*(3+2);sin(45)*5

is "decoded" as:

X=1

Y=2*(3+2) =10

Z =sin(45)*5 =3,5355339

Example 2 

- 366 -



Basicworking tools

Cleaner
Removing unnecessary data from the project
When you work for some time on a project, it may happen that some data you input at the beginning are not relevant any
more. For example, you may be force to change the material grades, you decide on replacing certain types of cross-sec-
tions, youmayopt for another type of reinforcement, the load the structure is subjected tomayhave been altered, etc.

In order to keep the project (especially a large one) "free of ballast", it is convenient to remove all the entities that are no
longer necessary.

Sometimes, it may happen that you must completely abandon the solution you chosen and you must start from scratch –
sometimesnot exactly, but almost.

For all these situations, you may use tool called Cleaner. It is a simple tool that enables you to select which particular data
should be removed from your project.

There are several groupsdefined within the Cleaner dialogue with each of them containing usually several items. The num-
ber and type of the items depends on the data that were defined in the project. The Cleaner dialogue offers only the data
that reallyexist in the project.

Below, you will find an example of the groups and individual items in them (the complete list would be too long and it would
contain all possible entities that can be defined in SCIAEngineer).

General This group allows you to delete e.g. results, temporary solver data,mesh, etc.

Document Here you can clear the document.

Model This group allows you to remove e.g. supports, hinges, etc.

Loads It is possible to remove all the applied loads or just the selected types of loads.

Sets Defined sets such as load cases, combinations, bore holes, stressing beds, etc. can be deleted here.

Unused library entities The unused items in specified libraries can be removed from the project to make the project file more compact.

Coordinate information
Information about coordinates of selected points
FunctionCoordinates info enables the user to review the coordinatesof selected points in themodel and tomeasure the dis-
tance between two defined points.

The function is easy to use. Once it is started, the user just selects (clicks) the required points (nodes) in the model and a
simple dialogue shows the information:

l coordinatesof the selected point in the global coordinate system,

l vector (in the global coordinate system) from the previouspoint to the last point,

l coordinatesof the selected point in the current user coordinate system,

l vector (in the current user coordinate system) from the previouspoint to the last point,
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l distance between last two selected points,

l angle defined by the last three selected points.

The procedure to obtain the information about coordinates

1. Start functionCoordinates info:

1. either throughmenu function: Tools>Coordinates info,

2. or through treemenu function: Tools>Coordinates info,

3. or through icon on toolbar Tools.

2. The information dialogue isopened on the screen.

3. If necessary, position the dialogue so that it doesnot it doesnot hinder you.

4. Select (click) the points you are interested in.

5. When ready, use the close button in the top right corner to close the information dialogue.

Attributes
Attributes

Introduction
The attribute isan object in SCIAEngineer. It can displaysome additional information aboutmembers. It can be edited in the
Propertywindow in the samewayasother properties.

We have two different kindsof attributes.

• User defined attributes

• Previousmember data – now converted to attributes
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When the user selectsamember with an attribute, then the attribute isalwaysdisplayed in the properties. It is not possible to
select amember without attributeswhen anyattributesare connected to themember.

There is a second tab in the properties when the member contains an attribute. This second tab displays the properties of
the attribute.

The user hasalso the possibility to select each attribute separatelybyselecting it by its label.

Previously Member Data - now Attributes
There are Member data in SCIA Engineer which can be considered as attributes already – Concrete member data, Steel
member data, Fire resistance andmore.

ThoseMember datawhich do not have special drawingsof their flagshave been alreadyconverted to attributes. Their beha-
vior is the same as for attributes.
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View flags for previousMember data stay the same– see example of concreteMember data:

The attributes that wereMember data previously have the same dialoguesand same properties. Only their displaying is dif-
ferent fromnow on.
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Example of converted Member data: Concrete member data, Steel member data, AMRD, Voided slabs, Fire resistance,
Punching in node (Punching data).

If the convertedMember data are inserted to the project then they can be inserted to a newmember in the samewayas it is
possible for user defined attributes.
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Displaying of Attributes
Attributesare displayed in tooltipsand in Labels.

Attributes can be selected one by one or all together. One by one selection is by clicking the mouse on their description in
label, All together are selected byclicking on the label itself.

The only exception is when the Attributes are not displayed – i.e. attributes have been inserted on non-geometrical objects
(loads, foundation blocks, openings…).

Displaying of tooltipscan be disabled in View parameterssettings.
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When the project contains at least one attribute, then a new tab in the view flags appears – Attributes. Here the user can
switch the user-defined attributeson or off.

Display
Thischeckbox tellswhether the attribute should be displayed in thewholewindow
Name of type
Displays theNameof the attribute (in the Attribute definition – the row Type name)
Values
Are set in the Attribute definition – Label setup
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Label setup in the attribute definition

Here the user can definewhich valueswill be used for creating of labelwith Values.

Text size, fonts, colour, ...
Change of the size of the Label for Attributescan be set in dialogueSetup->Fonts->Attributes.
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Change of the colour of the Label for Attributescan be set in dialogueSetup->Colours/Lines->Attributes.
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User defined Attributes
User defined attributesmust first be defined and then they can be inserted to the project. The definition dialogue comes out
of My Add Data dialogue. The user defines the String database, parameters, picture and icon. The pre-defined attributes
appear in the new servicemenu –Attributes. The attribute can be inserted to the project fromhere .

The attribute definition:

When at least one attribute isdefined a new service inmain tree appears:
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In this service also theAttributesDefinition dialogue isavailable.

The name of the service for a new attribute is set in the dialogue as Service name (example – Input of Attribute …) and to
this name from string database is connected the name of the attribute in row Name in the Attribute definition (example –
coins, face…).

It ismuch quicker to use anAttributewizard for the definition.

Name
The user setsa nameof the attribute
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Attribute parameters
Here the user specifiesparameters for Attribute
Label setup
The user can definewhich values fromparameterswill be displayed in the label of the attribute
Icon
The user can select an iconwhichwill be used for thisattribute in the servicemenu
Remove icon
Removes the icon
Picture
This item insertsa picturewhichwill be displayed in a smallwindow at the bottomof the dialogue
Remove picture
Removes the picture
Define text strings
All the text strings of the user interface are saved into a string database, this allows for an easy translation of the
interface to different languages
Adapt attributes owners
In the list of all available owners, the user can select owners for his attribute. If he selects nothing, then the owner
can be everymember with geometry.
Preview of dialogue
Preview of the attribute dialogue
Container Unique ID
Tellswhich container isused for thisattribute
Generate new container Unique ID
The user can change the container for thisattribute

User attribute wizard (version 2011)
The wizard is a new tool for creating User-defined attribute. The process is divided to the single stepswhich are completed
by the button “Next”. The wizard can be used also for editing. Attribute parameters are stored on the second tab. User-
attributewizard isautomatically launchedwhen user open emptyAttribute definition library.
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The first page defines the nameof the attribute and the explanatory icon and picture.

Next step defineswhich parameter will be added to the attribute. Buttons for String, Number, CheckboxandComboboxare
available. Each button switches the tab to the parameter specification.
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String
Text string is the simplest value for the attribute parameter.

User set name, description and a default text string.
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Number

The number is defined by the name, description and default value. Additional information is unit, range and summable
option. Summable option is a functionality of user-defined attribute. This checkbox add a column in the document table
where thisnumber displays its count. The table isavailable in the groupSpecial in theNew document item.
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Checkbox

The checkbox isdefined by the name, description and default value – yes/no.

Combobox

The combobox isdefined by the name, description, the list of valuesand default value from the list.

Possible valuesare editable by the text editbox– it can be added, renamed, deleted andmoved.

Definition of the owner, language and label
Definition of the owner, language and label is in the last step of the attributewizard.
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Each attribute parameter can be edited, deleted or added a new one. Language strings for localization, attribute label
optionsand attribute owner can be edited for thewhole attribute definition.

Editing by wizard
User-defined attribute can be edited by thewizard. Parametersare displayed on the second tab in the text editbox.
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Note: The first parameter in the attribute define grouping in the document table. When
there are 3 attributes inserted in the project and each of them has a different value for the
first parameter then the document table displays3 groups for thisattribute definition.

Attribute - service and inserting to the project
When the first attribute definition is created, the new service with attribute commands is displayed. Each definition has its
own command and it can be inserted asattribute instance on themember.

Inserting of user defined attributes
After launching the Input of Attribute a new dialogue window appears on the screen and the user can change the values for
the new added attribute. Then he confirmshissettingswith theOKbutton and can selectmember(s) to which the new attrib-
utewill be added.

The user-defined attribute isdisplayedwith a label containing the nameaccording to the label setup.
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An attribute can be inserted also in the Editor (see chapter about the Attribute editor) or through the context menu – Insert
attribute.

- 385 -



Chapter 5

Editing of attributes instances

Editing by attribute properties
There are more ways to edit attributes. A list of attributes is pasted to the property dialogue of the appropriate member.
Here a button can be used to see Instance setupwith attribute properties.

Alternatively the Editor in the same list can be started.

Bothwaysalsoworkswhen the user displays the properties through a contextmenu.
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Eachmember with attributeshas tabswith propertiesof the attributes in the propertydialogue.

First tab is for member propertiesand othersare for attributes. The last but one icon displays the editor and the last icon can
delete active attribute in the properties.

The contextmenu can be used to start the Attribute editor.
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Attribute editor

In the left part of the dialogue there is a list of selected members and attributes connected to them. The member without
attributes has only a number in brackets showing the count.In the right part of the dialogue there is an “intersection” of the
properties of selected member or attributes. The user can change the values here (change value and press ENTER). The
user can change the value for multiselected attributes or members. When the user selects item without an attribute, he can
insert a new attribute to thismember – using button Append new attribute

The user can insert here only those attributeswhich are alreadyconnected to some items in the project (it doesnotmatter to
which type –member, node…).When the user hasmade a selection containing some itemswith attributes, then he can use
buttonCopyattributesandDelete all attributes in the selected groups

Copy
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The user selects Attribute he wants to copy. He clicks button Copy. A new dialogue with a list of available items
appears. The user can (multi)select items to append selected attribute to.
Delete
The user (multi)selectsa group of attributesand clicksbuttonDelete.

Copy, move, delete

Copying and moving of Attributes
The first possibility to copyor move attribute is in the Attribute editor (previouschapter).

Another possibility to CopyandMove attributesare iconson a toolbar.

Copying and moving of attributes is possible only between the same types of item (from node to node, from 2D member to
2Dmember, etc.).

The same icons for copying andmoving are added to the contextmenu.

Deleting of Attributes
Deleting of Attributescan be done in theEditor (see chapter Attribute editor).
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Alternatively, it is possible to use the icon in the property dialogue. This icon can be also used when no member is selected
and the combo boxcontainsonlyattributes.

The third way is through the contextmenu and buttonDelete attributes.

Moving of attributes labels
Attribute label is automatically placed to the center of his owner –member, plate,... The attribute owner must be selected to
move the label.
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New commands for moving of labels are developed for version 2011 – “Move attributes label” and “Reset attributes label
position”.

Attribute label can bemoved in the samewayasvertexes. “Move attributes label” display labelwith the green dot and by this
dot ispossible tomove attribute label.

“Reset attributes label position” turns label back to itsoriginal position.

These two functionalitiesare possible to use also for more than one attribute label.

How to create and work with a User defined attribute

Attribute parts
Attribute definition
The definition of the attribute is a library item. This item specifieswhich parameters contains the user defined attribute. Each
definition isonlyonce in the project - in library. This is the specification of the attribute.
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Instance
The instance isbased on the attribute definition, but the valuesof predefined parameterscan be changed byuser. It is inser-
ted to the project. It shows the label of the attribute and parameters are displayed in the properties. Each instance of the
same attribute definition can have a different valuesbut it has the sameparameters.

If the definition is changed, all its instancesshould be updated. There isamessage:

How to create the attribute definition
Definition of attributeColour with two parameters - colour and thickness:
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1. Open the attached project – Attributes.esa. You can see a simple structure composed of beamsand plates in two levels.

2. Find service Attribute definition in Treemenu service Tools.

Definition of the attribute by Attribute wizard
It is possible to create the attribute definition by the library itself or user can use the attribute wizard. The wizard is much
more user friendly tool and the next part describes its functionality.

1. The attributewizard isopened automaticallywhen no attribute definition isalreadycreated in the library. If the librarycon-
tainsat least one definition, wizard startsautomaticallywhen user create a new item.
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2. The first part contains the name, explanation image and iconwhich used in the service afterwards.

If there is no small picture next to the button for adding, it means that no image and no icon
are added yet.

3. Define the nameas "Colour", add picture "colour.bmp" and icon "ico_colour.bmp". Used picture and icon are displayed
bysmall previewswhen user movescursor over the picture next to the button for adding.
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4. Use buttonNext andmove to the second step.
5. Define the parameter type in the next step. The first parameter isString. Clickon the big icon.
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6. Fill in the String parameter definition.The name is "Colour", description is "colour of the element" and the default value is
"Red".

7. Continue to the next step.
8. There isa list of alreadycreated parameters for thisUser defined attribute.

9. Add a new parameter by the buttonwith green plusand then select the typeNumber.
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10. Define the settingsof theNumber, name is "Thickness", description is "thicknessof the painting" and default value is1.
Select the units - mm (Length) and define the range from0 to 3mm.

11. Finish this step and check if the list displays two parameters for thisattribute.
12. Define the content of the attribute label. Label for colour - check the checkboxes for namesand values. Label for thick-

ness - checkall checkboxes.
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13. Define the attribute owner - thatmeanswhich type of elementscan contain an instance of thisattribute definition. The
owner for thisdefinition is1Dmember. Select "Member" in the left list andmove it to the right part.
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14. The attribute is ready to use. Finish thewizard and check the new attribute definition in the library.

How to insert attribute instance to the project

1. Close theAttribute definition library
2. The new service isdisplayed in themain treemenu - Attributes.
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3. Open the service and start commandColour. The new dialogue isopened. The default settingsare displayed.

4. Confirm byOKand select one column. The attribute instance isadded and the predefined label isdisplayed.
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Add a new attribute definition

1. Open theAttribute definition library from theAttributesservice.
2. ClickonNew. The application startswizard.
3. The name is "Level". Don't add anypicture or icon. The systemdefines the default. Continue to the next step.

4. Select the parameter typeCombobox.
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5. The parameter name is "Storey level", the description is "the number of the storey level", add two items to the list of pos-
sible valuesand name them "1st level" and "2nd level". The default value is "1st level".

6. Finish the definition of the parameter.
7. Define the attribute label. Checkonlyvalue.

- 404 -



Basicworking tools

8. Define the parameter owner. Select 2Dmembers.

9. Close thewizard and check that the new attribute isdisplayed in the service. There isa default icon used for the attribute.
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10. Insert the new attribute on both plates in the project. Change the value of the higher attribute to "2nd level" during insert-
ing. The label isalwaysplaced to the plate center.

Modify the properties of the attribute
Properties are displayed if user selects attribute label or selects the owner. It is displayed on the second tab in the properties
of owner.

1. Select theColour attribute label.
2. Change the parameter Colour fromRed to Blue.
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3. Check the changed value on the attribute label.

4. Select the bottomplate. Switch to the second tab in the propertydialogue.
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5. Change the parameter to "2nd level". Check if it is displayed on the label.

Modify the properties of the attribute definition
The attribute definition can bemodified by the attributewizard in the samewayas it is created.

Sometimes it is faster to find the property in the librarydirectly.
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1. Open the attribute definition library.
2. Clickon "More option" in propertiesof Colour. The group isexpanded.
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3. Clickon button to remove the picture. The preview isempty.
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4. Clickon "Adapt attribute owners". Define onemore owner for attribute - Node.

5. Close both dialoguesand insert attributeColour on node on the structure.

6. The label isnow displayed on the node.

The final project with inserted Attributes isattached as "final_attributes.esa".
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How to create summable attributes
The attribute parameter Number has an option summable. This option allows to add a table with sumsof values to the doc-
ument.

Create summable attribute

1. Open attached project "attribute_summable.esa"
2. Open service Attributesand open libraryAttribute definition.
3. Edit attribute definition "weight", open tab "Parameters" and select "weight" in the list. Start editing.
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4. Check "Summable" option and close the dialogue.

5. Start the commandweight from the servicemenu. Change the value to 3 in the inserting dialogue. Confirm byOK.
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6. Insert the attribute instance on the first column.

7. Start the command again. Change the value to 5 and insert it on the second column.
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Add table "Bill of material to the old document.

1. Check the functionality for Old style document. Open document.
2. Open list of insertable items (buttonNew). Select group "Special" and item "Bill of material byattributes".
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3. Add it to the document and refresh.

4. There isa columnTotalweight (kg) which displays the summof both attribute instanceswhich is inserted to the project.

The final project isattached as "attribute_summable-finished.esa".

Storeys
Storeys
SCIA Engineer has two tools for better vertical orientation in the project. These are storeys and 3D linegrid. Storeys are
defined by separate levels. Each level is defined by name, height, selection etc. The storeys are also connected with activity
functionality, so user maydisplay the level separately.

Storey isalso used by the seismiccalculation. Seemore in amanual about Seismicanalysis.

The storeycan be created in XYZ type of project.

The storey is generated as an object with a predefined shape. The values for heights, the inserting point and name are
defined by theStoreymanager. The visibility of the storeys is controlled byview parameters.

The storeycan be used for special type of activityand also for the simple generation of the plan section entity.

The special settings is allocation. When any beam is allocated to the specific storey level, then it can be profitably used in the
activityaccording to the storeys.

The storeymanager is in the service “Line grid and storeys” in themain tree.

The storeyobject in the 3Dwindow:
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Storey manager
The dialogue for storeydefinition containsa simple grid with preview.

The storey is defined by storey name, its start, its height, number of repetitions and its top which is calculated automatically.
User can fill some additional description in the last column.

The preview isupdated automatically.

There are two buttons for adding a new row and deleting the existing one.

The inserting point isdefined byXandYcoordinates.

The geometryof the storey, name and inserting point can bemodified only in the storeymanager.

The nameof each level isautomaticallygenerated according to the first one. The number isadded to the end of the string.
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Example:

Floor1, Floor2, Floor3 ...

flr_1, flr_2, flr_3, ...

When user confirms the storeybyOK, the new object isplaced to the inserting point.

SCIAengineer hasonlyone storeymanager, so the storeycan be onlyonce in the project.

Storeys in the project
The storey is displayed as simple lines with labels in the 3D window. Each storey level is displayed like line with triangle and
description – it contains the name and value for height (this is the default settings). User can addmore info by the view para-
meters.

The 3Dwindowwith the perspective view on the structure and storeys:

Storeysare reused for seismiccalculations.

Properties of storey level
The propertiesof the selected level are displayed in the propertydialogue.
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Name
the nameof the storey level
Description
the user defined description
Z-bottom
where the storey level starts
h_fl
the height of the storey level
Filtered allocation
the list of the allocatedmembers (to this storey level)
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Allocation type: this is important for the automatic allocation, because it defines which members will be allocated, there are
three possibilities:

1. All inside – themember must bewhole inside the storey level (it meansbetween Z-bottomandZ-top) to be auto-
maticallyallocated

2. Part inside – at least a smaller part of themember must be inside the storey level to be automaticallyallocated
3. Major part inside – the bigger part of themember must be inside the storey level to be automaticallyallocated

Include members on top: this is important setting for the automatic allocation, it defines if the members on the top border
(member with Z coordinate=Z_top) should be allocated

Includememberson bottom: this is important setting for the automaticallocation, it defines if thememberson the bottombor-
der (member with Z coordinate=Z_bottom) should be allocated

Current used activity
it is checkedwhen the level isused in activity (see a special chapter)
Select allocation
the allocatedmembersare selected in themodel by thisbutton
Allocate automatically
the system check the allocation parametersand allocate themembersagain by thisbutton

When the member is added to the structure where storeys are already defined, the alloc-
ation is not updated automatically. User has to use the action button “Allocate auto-
matically”.

The special property for Seismic
Level of reduction point
Thisproperty is visible when the functionalityDynamics / Seismic is checked. Seemore about thispropertyhere.
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Storey view parameters
The view parameters for storeysare on the tabModelling/Drawing.

The storeysdisplays:

1. Storey label – nameof the storey level
2. Storey level – the value fromZ-bottom column in the storeymanager
3. Storeyheight – the value h_fl in the storeymanager
4. Grid projection – if the 2D linegrid should be projected to the storey level (grid with labels)
5. Grid projection dimension – if the 2D linegrid should be projected alsowith dimensions, thisoption can be used onlywhen

“Grid projection” is switched on, otherwise it isnot visible in the project

The view parameters for selected entities can be used for storeys as well. If the user wants to project the linegrid only in
some storey levels, then he has to select them in themodel and use view parameters for selected.
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Example:

1. User wants to display linegrid on the FL3.
2. He select the storey levelFL3 in themodel and start view parameters for selected

3. He selects the grid projection in the dialogue.

4. The graycheckbox isdisplayed in the view parameters for all. That’sbecause it is checked only for the selected part of the
model. It can be changed byun-checking it.
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Activity by storey
‘Storey activity’ is a tool that allows for visualising of the model entities based on storey allocation. Allocated members on a
(or multiple) storey(s) can be displayed and edited in theSciamodelling environment while all other entitiesare hidden.

This activity option is located on the ActivityToolbar and it contains three buttons– ‘Activity by storey,’ ‘Move activity by storey
up,’ ‘Move activitybystoreydown.’

There are threeways to use ‘Storeyactivity.’

The options linked to ‘Activity by storey’ define which type of activity is used – ‘Single storey activity,’ ‘Unallocated members’
or user-defined settings.

One storey activity
The user can onlyactivate a single storey. All storey levelsare available for selection via the combobox.
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Unallocated members
Amodelmaycontainmembers that are not allocated to anystorey. There are also object typeswhich cannot be allocated to
any level at all (linegrids, a storey itself, etc.). Those itemscan be displayed by the option ‘Unallocatedmembers.’

Multiple levels together – Settings
The third option displaysselected levels together. This type can be created byuser.

The user selects the active levels by checkboxes. All storeys can be activated and deactivated at once by the two buttons at
the bottom right corner of the dialogue.

The ‘Storey activity’ dialogue may contain more user-defined settings to address different needs. New settings can be
added by the button ‘New’on the toolbar. The namesof settingsare user-defined.
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Move activity by storey up/down
The two additional buttonscan be used onlywhen the storeyactivity is selected.

The first onemoves the storeyactivity in the dialogue to the next one, the second to the previous.

Example:

1. The initial setting – “basement+1” isactive, thus, onlyFL1 and FL2 are visible in the 3Dwindow.

2. User presses the “Move activitybystoreyup”.
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3. Themodel is changed. Three levelsare now visible – FL1, FL2, and FL3. The active setting in the dialog is changed from
“basement+1” to “middle.”

Import and export
The storeycan be onlyonce in the project. This isalso the only limitation of the import and export tool.

l If the existing project containsstoreys -> the newly imported project is importedwithout storeys.
l If the existing project doesn’t contain storeys -> the newly imported project is importedwith storeys.

The inserting point for the imported storeys isplaced correctlywith the respect to the construction.

Project whichwill be imported:
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n Storeysare placed next to the structure, GCS isunder the second column.

Project imported to an emptyproject:

n Storeysare placed again next to the structure, GCS is located farther, because the inserting point for import wasn’t set to
0,0,0.

How to define new Storeys

Introduction to Storeys
Storeys isa special entity in SCIAEngineer. It is defined by “Storeymanager” dialogue. TheStoreysobject can be onlyonce
in the project. Anychangescan be done in “Storeymanager”.

Storeyscan be usedwith 2D linegrid. Together theycreate similar object as3D linegrid. A visual copyof a 2D linegrid in each
Storey is controlled byview parameters.

Location of Storeys in SCIA Engineer
Storeysdialogue can be started from service “Line grid and storeys”.
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Dialogue “Storeymanager” starts. Each storeycan be defined in an ordinarygrid.

How to define Storeys

1. Open a new blankproject in SCIAEngineer with this settings:
i. Structure –GeneralXYZ
ii. Project level – Advanced
iii. Model –One
iv. Material – Concrete
v. National code and annex–EN

Nomore functionality isneeded for the Storeys input.
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2. Find the commandStoreysand start dialogueStoreymanager.

3. Define a new name for floors.Write down “Floor” in the column for the name. It isautomatically renamed to “Floor1”.

4. Define “Z-bottom” to -2.000mand “h_fl” to 4.500m. “Rep” stays1.
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There isa schemeof Storeys in the picture above. One storey isdefined.

5. Define another row =next levelwith these settings:
i. “h_fl” =3.000

ii. “Rep” =2

iii. “Description” =Second level
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The preview isautomaticallyupdated according to the changes in the dialogue.

6. Add 2more levelswith height 2.000 and 5.000m.
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7. Confirm theStoreysbyOKand see the result in the 3Dwindow.
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Modification of Storeys

1. Storeyscan be edited only in the “Storeydialogue”. Start thisdialogue again.
2. Buttons “Insert” and “Delete” modify the number of rows in the dialogue. Clickon row number 3 and then on the “Insert”

button.

There isa new rowwith default values from row number 4.

3. Clickon the rowwith number 6 and push button “Delete”.

The 6th row isdeleted from the grid.
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4. Edit value for “Z-bottom” from -2.000 to -0.500. All valuesunder this cell are automatically recalculated.

5. Edit value “Rep” in 4th row from1 to 3.

6. See the result in the 3Dwindow.

7. Result isalso saved in project “storeys_final.esa”.
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Storeys and Linegrid in one project.

1. Open project “storeys+linegrid_start.esa”.

2. Open service “Line grid and storeys”.
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3. Define Storeyswith these settings:
i. “h_fl” in 1st row =3, “Rep” =2

ii. “h_fl” in 3rd row =2, “Rep” =1

iii. Inserting point is x=-5.000, y=-2.000

4. Close “Line grid andStoreys” service and see the changes in the 3Dmodel. The 2D linegrid is copied to the each level of
Storeys.
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5. Change view parameters for thewhole structure. Tab “Modelling/Drawing”, item “Grid projection” ->uncheck the check-
boxand confirm it byOKbutton.

- 437 -



Chapter 5

The 2D linegrid isdisplayed only in theworking plane.

6. The result is in file “storeys+linegrid_final.esa”.

How to use storey activity

1. Open file “storeys+linegrid_final.esa”.
2. Graphically select all three storeys in the project and set their properties to “Includememberson top” and “Includemem-

berson bottom” aschecked. Then clickaction button “Allocate automatically”.
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3. Deselect all storeysand now select only the second level. Set property “Allocation type” to Part inside. Clickaction button
“Allocate automatically”.

4. UseView Y.

5. Switch activity to Activitybystorey. Confirm thewarning.
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6. The new dialogue isopened. All possible activities that can be used for storeysare here.

7. Select “One storeyactivity” and there only1st level – FL1. Close the dialogue.

The result in the 3Dwindow:
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8. Go again to the “Storeyactivity” dialogue and select Settings_3. Checkalso the second storey– FL2. Close the dialogue.

The result in the 3Dwindow:

9. Conclusion: The activitybystoreysworks in the similar wayasactivitybyLayers. It isuseful functionality for higher build-
ings. The engineer haspossibility to work in separate levelswithout defining layers.

Storey Results
For a detailed description of storey resultsand their usage, see the following pages:
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l SummaryStoreyResults
l Detailed StoreyResults

Summary storey results
The service “SummaryStoreyResults” provides results directly produced by the IRSanalysis (see Reduced analysismodel
). At this time, this service is dedicated to result output for the seismic analysis of buildings. It provides single results per
storey, such asmass, position ofmasscenter, displacement, acceleration…
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Summarystorey resultsare available onlywhen the reducedmodal analysis isenabled and
storeyare defined.

Typesof results:

Formass combinations

Storey data:mass & mass center of each storey

Displacements of storeymass center per mode

Accelerations of storeymass center per mode

For seismic load cases

Displacements of storeymass center

Accelerations of storeymass center

Inter-storey drift at storeymass centers

Picture: Summary storey results
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Picture: Accelerations

Detailed Storey Results
The service “Detailed Storey Results” provides results from the full mesh analysis. At this time, it may be used for results
from any linear analysis, with or without dynamic analysis, with or without IRS analysis. It provides results in all supporting
members, with easyselection ofmembersper storey.Wallsand columnsmaybe represented on the samedrawing. Typical
provided resultsare: internal forces, resultantsper wall or per storey…

Tip: before using detailed storey results, make sure that all supporting members of the
building are properly allocated to storeys. That information is essential for proper handling
of storey results.

Type of results

Internal forces in supportingmembers

Selection by storey

Extreme bymember (also for walls !)

Walls & columns on the same drawing
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Simple choice of section level

Display of average & total value for walls

Available for static & seismic results

Also suitable e.g. for load descending

Resultant forces in supportingmembers

Resultant for each wall on the same drawing

Clear display ofmore components

+ all the key pointsmentioned previously

Resultant forces in supportingmembers per storey
Resultant of all supporting members at once (walls + columns combined)

+ all the key pointsmentioned previously

Picture: Internal forces

Design groups
Design groups is a tool which automatically sorts members according to predefined Filter and stores found groups in the
Design groups list. This simplify design of a structure because the user can easily identify identicalmembersand edit themat
once. Next, design groupscan be used for selection ofmembers in servicesResults, Steel, Concrete, etc.

Design groups setup dialogue
Thischapter providesdescription of available parameters from theDesign groupsSetup dialogue.
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Setup parameters
Regenerate auto-
matically

ActivatesDesign groups functionality. If active, Design groups
library isavailable.

Filter
Filter isa group of criteria which are used for generation of Design groups.

Beam length Default parameter. Cannot be deactivated.

Beam type Default parameter. Cannot be deactivated.

Beam cross-section Default parameter. Cannot be deactivated.

Layer If active, Layersare used

Design groups list
TheDesign groups list isa tool to control and edit existing design groups in the project.

It is amanager which uses the same "manager philosophy" asother SCIAEngineer managers.

Edit It opensan editing dialoguewhere the layer-propertiesmay
be changed.

Undo / Redo It performs theUndo or Redo operation.

Text Output It opensa small document windowwith a table that sum-
marizespropertiesof selected layers.

In order to open the Layersmanager use treemenu functionDesign groups>Design groups list.

- 446 -



Basicworking tools

Design groups view parameters
Tab Structure > Group Structure

Style + colour
It controls the style and colour ofmembersof themodel (beams, plates, shells, etc.)

normal settingsmade in Setup >Colour/Linesdialogue are used,

by layers eachmember isdisplayed in the colour of the appropriate layer, all
membersassigned to the same layer are of the same colour,

by material eachmember isdisplayed in the colour of the appropriatematerial, all
membersmade of the samematerial are of the same colour,

by cross-sec-
tion

eachmember isdisplayed in the colour of the appropriate cross-sec-
tion, allmembersof the same cross-section are of the same colour,
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by design
group

eachmember isdisplayed in the colour of the appropriate design
group, allmembersassigned to the samedesign group are of the
same colour

according to
structural
type

eachmember isdisplayed in the colour corresponding to its structural
type.

Note : If e.g. two materials, two layers, two cross-sections have assigned the same colour,
than the same colour isused for membersof different controlling property.

Tab Structure > Group Design groups

Display
The view flagswith the design group name can be displayed or hidden.

Match properties
Match properties is featurewhichwill allow user to copypropertiesacrosselements.

User can start Match properties simply from property window (or command line, keyboard shortcut), the tool tip in com-
mand linewill appear. (Or user can choose source first and then start Match properties)

Therewill be shown list of propertieswhichwere picked to copy
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And tooltip in command linewill appear

Now user can choose asmany elements he want to copy properties to. If some propertywas not possible to copy, error log
will appear.

List of allowed elements for Match properties:

l 1Dmembers
l 2Dmembers
l Load panel
l Support in node
l Support on beam
l Line support on 1Dmember
l Line support on 2Dmember edge
l Point force in node
l Point force on 1Dmember
l Free point force
l Line load on 1Dmember
l Line load on 2Dmember edge
l Free Line load
l Surface load on 2Dmember
l Free surface load
l Moment in node
l Moment on 1Dmember
l Freemoment
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l Linemoment on 1Dmember
l Linemoment on 2Dmember edge
l Hinge on 1Dmember

User can start Match properties:

l From icon in propertygrid
l default keyboard shortcut CTRL+SHIFT+F
l "ma" to command line
l Match propertiescommand and keyboard shortcut can be adjusted asanyother command in Scia Engineer

SCIA Engineer 64-bit

SCIA Engineer 64-bit main approach & overview
SCIA Engineer (from version v17.1) provides the possibility to choose between two versions (32-bit and 64-bit) for dis-
playing resultsand performing the design.

Main approach for modelling – calculating - checking in 64-bit
The 64-bit version does not yet contain all functionalities which are available in the 32-bit build due to the fact that not all of
these functionalities are 64-bit compliant yet. The main approach for 64-bit is to allow the user to input (almost) everything
(even if it is unsupported). If an unsupported analysis type isused in the project an error messagewill appear before the cal-
culation starts. For example, when using "plastic hinges" which is currently unsupported youwill get the following error mes-
sage before the calculation starts:

And if a result or check is unsupported it will be hidden in SCIA Engineer. In those cases the user has the possibility to con-
tinue his/her work in the 32-bit version of SCIA Engineer (with the V16 PPE ). If an unsupported check/result item was
already present in the Engineering Report, Picture Gallery or Table result the user will see the following message appear:
Not supported task. Please switch to PPE v16 (available in 32-bit version).

Remark: PPE is the abbreviation for the term post-processing environment
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Overview table of functionalities
Below you can find an overview of the supported or unsupported functionalities per version and per post-processing envir-
onment (PPE).

Functionality Subfunctionality
32-bit version (R17.1) 64-bit version

(R17.1)
"V16 and older"

PPE "V17" PPE "V17" PPE

Aluminium
Scaffolding yes yes no (*1)
LTB2ndOrder yes yes no

Concrete
Code dependent deflection no yes yes
1D physical nonlinearity yes no no
2D physical nonlinearity no yes yes

Steel

Plastichinges yes no no
Fire resistance yes yes yes
Connectionmodeller no (*2) no (*2) no (*2)
Frame rigid connections yes yes no
Frame pinned connections yes yes no
Grid pinned connections yes yes no
Bolted diagonal connections yes yes no
Hollow section joints yes yes yes
Expert system yes yes no
Connectionmono-drawings yes yes yes
Scaffolding yes yes no (*1)
LTB2ndOrder yes yes no
ArcelorMittal no (*2) no (*2) no (*2)
Girderswith sinusoidalwebs yes yes no

Dynamics

- yes no (*5) no (*5)
Seismic yes yes yes
Harmonicband analysis yes no no
General dynamics yes no no
Non-proportional damping yes no no

Initial stress - yes yes yes

Subsoil

- yes yes yes
Soil interaction yes yes yes
Soil loads yes yes yes
Pile Design (NENmethod) yes no no
Pad foundation check yes yes no

Non-linearity

Initial deformationsand
curvature yes yes yes

Geometrical non-linearity yes yes yes
Phys. non-linearity for reinf.
concrete yes no no
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Beam local non-linearity yes yes yes
Support non-linearity/Soil
spring yes yes yes

Friction support/Soil spring yes no (*4) no (*4)
Membrane elements yes no no
Pressonly2Dmembers yes no no
General plasticity yes yes yes
Sequential analysis yes no no
Cable yes no no

Stability - yes yes yes (*9)
Climatic loads - yes no (*8) no (*8)

Prestressing
- yes no no
Advanced yes no no

Pipelines - no (*2) no (*2) no (*2)
Structural model - yes yes yes
BIM properties - yes yes yes
Parameters - yes yes yes
Mobile loads - yes no no
Automated GA draw-
ings - yes yes yes

LTA - loadcases - yes (*2) no (*2) no (*2)

CADS composite
checks

Composite column yes yes no
Fire resistance yes yes no

External application
checks - yes yes no

Slabs with void formers - yes no no
Property modifiers - yes yes (*7) yes (*7)

Bridge design
Load combinations yes yes yes
Concrete checksextensions yes no no

Document - yes no (*6) no (*6)

Advanced concrete
checks

- yes no no
Fire resistance yes no no
Hollow core slab yes no no

(*1): Only the scaffolding coupler check is not supported in 64-bit, the scaffolding check does work under 64-bit.
(*2): Functionality is obsolete and thus to be removed from the source code.
(*4): Only "friction support" is not supported in "V17" PPE and 64-bit.
(*5): Only modal analysis is supported (eigenmode shapes are available under 3D-displacements). Harmonic loads and Karman
vibrations are not supported.
(*6): Hidden in new projects but available when opening old projects that contain the old document.
(*7): Property modifiers are not supported for composite
(*8): 3D wind generator is supported since 1st patch of SCIA Engineer 17.1.
(*9) : Buckling factors from stability are not supported yet in 64-bit
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Overview table of results service items

Results service items
32-bit version (R17.1) 64-bit version (R17.1)

"V16 and older" PPE "V17" PPE "V17" PPE
Deformed structure yes no(*2) no(*2)
Foundation table yes yes no
Nodal space support resultant yes yes no
Relative deformations yes no no
Member stress yes no(*1) no(*1)
Shear stress yes no(*1) no(*1)
Connection forces yes yes no
Integration strip yes no no
2D/1D upgrade yes no no
Bill of material yes no no

(*1): User can use 1d member stress and 3d stress
(*2): Deformed structure is drawn in wireframe mode of 3D displacement

Overview table of model types
Below you can find an overview of the supported or unsupported model types per version and per post-processing envir-
onment (PPE).

Model type
32-bit version (R17.1) 64-bit version (R17.1)

"V16 and older" PPE "V17" PPE "V17" PPE
One yes yes yes
Absence yes no no
Construction stages yes no no

Overview table of import formats
Below you can find an overview of the supported or unsupported import formats per version and per post-processing envir-
onment (PPE).

Import
32-bit version (R17.1) 64-bit version (R17.1)

"V16 and older" PPE "V17" PPE "V17" PPE
DSTV yes yes no
Esa yes yes yes
Esa In yes yes no
Etabs yes yes no
Graphic format (dwg,...) yes yes yes
IFC 2x3 yes yes yes
SDNF yes yes yes
Stepsteel yes yes no
Tekla yes yes yes
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Revit yes yes yes (*1)
XML yes yes yes

(*1): Direct data exchange is not supported yet in 64bit.

Overview table of export formats
Below you can find an overview of the supported or unsupported export formats per version and per post-processing envir-
onment (PPE).

Export
32-bit version (R17.1) 64-bit version (R17.1)

"V16 and older" PPE "V17" PPE "V17" PPE
Allplan (.ifc) yes yes yes
CEA Plant-4D yes yes yes
DSTV yes yes no
Esa yes yes yes
Esav yes yes yes
Esa In yes yes no
Etabs yes yes no
Graphic format (dwg,...) yes yes yes
IFC 2x3 yes yes yes
IFC 2x3 Compressed yes yes yes
SDNF yes yes yes
Stepsteel yes yes no
Tekla yes yes yes
Revit yes yes (*1) yes (*3)
XML yes yes (*2) yes (*2)

(*1): Export of results is not supported in "v17" PPE.
(*2): Export of new results (results v17)) is not supported in "v17" PPE
(*3): Direct data exchange and export of results to r2s file is not supported yet in 64bit.

SCIA Engineer 64-bit: Hidden items
Hidden items of unsupported functionalities in 64-bit (General)
The list of unsupported functionalities in the 64-bit version can be found below. This list will become shorter after each incre-
mental release of SCIAEngineer in the future.

Functionality/Material Subfunctionality Hidden items in R17.1 (64-bit)

Advanced concrete checks
(not applicable)

- Concrete Advanced service containing all the checks
(OverallCheck, Crackcontrol,...)

- EC-tools (also not available in 32-bit with "v17" PPE)

- Advanced concrete checks functionality in the project
data dialog

Fire resistance - Concrete Advanced service containing all the checks
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(OverallCheck, Crackcontrol,...)

- Fire resistance functionality in the project data dialog

Hollow core slab

- Concrete Advanced service containing all the checks
(Overall check, Crackcontrol,…)

- Hollow core slab functionality in the project data dia-
log

Aluminium

(not applicable)
- Check (ULS)

- Relative deformation (SLS)

LTB2ndOrder - No hiding, FriLo-solver isn’t used because the checks
that use it are hidden (see above).

Scaffolding - Scaffolding –Coupler Check
External application checks (not applicable) - Custom check (i.e. ExcelCheck)

Bridge Design Concrete checksextension - Concrete Advanced service containing all the checks
(Overall check, Crackcontrol,…)

CADS composite checks

Composite beam

- Member data

- ULSdesign check

- SLSdesign check
Composite column - ULSdesign check

Fire resistance
- Fire resistance (composite beam)

- Fire resistance checks (composite column)

LTA - loadcases (not applicable)
- LTALoad

- LTAConductor insulators (load service)

Prestressing

(not applicable)
- Concrete Advanced service containing all the checks
(Overall check, Crackcontrol,…)

- Prestressing functionality in the project data dialog

Advanced
- Concrete Advanced service containing all the checks
(Overall check, Crackcontrol,…)

- Prestressing functionality in the project data dialog

Slabs with void formers (not applicable)

-Concrete Advanced service containing all the checks
(Overall check, Crackcontrol,…)

- Slabs with void formers functionality in the project
data dialog
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Steel

ArcelorMittal - Cellular beamcheck

Bolted diagonal

- Bolted diagonal functionality in the project data dialog

- Bolted diagonal, Bolted diagonal – bolt operations

- Action buttons in bolted diagonal property window
(Refresh, Open preview, Results, Autodesign, Edit
bolted diagonal)

- Bolted diagonal (in the connectionssetup).

Expert system

- Expert system functionality is hidden in the project
data dialog

- Action buttons in connection property window (Save
to expert database, Load fromexpert database)

- Expert system (in the connectionssetup)

Frame pinned connections
- Frame strong-axis

- Frameweak-axis

Frame rigid connections
- Frame strong-axis

- Frameweak-axis
Girderswith sinusoidalwebs - SIN beamcheck
Grid pinned connections - Grid pinned

LTB2ndOrder
- No hiding, FriLo isn’t used ->default method from
steel setup isused +error message isshown in the
header of the steel code checkoutput.

Plastichinges - No hiding, plastichingesaren’t accounted for. Error
message isshownwhen calculating.

Scaffolding - Scaffolding –Coupler Check

Subsoil Pad foundation check
- Geotechnicssetup

- Pad foundation –Pad foundation stability

Hidden items of unsupported functionalities in 64-bit (Non-Eurocode)
Remarks:

• Advanced concrete checks (old concrete menu) is not supported in 64-bit, only the new concrete menu. Therefore, the
functionality Advanced concrete checks are only possible to obtain in the 32-bit version with the post processing envir-
onment set to "V16 and older".

• The same applies for the steel connections related functionalities (Bolted diagonal, Expert system, Frame pinned con-
nections, Frame rigid connections, Grid pinned connections), these are only possible to obtain in the 32-bit version (avail-
able in both post processing environments).

Code Functionality/Material Hidden items in R17.1 (64-bit)
ABNT-NBR (Brazilian) Steel - Steel slenderness

BS (Great Britain) Steel (BS)

- Setup

- Steel slenderness

- ULSdesign check

- SLSdesign check
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Steel (BS5950-1:1990)

- Setup

- Steel slenderness

- ULSChecks - Check

- SLSChecks - Relative deformation

CSN (Czech Republic)

Steel

- Setup

- Steel slenderness

- ULSChecks - Check

- SLSChecks - Relative deformation

Timber

- Setup

- Check

- Deformationwith creep

DIN (Germany)
Steel

- Setup

- Steel slenderness

- ULSChecks - Check

- SLSChecks - Relative deformation

- Characteristicbeam factor
Timber Beams - Setup

ENV (Europe)

Steel

- Setup

- Steel slenderness

- SLSChecks - Relative deformation

Timber

- Setup

- Check

- Deformationwith creep

France Steel

- Setup

- Steel slenderness

- ULSChecks - Check

- SLSChecks - Relative deformation

IBC (U.S.A.) Steel

- Setup

- Steel slenderness

- Check ASD

- CheckLRFD

- SLSChecks - Relative deformation

India Steel

- Setup

- Steel slenderness

- ULSChecks - Check

- SLSChecks - Relative deformation
NEN (Netherlands) Steel - Setup
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- Steel slenderness

- ULSChecks - Check

- ULSChecks - Fire resistance

- SLSChecks - Relative deformation

ONORM (Austria) Steel

- Setup

- Steel slenderness

- ULSChecks - Check

- SLSChecks - Relative deformation

SIA (Switzerland)
Steel

- Setup

- Steel slenderness

- ULSChecks

- Check - Fire resistance

- SLSChecks - Relative deformation
Timber - Beams - setup

Slovakia

Steel

- Setup

- Steel slenderness

- ULSChecks - Check

- SLSChecks - Relative deformation

Timber

- Setup

- Check

- Deformationwith creep

Spain Steel

- Setup

- Steel slenderness

- ULS Checks - Check

- SLSChecks - Relative deformation

SCIA Engineer 64-bit: Frequently Asked Questions
Frequently Asked Questions

What is the difference between 32-bit and 64-bit SCIA Engineer?
The terms 32-bits and 64-bits refers to how the processor (CPU) of a computer processes data. The 64-bit version of
SCIAEngineer processes large amounts of RAM (memory) more effectively than the 32-bit version of SCIAEngineer. This
gives the user the possibility to allocate much more memory (> 2^32 bytes = approx. 4 Gb) which improves the sta-
bility of SCIAEngineer whenmodelling large projects.

The 64-bit version of SCIAEngineer uses the “v17” post processing environment while the 32-bit version of SCIAEngineer
can use the “v16 and older” post processing environment as well as the “v17” post processing environment. More inform-
ation about the post processing environmentscan be found here: "v17Post-processing environment " on page 209
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What is the difference between "v16 and older" versus "v17" post-processing environment?
Usage of the v17 post-processing environment is recommended to get the benefits from some of the latest developmentsof
SCIAEngineer 17: ability to run a selection of load casesor non-linear combinations, CDD (CodeDependent deflection) for
concrete according to theEurocode, upgraded result service. For more info: visit the pagewhat’snew SCIAEngineer 17

While in the "v16 and older" post-processing environment there are no new developments but it fully supports all the devel-
opmentsbefore version 17.

An overview table of supported and unsupported functionalities can be found in "SCIA Engineer 64-bit main approach &
overview" on page 450

What is the interaction between the two post-processing environments?
The two post-processing environments are fully compatible. Existing projects from previous SCIA Engineer versions or
using the "v16 and older" post-processing can be run using the "v17" post-processing and vice-versa. Every time the post-
processing environment is switched, a recalculation of themodel is required.

It mayhappen that you start your project in “v17” and you realize that an advanced functionality you need ismissing. You can
switch back to "v16 and older" post-processing by the “project data” dialogue.

If you change the post-processing environment, asmentioned above you will use another export of the model to the solver,
but also another method of showing resultsand new algorithmswhichmight lead to slightlydifferent result values.

Another consequence when switching between post-processing environments is the fact that the calculated results will be
deleted. So as indicated a recalculation after switching isneeded.

What happens with the Engineering report when switching to another version or post-pro-
cessing environment?
In 32-bit version:
TheEngineeringReport is fully compatible with the two post-processing environmentsand can also contain images from
both environments. Checking theEngineeringReport might be required if content from the other post-processing envir-
onment isused, to avoidmissing results fromunsupported features.

In 64-bit version:
If the EngineeringReport containsan unsupported item (see previous tables) it will not show the resultsof that item. Instead
the followingmessagewill be displayed:Not supported task. Please switch to PPEv16 (available in 32-bit version).

When to use the 32-bit or 64-bit version of SCIA Engineer?
Themain advantage of 64-bit is the fact that it can process large amounts of data effectively than the 32-bit version. But the
64-bit version doesn’t support all the features yet of the 32-bit version. So it depends per project which version is recom-
mended. The flow chart below can offer some guidance:
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This decision table doesn't need to be followed strictly during the start of the project as it can be sometimes unclear what
functionalitieswill be used. The user can always start in both versions and in a later stage switch to the optimal version. This
ispossible due to the fact that SCIAEngineer projects can be opened in both versions (32-bit & 64-bit).
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